
 

 
장비 운영 매뉴얼 

 

컴팩트 라이브 스위처  

Model No. AV-HSW10P 

Medel No. AV-HSW10E 
 

 
 
 

 
 

 
 
 
 
 
 
 

이 제품을 작동하기 전에 지침을 주의 깊게 읽고 나중에 사용할 수 있도록 이 설명서를 보관하십시오. 제품 사용 전에 매뉴얼 내의 "사전 
숙지 내용" (3-7페이지)을 우선 참조하십시오. 

 
 

 

한국어 제작 : ㈜디브이네스트 1544-5596 
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제작 : ㈜디브이네스트 1544-5596 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 

• HDMI 및 HDMI High-Definition Multimedia Interface라는 용어와 
HDMI 로고는 미국 및 기타 국가에서 HDMI Licensing 
Administrator, Inc.의 상표 또는 등록 상표입니다. 

• NDI®는 NewTek, Inc.의 등록 상표입니다. 

미국 및 기타 국가. 

• 이 사용 설명서에 포함된 회사 및 제품의 다른 이름은 해당 소유자의 
상표 또는 등록 상표일 수 있습니다. 

이 설명서에는 다음 약어가 사용됩니다. 

• 개인용 컴퓨터를 "컴퓨터"라고 합니다. 

 

• 설명서의 그림과 화면 표시에 표시된 내용은 실제로 표시되는 것과 

다를 수 있습니다. 

 

이 장치와 함께 제공된 소프트웨어의 수출법을 위반하여 배포, 복사, 

분해, 리버스 컴파일, 리버스 엔지니어링 및 내보내기는 명시적으로 

금지됩니다. 

• 이 제품의 소프트웨어에 대한 정보 

이 제품에는 GNU 일반 공중 사용 허가서(GPL) 및 GNU 약소 일반 공중 사용 허가서(LGPL)에 따라 사용권이 허여된 소프트웨어가 

포함되어 있으며, 사용자는 이 소프트웨어의 소스 코드를 획득, 변경 및 재배포할 수 있는 권리가 있음을 알려드립니다. 

소스 코드를 얻으려면 다음 웹 사이트로 이동하십시오. 

https://pro-av.panasonic.net/en/ 

제조업체는 사용자가 얻은 소스 코드 및 기타 세부 사항에 대한 문의를 대리인에게 직접 문의하지 않도록 요청합니다. 

이 제품에는 MIT 라이선스에 따라 사용이 허가된 소프트웨어가 포함되어 있습니다. 

① 이 제품에는 FreeType Project(www.freetype.org)에 따라 사용이 허가된 소프트웨어가 포함되어 있습니다 . 

 

이에 대한 자세한 내용은 아래 웹 사이트를 참조하십시오. 

https://pro-av.panasonic.net/manual/en/index.html 

자세한 내용은 원문(영어)으로 제공됩니다. 

저작권 및 라이선스에 대해 

상표 및 등록 상표 약어 

설명서에 포함된 그림과 화면 표시 

http://www.freetype.org/
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사전 숙지 내용 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

미국 및 캐나다의 경우 
 

 

 

 

 

 

 

 

 

 

 

안전 정보를 나타냅니다. 

주의: 
화재나 감전 및 성가신 간섭의 위험을 줄이려면 

권장되는 액세서리만 사용하십시오. 

주의: 
나사를 풀어 패널 덮개를 제거하지 마십시오. 

감전의 위험을 줄이려면 덮개를 제거하지 마십시오. 

내부에는 사용자가 수리할 수 있는 부품이 없습니다. 

      

경고: 
이 장비는 CISPR 32의 클래스 A를 준수합니다. 주거 환경에서 

이 장비는 무선 간섭을 일으킬 수 있습니다. 

주의: 
전원 코드의 손상으로 인한 화재나 감전의 위험을 줄이려면 

기기를 사용할 때 전원 코드를 꽉 쥐거나 구부리거나 당기지 

마십시오. 

경고: 
항상 액세서리(접지 커넥터, 장착 나사, 케이블 clamp) 

아기와 어린이의 손이 닿지 않는 곳에 보관하십시오. 

주의: 
불을 붙인 양초와 같은 노출된 불꽃을 기기 위에 올려 놓으면 안 

됩니다. 

주의: 
코인 타입의 배터리가 장치 내부에 설치되어 있습니다. 

햇빛, 불 등과 같은 과도한 열에 기기를 노출시키지 

마십시오. 

주의: 
전원 공급 장치 코드의 전원 플러그는 쉽게 작동할 수 있어야 

합니다. 

AC 콘센트(주 소켓 콘센트)는 장비 근처에 설치하고 쉽게 

접근할 수 있어야 합니다. 이 장비를 AC 주전원에서 완전히 

분리하려면 AC 콘센트에서 전원 코드 플러그를 분리하십시오. 

주의: 
적절한 환기를 유지하기 위해 책장, 붙박이 캐비닛 또는 

기타 밀폐된 공간에 이 장치를 설치하거나 두지 마십시오. 

과열로 인한 감전이나 화재 위험을 방지하려면 커튼 및 기타 

물질이 환기를 방해하지 않도록 하십시오. 

주의: 
이 장치는 100 – 240 V AC 범위에서 작동할 수 있습니다. 

120V 이외의 전압은 미국 및 캐나다용이 아닙니다. 

120V AC 이외의 전압에서 작동하려면 다른 AC 플러그를 

사용해야 할 수 있습니다. 현지 또는 외국 Panasonic 공인 

서비스 센터에 연락하여 대체 AC 플러그를 선택하는 데 

도움을 받으십시오. 

경고: 
• 화재나 감전의 위험을 줄이려면 이 장비를 비나 습기에 

노출시키지 마십시오. 

• 화재나 감전의 위험을 줄이려면 이 장비를 모든 

액체로부터 멀리 두십시오. 액체가 떨어지거나 튀는 위험에 

노출되지 않는 장소에서만 사용 및 보관하고 장비 위에 

     

경고: 
이 장비는 접지되어야 합니다. 

안전한 작동을 보장하기 위해 3핀 플러그는 일반 가정용 

배선을 통해 효과적으로 접지되는 표준 3핀 전원 

콘센트에만 삽입해야 합니다. 

장비와 함께 사용되는 연장 코드에는 3개의 코어가 있어야 

하며 접지에 연결할 수 있도록 올바르게 배선되어야 

합니다. 잘못 배선된 연장 코드는 사망 사고의 주요 

원인입니다. 

장비가 만족스럽게 작동한다는 사실이 전원 콘센트가 

접지되어 있거나 설치가 완전히 안전하다는 것을 

의미하지는 않습니다. 안전을 위해 전원 콘센트의 
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제작 : ㈜디브이네스트 1544-5596 

 

이 제품(액세서리 포함)의 기호는 다음을 나타냅니다. 

 

 

 

 

 

 

 For AV-HSW10P  

 

 

indicates safety information. 

교류 

직류 

FCC NOTICE (USA) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

CAN ICES-003 (A)/NMB-003(A) 

Supplier’s Declaration of Conformity 

Model Number: AV-HSW10P Trade 

Name: Panasonic 

Responsible Party: Panasonic Corporation of North America Two 

Riverfront Plaza, Newark, NJ 07102 

Support contact: 1-800-524-1448 

This device complies with part 15 of the FCC Rules. Operation is 

subject to the following two conditions: 

(1) This device may not cause harmful interference, and (2) this device must accept any interference received, including 

interference that may cause undesired operation. 

FCC Note: 

This equipment has been tested and found to comply with the limits for a class A digital device, pursuant to Part 15 of the 

FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the 

equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy, 

and if not installed and used in accordance with the instruction manual, may cause harmful interference to radio 

communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the 
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 AV-HSW10E의  경우   

 

AC 메인 리드에 대한 주의 
안전을 위해 다음 텍스트를 주의 깊게 읽으십시오. 이 제품에는 3가지 유형의 AC 주전원 케이블이 장착되어 있습니다. 

 

다른 유형의 주전원 케이블은 적합하지 않으므로 각 지역에서 적절한 주전원 케이블을 사용해야 합니다. 
 

유럽  영국 인도 
   

제공된 플러그가 다음에 적합하지 않은 경우 
 

영국에서는 사용할 수 
없습니다. 

 소켓 콘센트를 잘라야 합니다.  

    

    

 

영국만 해당 

이 기기는 안전과 편의를 위해 성형된 3핀 전원 플러그와 

함께 제공됩니다. 13 amp 퓨즈가 이 플러그에 장착되어 

있습니다. 퓨즈를 교체해야 하는 경우 교체 퓨즈의 정격이 

13암페어이고 BS1362에 대한 ASTA 또는 BSI의 승인을 

받았는지 확인하십시오. 퓨즈 본체에 ASTA 마크 또는 BSI 

마크가 있는지 확인하십시오.

퓨즈를 교체하는 방법 

1. 드라이버로 퓨즈 구획을 엽니다. 

 

플러그에 탈착식 퓨즈 덮개가 포함되어 있는 경우 퓨즈를 

교체할 때 다시 장착되었는지 확인해야 합니다. 

퓨즈 커버를 분실한 경우 교체용 커버를 얻을 때까지 

플러그를 사용해서는 안 됩니다. 교체용 퓨즈 커버는 지역 

Panasonic 대리점에서 구입할 수 있습니다. 

2. 퓨즈를 교체하십시오.  
 

 

 

 

퓨즈 

 

안전 정보를 나타냅니다. 
 

 

Manufactured by:  

Panasonic Entertainment & Communication Co., Ltd. 

1-10-12, Yagumo-higashi-machi, Moriguchi City, Osaka, Japan Importer: 

Panasonic Connect Europe GmbH 

Hagenauer Strasse 43, 65203 Wiesbaden, Germany Authorized Representative in EU: 

Panasonic Connect Europe GmbH 

Panasonic Testing Centre 

Winsbergring 15, 22525 Hamburg, Germany 

Importer for UK: 

Panasonic Connect UK, 

a branch of Panasonic Connect Europe GmbH, 

Maxis 2, Western Road, Bracknell, Berkshire, RG12 1RT 
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제작 : ㈜디브이네스트 1544-5596 

장치 구매자/사용자에 대한 EMC 고지 사항 
 

1. 위의 표준을 준수하기 위한 전제 조건 

<1> 기기에 연결할 주변 장치 및 특수 연결 케이블 

• 구매자/사용자는 장치에 연결할 주변 장비로 당사에서 권장하는 장비만 사용해야 합니다. 

• 구매자/사용자는 아래에 설명된 연결 케이블만 사용해야 합니다. 

<2> 연결 케이블은 기기의 용도에 맞는 차폐 케이블을 사용하십시오. 

• 비디오 신호 연결 케이블 

SDI(Serial Digital Interface)에는 75옴 유형 고주파 애플리케이션용으로 설계된 이중 차폐 동축 케이블을 사용합니다. 

75옴 유형의 고주파 애플리케이션용으로 설계된 동축 케이블은 아날로그 비디오 신호에 권장됩니다. 

• 오디오 신호 연결 케이블 

장치가 AES/EBU 직렬 디지털 오디오 신호를 지원하는 경우 AES/EBU용으로 설계된 케이블을 사용하십시오. 

아날로그 오디오 신호에는 고주파 전송 애플리케이션에 고품질 성능을 제공하는 차폐 케이블을 사용하십시오. 

• 기타 접속 케이블(LAN, RS-422) 

고주파 애플리케이션에 고품질 성능을 제공하는 차폐 케이블을 연결 케이블로 사용하십시오. 

• DVI 신호 단자에 연결할 때는 페라이트 코어가 있는 케이블을 사용하십시오. 

• 장치에 페라이트 코어가 함께 제공되는 경우 이 설명서의 지침에 따라 케이블에 연결해야 합니다. 

2. 성능 수준 

장치의 성능 수준은 이러한 표준에서 요구하는 성능 수준과 동등하거나 더 우수합니다. 그러나 장치가 강한 전자기장이 발생하는 영역(신호 송신탑, 휴대폰 

등의 존재에 의해)과 같은 EMC 환경에서 사용되는 경우 간섭에 의해 부정적인 영향을 받을 수 있습니다. 이와 같은 경우 장치에 대한 간섭의 부작용을 

최소화하려면 영향을 받는 장치 및 작동 환경에 대해 다음 단계를 수행하는 것이 좋습니다. 

1. 간섭원에서 멀리 떨어진 곳에 장치를 놓으십시오. 

2. 장치의 방향을 변경하십시오. 

3. 장치에 사용되는 연결 방법을 변경하십시오. 

4. 다른 기기와 전원을 공유하지 않는 다른 전원 콘센트에 기기를 연결하십시오. 

 

유럽 연합 및 재활용 시스템이 있는 국가에만 해당 
제품, 포장 및/또는 첨부 문서에 있는 이러한 기호는 사용한 전기 및 전자 제품 및 배터리를 일반 가정 쓰레기와 혼합해서는 안 된다는 의미입니다. 

오래된 제품과 사용한 배터리의 적절한 처리, 회수 및 재활용을 위해 해당 국가 법률에 따라 해당 수거 장소로 가져가십시오. 

올바르게 폐기하면 귀중한 자원을 절약하고 인간의 건강과 환경에 대한 잠재적인 부정적인 영향을 예방하는 데 도움이 됩니다. 

수거 및 재활용에 대한 자세한 내용은 지역 당국, 딜러 또는 공급업체에 문의하십시오. 이 폐기물의 잘못된 처리에 대해서는 

국가 법률에 따라 처벌이 적용될 수 있습니다. 
 

배터리 기호(하단 기호)에 대한 참고 사항: 
이 기호는 화학 기호와 함께 사용할 수 있습니다. 이 경우 관련 화학 물질에 대한 지침에서 정한 요구 사항을 준수합니다. 

 

Turkey Only 

AEEE Yönetmeliğine Uygundur. 

AEEE Complies with Directive of Turkey. 

경고: 이 제품에는 코인 배터리가 포함되어 있습니다. 

• 섭취 위험: 이 제품에는 버튼 셀 또는 코인 배터리가 

포함되어 있습니다. 

• 삼키거나 신체의 일부에 넣을 경우 2시간 이내에 사망 또는 

심각한 부상이 발생할 수 있습니다. 

• 배터리는 위험하므로 새 배터리와 사용한 배터리는 어린이의 

손이 닿지 않는 곳에 보관하십시오. 

• 배터리를 삼켰거나 신체의 일부에 삽입된 것으로 의심되는 

경우 즉시 의사의 진료를 받으십시오. 

배터리를 제거하려면 

백업 배터리(리튬 배터리) 
• 수명이 다한 후 폐기를 위해 배터리를 제거하려면 대리점에 문의하십시오. 
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ІНФОРМАЦІЯ ПРО ПІДТВЕРДЖЕННЯ ВІДПОВІДНОСТІ ПРОДУКТУ 
 

Виробник: Panasonic Entertainment 

& Communication Co., Ltd. 

Панасонік Ентертейнмент 
енд Коммюнікейшн Ко., Лтд. 

Адреса виробника: Moriguchi, Osaka, Japan Моріґучі Осака Японія 

Країна походження: China Китай 

 

Імпортер: ТОВ “ПАНАСОНІК УКРАЇНА ЛТД” 

Адреса Імпортера: вул. Васильківська, буд. 30, м. Київ 03022, Україна 

Примітки: 
 

 

Дату виготовлення можна визначити за комбінацією букв і цифр серійного номера, що розташований на 

маркувальній табличці виробу. 

 

П риклад: X X XXXXXXX  

 

Information for Users in India 
Information on hazardous constituents as specified in the E-Waste (Management) Rules in electrical and electronic equipment. Declaration of Conformity 
with the requirements of the E-Waste (Management) Rules limits with respect to Lead, Mercury, Cadmium, Hexavalent chromium, Polybrominated 
biphenyls,Polybrominated diphenyl ethers. 
The content of hazardous substance with the exemption of the applications listed in the E-Waste (Management) Rules:  

1.  Lead (Pb) – not over 0.1% by weight. 

2.  Cadmium (Cd) – not over 0.01% by weight. 

3.  Mercury (Hg) – not over 0.1% by weight. 

4.  Hexavalent chromium (Cr6+) – not over 0.1% by weight. 

5.  Polybrominated biphenyls (PBBs) – not over 0.1% by weight. 

6.  Polybrominated diphenyl ethers (PBDEs) – not over 0.1% by weight.  
For the purpose of recycling to facilitate effective utilization of resources, please return this product to a nearby authorized collection center, 
registered dismantler of recycler, or Panasonic service center when disposing of this product. 
Customer care number (Toll free) : 1800 103 1333 ,1800 108 1333 
Please see the Panasonic website for further information on collection centers, etc. or call the customer care toll-free number.  
https://www.panasonic.com/in/corporate/e-waste-management.html 

 

Do’s & Don’ts 

No. Do’s Don’ts 

1 
All electrical and electronic products are required to be handed 
over only to the Authorized recycler. 

The product should not be opened by the user himself / herself, 
but only by authorized service personnel. 

2 
The product should be handed over only to authorized recycler for 
disposal. 

The product is not meant for re-sale to any unauthorized agencies 
/ scrap dealers / kabariwalas. 

 

3 
Keep the product in an isolated area, after it becomes non- 
functional / unrepairable so as to prevent its accidental breakage. 

The product is not meant for mixing into household waste stream. 

4 Refer to Operating Instructions for handling of end of life products. 
Do not keep any replaced spare part(s) from the product in an 
exposed area. 

 

5 
Always dispose of products that have reached end of life at 
Panasonic Life Solutions India Authorized Service Centre. 

Do not donate old electronic items to anybody. 
Do not dispose of your product in garbage bins along with 
municipal waste that ultimately reaches landfill. 

 

6 

Wherever possible or as instructed, separate the packaging 
material according to responsible waste disposal options and 
sorting for recycling. 

Do not give e-waste to informal and unorganized sectors like Local 
Scrap Dealers / Rag Pickers. 

  

 

Рік: остання цифра року (6 – 2016, 7 – 2017,… 0 – 2020)  
Місяць: А – Січень, В – Лютий… L – Грудень  

 

7 років Термін служби виробу 

http://www.panasonic.com/in/corporate/e-waste-management.html
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사용하기 전에 

 

사용하기 전에 

개요 
이 장치는 다수의 3G 및 HD 포맷을 지원하는 1ME 디지털 비디오 스위처입니다. 

컴팩트한 크기에도 불구하고 SDI 입력 4개, HDMI 입력 2개, SDI 출력 2개, HDMI 출력 1개, IP 입력 4개, IP 출력 2개, 아날로그 오디오 2채널 
입출력이 제공됩니다. 

3G-SDI와 함께 NDI*1/SRT/RTMP와 같은 IP 입출력 시스템과 호환되는 AV-HSW10 컴팩트 라이브 스위처는 중급 스위처에 필적하는 기본 기능을 
갖추고 있어 HD 비디오 제작이 가능합니다. 

뛰어난 휴대성으로 올인원 메인 유닛은 다양한 라이브, 음악, 스포츠 및 엔터테인먼트 행사에서 사용할 수 있도록 쉽게 운반할 수 있습니다. 

또한, 3G/HD 멀티 포맷 지원과 함께 다양한 IP 입출력이 가능하며, UVC와 호환이 가능하여 다수의 카메라*2가 있는 행사에서 원활하게 작동할 수 
있을 뿐만 아니라, 원격지에서 다양한 표현 방식을 사용하여 영상을 직접 전송할 수 있습니다. 

다양한 프로그램 제작 기법을 가능하게 하는 키어에는 PinP 2ch와 크로마키 1ch 등 2개의 키어가 포함됩니다. 

또한 업/다운 컨버터 기능과 HDMI 스케일러 기능을 사용하여 다양한 포맷을 사용하는 장면이 있는 경우에도 목적에 맞게 유연하게 비디오 출력을 
선택할 수 있습니다. 

우리는 특별 행사장, 방송 차량, 대학교나 회사 발표회 등 다양한 휴대용 응용 프로그램, 그리고 물론 방송사 내부에서도 이 제품을 유용하게 사용하기 
위해 노력해 왔습니다. 이 소형 라이브 스위치는 현장에서 살아있는 영상을 만들 때 정말 뛰어난 성능을 발휘합니다. 

 

 

*1 NDI®는 High bandwidth NDI®를 의미합니다. NDI®|HX는 고효율, 저대역폭의 특성을 가지는 NDI®|HX를 의미합니다. 

NDI®는 NewTek,Inc.에서 개발한 IP를 사용하는 라이브 이미지 제작 워크플로를 지원하는 데 사용되는 프로토콜입니다. 

 

*2 Panasonic 4K/HD 통합 카메라 및 AG-CX350 메모리 카드 카메라 레코더. 

NDI® 및 NDI와 호환되는 4K/HD 통합 카메라의 경우|®HX, 다음 Panasonic 웹 사이트를 참조하십시오. https://pro-

av.panasonic.net/en/ 

 

 

등급 표시에 관하여 
장치의 이름, 모델 번호 및 정격 전력이 측면 패널에 표시됩니다. 

 

 

보증 면책 조항 
어떠한 경우에도 Panasonic Entertainment & Communication Co., Ltd.는 아래를 포함하되 이에 국한되지 않는 경우에 대해 제품의 교체 또는 

합리적인 유지 관리를 제외하고 당사자 또는 개인에게 책임을 지지 않습니다. 

① 제품으로 인해 또는 제품과 관련하여 발생하는 직접 또는 간접, 특별, 결과적 또는 징벌을 포함하되 이에 국한되지 않는 모든 손해 및 손실; 

② 사용자의 부적절한 사용 또는 부주의한 작동으로 인한 부상 또는 손상; 

③ 사용자가 제품을 무단으로 분해, 수리 또는 개조하는 행위 

④ 제품의 고장 또는 문제를 포함한 어떠한 이유 또는 원인으로 인해 이미지가 표시되지 않을 때 발생하는 불편 또는 손실; 

⑤ 제3자의 장치에 의해 결합된 시스템으로 인해 발생하는 모든 문제, 결과적 불편 또는 손실 또는 손해; 

⑥ 부적절한 설치 방법 또는 제품 자체의 결함 이외의 요인으로 인한 사고로 인한 모든 불편, 손해 또는 손실; 

⑦ 실패로 인한 등록된 데이터의 손실; 

⑧ 본 기기 또는 USB 메모리 또는 컴퓨터에 저장된 이미지 데이터 또는 설정 데이터의 손실 또는 유출로 인한 모든 손해 또는 청구. 
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제작 : ㈜디브이네스트 1544-5596 

네트워크 보안 
이 장치에는 네트워크에 연결되어 있을 때 사용되는 기능도 있습니다. 네트워크에 연결된 상태에서 장치를 사용하면 다음과 같은 문제가 발생할 수 

있습니다. 

① 본 기기를 통한 정보 유출 또는 도난 

② 악의적인 의도를 가진 사람에 의한 불법 작업에 이 장치가 사용됨 

③ 악의적인 의도를 가진 사람에 의한 이 장치의 간섭 또는 중지 

위의 네트워크 보안 위험으로부터 자신을 보호하기 위해 아래에 설명된 것과 같은 예방 조치를 취하는 것은 귀하의 책임입니다. 

• 방화벽 등으로 보호되는 네트워크에서 본 기기를 사용하십시오. 

• 본 기기가 컴퓨터가 포함된 네트워크에 연결된 경우 시스템이 컴퓨터 바이러스 또는 기타 악성 개체(정기적으로 업데이트되는 바이러스 백신 
프로그램, 스파이웨어 방지 프로그램 등 사용)에 감염되지 않았는지 확인하십시오. 

다음 사항도 염두에 두어야 합니다. 

• 장치에 연결된 장비에 대해 동일한 세그먼트와 함께 사용하는 것이 좋습니다. 

장치가 세그먼트가 다른 장비에 연결된 경우 예를 들어 네트워크 장비 고유의 설정에 따라 달라지는 이통풍구가 발생할 수 있으므로 작동 시작 

전에 장치가 연결될 장비와의 연결을 철저히 확인하십시오. 

• 장치, 케이블 및 기타 부품이 쉽게 손상될 수 있는 설치 위치를 선택하지 마십시오. 

• 일부 네트워크 환경에서는 NDI 통신이 불안정해질 수 있습니다. 

NDI 통신의 양을 대략적으로 계산하여 계획된 NDI 트래픽의 양을 확인한 다음 회선 속도에 충분한 위도가 있는지 확인합니다. 

단일 NDI 소스에 대해 여러 참조가 이루어지면 참조 수에 따라 전송 측의 NDI 신호 볼륨이 확장됩니다. 

시스템 설계에 필요한 것으로 보이는 경우 멀티캐스팅 사용을 조사합니다. 



13 

사용시 주의사항 

 

사용시 주의사항 
 

 조심스럽게 다루십시오. 

제품을 떨어뜨리거나 강한 충격이나 진동을 가하지 마세요. T-Bar나 

페이더 레버를 잡고 제품을 운반하거나 이동하지 마세요. 이는 

오작동이나 사고를 예방하는 데 중요합니다. 

 

 0 °C - 40 °C (32 °F - 104 °F) 사이의 

온도에서 제품을 사용하십시오. 

극도로 낮거나 높은 온도는 내부 부품에 악영향을 미치므로 

0°C(32°F) 미만의 추운 장소 또는 40°C(104°F) 이상의 뜨거운 

장소에서 제품을 사용하지 마십시오.  

 

 케이블을 연결하거나 분리하기 전에 

전원을 끄십시오. 

케이블을 꽂거나 뽑기 전에 반드시 전원을 끄십시오. 

 

 습기와 먼지를 피하십시오. 

습기와 먼지가 많으면 내부 부품이 손상될 수 있으므로 습하고 

먼지가 많은 곳에서 제품을 사용하지 마십시오. 

 

 정비 

기기의 전원을 끄고 마른 천으로 제품을 닦으세요. 잘 지워지지 않는 

더러움을 제거하려면 주방 세제(중성)를 희석한 용액에 천을 담그고 

잘 짜낸 후 제품을 부드럽게 닦아주세요. 그런 다음 젖은 천으로 

제품을 닦은 후 마른 천으로 다시 닦으십시오. 

 제품을 폐기해야 하는 경우 

수명이 다한 제품을 폐기할 경우 환경 보호를 위해 전문 계약자에게 

적절하게 폐기하도록 요청하십시오. 

 

 소모품에 관하여 

냉각팬: 
냉각팬은 소모품입니다. 

일반적으로 약 5년마다(하루 15시간 동안 장치를 작동한 경우) 

교체하십시오. 

AC 어댑터: 
이것은 소모품입니다. 

일반적으로 약 5년마다(하루 15시간 동안 장치를 작동한 경우) 

교체하십시오. 

 

소모품을 교체해야 하는 기간은 작동 조건에 따라 다릅니다. 이러한 

부품 중 하나를 교체할 시기가 되면 반드시 대리점에 작업을 

요청하십시오. 

 

 

 프로덕션 제작시 준수해야 할 주의 사항 

이 제품의 이미지 전환 및 이미지 효과 기능을 사용하여 빠르게 

깜박이는 이미지나 빠르게 변하는 이미지를 생성할 수 있습니다. 

그러나 프로덕션에서 이러한 기능을 사용할 때 생성된 이미지의 

종류가 시청자의 신체적 웰빙에 부정적인 영향을 미칠 수 있음을 

명심하십시오. 

주의 
• 벤젠, 페인트 희석제 및 기타 휘발성 액체의 사용을 

피하십시오. 

• 화학 청소용 천을 사용할 경우 사용 시 주의사항을 주의 

깊게 읽으십시오. 
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제작 : ㈜디브이네스트 1544-5596 

설치시 주의 사항 
 

  "사전 숙지 내용"에 제시된 요점에 주의를 기울이는 것 외에도 다음 예방 조치를 준수해야 합니다. 

 
대리점에 장치 설치 및 연결 작업을 요청하십시오. 

 

전원 공급 장치 연결 

• 반드시 기기와 함께 제공된 AC 케이블과 AC 어댑터만 
사용하십시오. 

• 반드시 접지를 연결하십시오. 

장치 후면의 터미널(SIGNAL GND)을 시스템 

접지에 연결합니다. 

• AC 어댑터를 완전히 밀어 넣습니다. 

• 기기를 장기간 사용하지 않을 경우 전원을 끄고 AC 콘센트에서 전원 
플러그를 뽑으십시오. 

 

조심스럽게 다루세요! 

• 기기를 떨어뜨리거나 강한 충격이나 진동을 가하면 고장 및/또는 
오작동이 발생할 수 있습니다. 

 

제품 내부에 이물질이 들어가지 않도록 하세요! 

• 물, 금속 제품, 음식 찌꺼기 또는 기타 이물질을 허용하는 행위 

기기 내부의 물체는 화재 및/또는 감전의 원인이 될 수 있습니다. 

최적의 설치 위치 선택 

• 이 장치는 실내 전용으로 설계되었습니다. 

• 사용하기에 충분히 강하고 안정적이며 평평한 표면에 장치를 
설치하십시오. 

• 환기를 방해하지 않도록 장치 통풍구 주변에 최소 100mm(3-
15/16인치)의 공간을 확보하십시오. 

특히 패널이나 테이블에 장착하여 사용할 경우 환기와 배선 사이에 

충분한 공간을 확보하십시오. 

• 케이블 및 기타 액세서리가 쉽게 손상될 수 있는 방식으로 장치를 
설치하지 마십시오. 

• 온도가 0°C(32°F) 이하로 떨어지는 추운 곳이나 40°C(104°F) 
이상으로 올라가는 더운 장소에 장치를 설치하지 마십시오. 

• 직사광선에 노출될 곳에 장치를 설치하지 마십시오. 

햇빛이나 다른 제품에서 불어오는 뜨거운 공기. 

• 매우 습하거나 먼지가 많거나 진동이 발생하기 쉬운 장소에 장치를 
설치하면 문제가 발생할 수 있습니다. 

통풍구 입구 

통풍구 입구 통풍구 배출구 
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기능 

 

기능 
 

컴팩트한 디자인, 풍부한 입력 및 출력 
• 컴팩트한 크기에도 불구하고 4개의 SDI 입력, 2개의 HDMI 입력, 

2개의 SDI 출력, 1개의 HDMI 출력을 지원합니다. 또한 IP 입력 및 
출력, 레퍼런스 입력, 스루 출력, 2채널 아날로그 오디오 입력 및 
출력, UVC 출력을 갖추고 있어 다양한 라이브 스위칭 상황에 대응할 
수 있습니다. 

• 컷, 믹스, 와이프를 사용한 백그라운드 전환과 함께 크로마키용 채널 
1개와 PinP 채널 2개를 포함한 2개의 키어가 장착되어 있습니다.  

• 멀티 뷰 디스플레이 기능을 사용하면 단일 모니터를 분할하여 최대 
16개의 비디오를 표시할 수 있습니다. 

• 입력/출력은 3G/HD-SDI를 지원하며, 각 입력에는 프레임 
싱크로나이저(FS)가 장착되어 있습니다. 

• NDI, NDI|HX, SRT, RTMP를 포함한 많은 IP 입력 및 출력 시스템을 
지원합니다, 

• 2채널 아날로그 오디오 입력 커넥터를 사용하면 모든 출력 버스를 
통해 오디오를 임베딩할 수 있습니다. 입력 레벨과 오디오 지연을 
조정할 수도 있습니다. 

 

여러 형식 지원 

• 지원되는 신호 형식은 다음과 같습니다. 
 

• 여러 2K/HD 형식을 지원합니다. 

• 3G-SDI, 1.5G-SDI, HDMI 및 IP와 같은 다양한 인터페이스와 
호환됩니다. 

• 최대 입력 수는 SDI의 경우 4개, HDMI의 경우 2개, IP의 경우 
4개입니다. 

• 최대 출력 수는 SDI의 경우 2개, HDMI의 경우 1개, IP의 경우 
2개입니다. 

• 2개의 키어가 장착되어 있어 다양한 비디오 효과를 낼 수 있습니다. 

• 업/다운 컨버터와 같은 기능을 갖추고 있습니다. 

• 2개의 AUX BUS가 장착되어 있습니다. MIX 전환 기능이 있습니다. 

• 최대 9대의 Panasonic 4K/HD 통합 카메라의 집계를 제어할 수 있는 
원격 카메라 컨트롤러 기능이 장착되어 있습니다. 

• 크로마키가 가능합니다. 

• 비디오 메모리(정지 이미지용 2개)는 키 신호가 연결된 상태로 
기록하고 불러올 수 있습니다. 

• 샷 메모리 기능을 갖추고 있습니다. 

• USB 메모리와 호환됩니다. 

HD 형식: 

720×59.94p, 720×50p 

2K 형식: 

1080 × 59.94p, 1080 × 50p, 1080 × 29.97p, 1080 × 25p, 

1080 × 24p, 1080 × 23.98p, 1080 × 59.94i, 1080 × 50i 
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액세서리 
 

다음 부속품이 존재하고 설명되어 있는지 확인합니다. 

• 제품을 용기에서 분리한 후 전원 케이블 캡(제공된 경우)과 포장재를 적절한 방법으로 폐기합니다. 

• 이 장치에는 AC 어댑터가 실수로 플러그를 뽑는 것을 방지하는 케이블 클램프가 제공됩니다. 

AC 어댑터 ............................................... 1 

케이블 클램프 ......................................... 1 

AV-HSW10P용 AC 케이블 .................... 1 

 

 

AV-HSW10E용 AC 케이블 ................... 3 

• 영국 및 사우디 아라비아의 경우  • 유럽 대륙 등의 경우  • 인도만 해당 

 

• 이 제품에는 3가지 유형의 AC 주전원 케이블이 장착되어 있습니다. 

다른 유형의 주전원 케이블은 적합하지 않으므로 각 지역에서 적절한 주전원 케이블을 사용해야 합니다. 
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액세서리  

 

케이블  클램프  부착  

 
케이블  클램프  분리  

1 1  을 잡고 2 방향으로 당깁니다. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

AC 어댑터  고정  

1 케이블 클램프 잠금 해제 
 

 

2 AC 어댑터 삽입 

 

3 케이블 클램프로 AC 어댑터의 케이블 잠금 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

① 

② 
① 
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구성과 그 기능 

 제어판  
 

 
 

① POWER 표시등 [POWER] 
DC IN 커넥터(22)에 전원이 공급되고 후면 패널의 POWER 
스위치(37)가 ON으로 설정되면 이 표시등이 켜집니다. 

 

② 알람 표시기 [ALARM] 

이 표시등은 냉각 팬(36)이 작동을 멈췄을 때, 전원 공급 장치에 

문제가 있을 때(전원 드롭) 또는 장치 내부의 온도가 비정상적으로 

높은 수준에 도달한 경우 표시됩니다. 

이 경우 OSD 메뉴에는 알람 메시지가 나타나고 외부 모니터에는 

OSD 메뉴가 표시됩니다(OSD ON 상태). 

알람 정보는 장치의 TALLY/GPI 커넥터(30)에서 외부 장치로 

출력할 수 있습니다.  "알람 메시지"를 참조하십시오. 

경보가 울리면 즉시 사용을 중지하고 반드시 대리점에 

문의하십시오. 알람이 발생한 후에도 장치를 계속 사용하면 장치가 

손상될 수 있습니다. 

 

③ STREAM 버튼 [STREAM] 

SRT/RTMP를 사용하여 본 기기에서 전송을 직접 시작, 중지 

및 대기 상태로 설정할 수 있습니다. LED 조명의 색상이 

변경되어 다음을 나타냅니다. 

전송 상태. (OFF: 꺼짐(*1), 대기: 녹색, 송신: 적색) 

본 기기에는 두 개의 전송 채널(CH1 및 CH2)이 장착되어 있으며 

[SHIFT] 버튼(6)을 누른 상태에서 CH6 작업을 수행할 수 있습니다. 

 

버튼 

조작 

전송 채널 : LED 

 

누르기 

 

길게 누르기 

OFF: 꺼짐(*1) 전송: 빨간색 대기: 녹색 

대기: 녹색 전송: 빨간색 OFF: 꺼짐(*1) 

전송: 빨간색 대기: 녹색 OFF: 꺼짐(*1) 

*1 [12] Config > Button Illumination > Color Group Other > 

STREAM의 Color Group(컬러 그룹)에 설정된 색상의 조명.  

 

④ 사용자 버튼 [USER 1, USER 2, USER 3] 

메뉴 항목 중에서 선택한 6가지 기능을 [USER 1] 버튼, [USER 2] 

버튼 및 [USER 3] 버튼에 할당하여 사용할 수 있습니다. 

[USER 1] 및 [USER 4]에 등록된 기능은 [USER 1] 버튼에 할당되고, 

[USER 2] 및 [USER 5]에 등록된 기능은 [USER 2] 버튼에, [USER 

3] 및 [USER 6]에 등록된 기능은 [USER 3] 버튼에 할당됩니다. 

SHIFT 버튼(6)을 누른 상태에서 [USER 4], [USER 5] 또는 [USER 

6]에 등록된 기능을 선택할 수 있습니다. 
 

조명 켜짐 [USER] 버튼에 할당된 기능이 활성화됩니다. 

조명 꺼짐 [USER] 버튼에 할당된 기능이 비활성화됩니다. 
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⑤ 샷 메모리 버튼 [SHOT MEM] 

이 버튼을 사용하면 샷 메모리를 등록, 불러오기 및 삭제할 수 

있습니다. 

 "샷 메모리"를 참조하십시오. 

 

⑥ SHIFT 버튼 [SHIFT] 

이 버튼은 [USER 1] 버튼, [USER 2] 버튼 및 [USER 3] 버튼에 

할당된 [USER 4], [USER 5] 및 [USER 6]의 기능을 호출하는 데 

사용되며, 크로스포인트 버튼 [1] 내지 [6] 및 Shot Memory 작업에 

할당된 XPT7 내지 XPT12 자료를 호출하는 데에도 사용됩니다. 

 ([SHIFT] 버튼을 사용하여 실행되는 기능은 버튼을 누른 상태에서만 

적용됩니다.) 

 

⑦ OSD/TIME 다이얼 
이 다이얼을 사용하여 다음 작업을 수행합니다. 

• 메인 메뉴가 표시되는 경우: 
OSD/TIME 다이얼을 돌려 하위 메뉴를 선택하고 다이얼을 눌러 
선택을 입력합니다. 

• 하위 메뉴가 표시되는 경우: 
OSD/TIME 다이얼을 돌려 하위 메뉴를 선택하고 다이얼을 눌러 
선택을 입력합니다. 
설정값을 입력할 때 처음에 다이얼을 눌렀다가 돌리면 설정값이 
바뀌고, 다시 다이얼을 누르면 설정값이 확인됩니다. 
다이얼을 길게 눌러 설정값을 기본값으로 되돌립니다. 

• 다이얼을 돌린 후에도 누른 상태에서 다이얼을 돌렸을 때 
[KEY1 ON], [KEY2 ON], [FTB ON] 또는 [AUTO] 버튼이 
보류됩니다 

 

⑧ EXIT 버튼 [EXIT] 

이 버튼은 OSD 메뉴를 사용할 때 하나의 하위 메뉴 레이어로 

이동합니다. 

 

⑨ MENU 버튼 [MENU] 

OSD 메뉴를 표시할지 숨길지 선택합니다. 

[MENU] 버튼을 길게 누를 때마다 메뉴가 표시되거나 숨겨집니다. 
 

오렌지 라이트 OSD 메뉴가 표시됨 
조명 꺼짐 OSD 메뉴 숨김 

OSD 메뉴가 표시되는 동안 [MENU] 버튼을 누르면 디스플레이가 

메인 메뉴와 상태 디스플레이 사이를 전환합니다. 

상태 표시에서 다음 정보를 볼 수 있습니다. 

• 와이프 패턴 설정 

• 전환 시간 설정 

• [USER] 버튼 설정 

• 크로스포인트 할당 설정 

 

⑩ FTB ON 버튼 [FTB ON] 

이 버튼을 누르면 설정된 전환 기간 동안 프로그램 이미지가 

검은색 화면으로 희미하게 사라집니다. 버튼을 다시 누르면 

프로그램 이미지가 검은색 화면에서 희미해집니다. 

 

검은색 화면이 아닌 다른 이미지를 프로그램 이미지를 비울 

화면으로 설정할 수 있습니다. 

→ "FTB(페이드 투 블랙)"를 참조하십시오. 

버튼을 누른 상태에서 [FTB ON] 버튼을 누른 상태로 OSD/TIME 

다이얼(7)을 돌리면 전환 기간을 변경할 수 있습니다. 

⑪ KEY 1 ON 버튼, KEY 2 ON 버튼 [KEY 1 ON, KEY 2 

ON] 

이것은 설정된 화면전환 기간 동안 주요 소스를 결합하는 데 

사용됩니다. 

 
버튼을 누른 상태에서 [KEY 1 ON] 버튼 또는 [KEY 2 ON] 버튼을 
누른 상태로 OSD/TIME 다이얼(7)을 돌리면 전환 기간을 변경할 수 
있습니다. 

 

⑫ CUT 버튼 [BKGD CUT] 

이렇게 하면 현재 선택한 작업에 대한 화면 전환이 즉시 시작됩니다. 
 

조명 켜짐 전환이 실행 중입니다. 
조명 꺼짐 전환이 완료되었습니다. 

조명 켜짐 [SHIFT] 버튼이 활성화됩니다. 

조명 꺼짐 [SHIFT] 버튼이 비활성화됩니다. 
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⑬ AUTO 버튼 [BKGD AUTO] 

이렇게 하면 설정된 전환 지속 시간(자동 전환) 동안 화면 전환이 

자동으로 시작됩니다. 
 

조명 켜짐 자동 전환이 실행 중입니다. 
조명 꺼짐 자동 전환이 완료되었습니다. 

자동 전환이 실행되는 동안 [AUTO] 버튼을 누르면 자동 전환 

작업이 중단됩니다. 작업이 중단된 후 버튼을 다시 누르면 나머지 

전환이 실행됩니다. 페이더 레버(⑭)가 중간 설정에 있는 동안 

[AUTO] 버튼을 누르면 중간 설정에서 남은 시간에 전환이 

실행됩니다. 버튼을 누른 상태에서 [AUTO] 버튼을 누른 상태로 

OSD/TIME 다이얼(7)을 돌리면 전환 기간을 변경할 수 있습니다. 

 

⑭ 페이더 레버 
화면 전환을 수동으로 실행할 때 사용됩니다. 

페이더 레버를 끝까지 움직이면 전환이 완료됩니다. 

자동 전환 중에 페이더 레버를 움직이면 페이더 레버 위치가 현재 

화면 전환량을 추월하는 지점에서 작동이 수동으로 전환됩니다. 

화면 전환과 관련된 소스에 대한 메뉴를 사용하여 배경 또는 키를 

선택할 수 있습니다. 

 

⑮ MIX/WIPE 전환 버튼 [MIX, WIPE] 
이 버튼은 화면 전환 방법을 선택합니다. 

버튼을 누를 때마다 MIX 및 WIPE 로 바뀌게 됩니다. 

MIX 이것은 A 버스와 B 버스의 이미지(또는 PGM 버스와 

PST 버스의 이미지)를 겹치면서 전환(MIX 전환)을 

실행하는 데 사용됩니다. 

트랜지션이 실행되는 동안 A 버스 및 B 버스(또는 PGM 

버스 및 PST 버스) 출력의 총계는 100%로 유지됩니다. 

왼쪽의 [MIX] 표시등이 주황색으로 켜지고 MIX가 

선택됩니다. 

WIPE 선택한 WIPE 패턴에 따라 전환이 이루어집니다. 

WIPE가 선택되어 있는 동안. 왼쪽의 [WIPE] 표시등이 

주황색으로 켜집니다. 

 

⑯ 버스 탈리 인디케이터 [A, B] 

프로그램(PGM) 소스가 출력되는 버스에 해당하는 표시기가 

켜집니다. 

 

⑰ AUX 버스 선택기 버튼 [AUX BUS DELEGATION] 

AUX 버스 크로스포인트 버튼( ⑱ )을 사용하여 작동할 버스를 

선택합니다. 

선택한 버튼에 불이 들어옵니다. 

[키 1], [키 2]: 

이 버튼은 AUX 버스 크로스포인트 버튼(18)을 키 채우기 버스 또는 

키 소스 버스의 소스 선택기 버튼으로 변경하는 데 사용됩니다. 누를 

때마다 선택기 버튼 기능이 키 필 버스와 키 소스 버스 간에 

전환됩니다. 
 

오렌지 색  키 필 버스 
초록 색 주요 소스 버스 

[AUX 1], [AUX 2]: 

이 버튼은 AUX 버스 크로스포인트 버튼(18)을 AUX 버스 소스의 

선택기 버튼으로 변경하는 데 사용됩니다. 

 

⑱ AUX 버스 크로스포인트 버튼 

이 버튼은 AUX 버스 선택 버튼(17)으로 선택한 버스의 소스를 

선택하는 데 사용됩니다. 버튼 1에서 12는 [SHIFT] 버튼(6)을 

사용하여 선택할 수 있습니다 

크로스포인트 버튼(18, 20, 21)을 누르고 있으면 OSD에 입력 

소스의 이름과 크로스포인트 버튼 번호가 표시됩니다. 

 

⑲ AUX 버스 전용 크로스포인트 버튼 [AUX SOURCE] 

[AUX 1], [AUX 2] AUX 버스 선택 버튼(A)이 켜져 있는 동안 이들은 

AUX 버스 소스를 선택합니다. 누른 버튼이 주황색으로 바뀝니다. 

[MV]: 

AUX 버스에 대한 멀티 뷰 디스플레이 신호를 선택합니다. 

[PGM/PVW]: 

AUX 버스에 대한 PGM 신호 또는 PVW 신호를 선택합니다. 

PGM 신호와 PVW 신호 간의 전환은 [SHIFT] 버튼(6)으로 

수행됩니다. 

 

⑳ PGM 버스 크로스포인트 버튼 [1 - 6] 

이는 PGM/A 버스 비디오 신호를 선택하는 데 사용됩니다. 버튼 

1에서 12는 [SHIFT] 버튼(6)을 사용하여 선택할 수 있습니다. 

버스 모드는 구성 메뉴에서 "A/B", "PGM-A/PST-B" 또는 

"PGM-B/PST-A"로 선택할 수 있습니다. 

 "배경 전환"을 참조하십시오. 

크로스포인트 버튼(18, 20, 21)을 누르고 있으면 OSD에 입력 

소스의 이름과 크로스포인트 버튼 번호가 표시됩니다. 

 

㉑ PST 버스 크로스포인트 버튼 [1 - 6] 

PGM/B 버스 비디오 신호를 선택하는 데 사용됩니다. 버튼 1에서 

12는 [SHIFT] 버튼(6)을 사용하여 선택할 수 있습니다. 

버스 모드는 구성 메뉴에서 "A/B", "PGM-A/PST-B" 또는 

"PGM-B/PST-A"로 선택할 수 있습니다. 

 "배경 전환"을 참조하십시오. 

크로스포인트 버튼(18, 20, 21)을 누르고 있으면 OSD에 입력 

소스의 이름과 크로스포인트 버튼 번호가 표시됩니다. 
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 후면 패널 영역  
 

 
 

 

㉒ 전원 스위치 [POWER] 

[POWER] 스위치가 켜지면 [POWER] 표시등(1)이 켜지고 기기를 

작동할 수 있습니다. 

 

㉓ SDI IN 커넥터 [SDI IN 1 - 4] 
HD SDI 신호 입력 커넥터입니다. 

• SDI IN 1과 HDMI IN 1은 상호 배타적입니다. 입력 메뉴에서 그 
중 하나를 선택합니다. 

• SDI IN 3 및 4에서 사용할 수 있는 고급 업컨버터 / 다운컨버터 
설정이 있습니다. 

 

㉔ SDI OUT 커넥터 [SDI OUT 1, 2] 

HD SDI 신호 출력 커넥터입니다. 다음 신호는 메뉴 조작을 통해 

커넥터에 할당할 수 있습니다. 

 
SDI OUT 1 커넥터에서 OSD 메뉴가 표시되지 않습니다. 

 

㉕ HDMI IN 커넥터 [HDMI IN 1, 2] 

HDMI 신호 입력 커넥터입니다. HDMI 1.4b를 지원합니다. 이 

장치는 HDCP를 지원하지 않습니다. 

다음 해상도의 신호는 메뉴 조작으로 입력할 수 있습니다. 
 

 
• HDMI IN 커넥터는 스케일러 기능을 지원합니다. 

㉖ HDMI OUT 커넥터[HDMI OUT] 

HDMI 신호 출력 커넥터입니다. 다음 신호는 메뉴 조작을 통해 

커넥터에 할당할 수 있습니다. 
 

 
본 기기의 시스템 형식과 동일한 해상도로 출력할 수 있습니다. 

다음 해상도의 신호는 메뉴 조작으로 출력할 수 있습니다. 

출력 해상도는 1080/720으로 고정할 수 있습니다. 

 

㉗ 레퍼런스 입력 커넥터[REF] 
외부 동기화 모드에서 루프 스루 출력입니다. 

루프 스루 출력을 사용하지 않을 경우 75옴 터미네이션을 제공합니다. 
 

㉘ 오디오 입력 커넥터[AUDIO IN] 

외부 오디오(마이크/라인)를 입력하기 위한 커넥터입니다. 

Left, Right 두 채널을 지원합니다. 
 

㉙ USB 커넥터(*1)(Type-C 커넥터)[USB STREAM OUT] 

본 기기의 비디오 및 오디오 출력을 USB 비디오 클래스를 통해 

연결하여 컴퓨터로 로드할 수 있습니다. 

다음 신호는 메뉴 조작을 통해 커넥터에 할당할 수 있습니다. 

 
*1 USB 3.2 Gen1 장치, USB 버스 전원 기능 없음 

  

PGM, PVW, CLN, AUX1, AUX2, MV, Key Out 

해상도 (수직 주파수 : 60Hz) : 

WSXGA+(1600 × 1050), SXGA(1280 × 1024), 

WXGA(1280 × 768), XGA(1024 × 768) 

해상도: 

1920 × 1080/59.94p, 1920 × 1080/50p, 

1920 × 1080/29.97p, 1920 × 1080/25p, 1920 × 1080/24p, 

1920 × 1080/23.98p, 1920 × 1080/59.94i, 1920 × 1080/50i, 

1280 × 720/59.94p, 1280 × 720/50p 

PGM, PVW, CLN, AUX1, AUX2, MV, Key Out 

PGM, PVW, CLN, AUX1, AUX2, MV, Key Out 

해상도 (수직 주파수 : 60Hz) : 

WSXGA+(1600 × 1050), SXGA(1280 × 1024), 

WXGA(1280 × 768), XGA(1024 × 768) 

해상도: 

1920 × 1080/59.94p, 1920 × 1080/50p, 

1920 × 1080/29.97p, 1920 × 1080/25p, 1920 × 1080/24p, 
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㉚ TALLY/GPI 커넥터 

[TALLY/GPI] (D-sub 15핀, 암, 인치 나사) 이 장치에는 외부 

장치에서 본 장치를 제어하기 위한 5개의 접점 입력 포트와 이 

장치의 탈리 정보 및 알람 정보를 출력하기 위한 8개의 오픈 컬렉터 

출력 포트가 장착되어 있습니다. 

 

㉛ LAN 커넥터 [LAN] (RJ-45) (1000Base-T) 
IP 제어를 위해 외부 장치를 본 기기에 연결하는 데 사용되는 LAN 
커넥터(RJ-45)입니다. 

또한 IP 신호는 이 커넥터에서 수신한 끝단으로도 전송됩니다. 

LAN 케이블(*1)을 사용하여 연결하십시오. 

*1 카테고리 5e 이상, STP(Shielded Twisted Pair), 최대 

100m(328피트) 

 

 

㉜ 서비스 스위치 [BOOT SV/NM] 

이 스위치는 유지 관리 목적으로 사용됩니다. 정상 작동의 

경우 [NM] 위치를 선택하십시오. 

 

㉝ 접지 커넥터 [SIGNAL GND] 
시스템의 접지에 연결합니다. 

 

㉞ 보안 슬롯 

Kensington에서 제조한 보안 케이블을 연결할 수 있습니다. 

연결 지침은 케이블과 함께 제공된 사용 설명서를 참조하십시오. 

보안 슬롯과 보안 케이블은 도난 방지를 위한 것입니다. 

Panasonic은 도난 사고가 발생할 경우 발생하는 손해에 대해 

책임을 지지 않습니다. 

 

 오른쪽 패널 영역  

 

㉟ USB 커넥터(*2) (Type-A 커넥터) [USB]  
프로젝트 파일은 본 기기와 USB 메모리를 연결하여 로드하고 저장할 수 있습니다. 

또한 스틸 데이터를 로드 및 저장하고, 로그 파일을 저장하고, 

펌웨어를 로드할 수 있습니다. 

*2 USB2.0 장치, USB 버스 전원 기능 포함 

 

㊱ 냉각 팬 

냉각 팬의 통풍구를 막으면 오작동이 발생할 수 있습니다. 

통풍구 근처에 충분한 공간을 두십시오. 
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구성과 그 기능  

 

 왼쪽 패널 영역   
 

 

㊳ DC IN 커넥터 [DC IN 16 V ] (DC 16V, 3.0A) 

장치와 함께 제공된 AC 어댑터가 이 커넥터에 연결되어 있습니다. 

 

㊴ 케이블 클램프 장착용 홀 

제공된 케이블 cl 부착amp AC 어댑터를 고정합니다. (17페이지) 

 

 전면 패널 영역  
 

 
㊴ 헤드폰 커넥터 [  ] (Φ3.5mm, 스테레오 미니 잭) 

오디오 출력은 헤드폰을 장치에 연결하여 모니터링할 수 있습니다. 

본 기기의 설정 메뉴에서 PGM, PVW, AUX1, AUX2 또는 CLN을 

선택할 수 있습니다. 

 

㊵ 모니터 볼륨 다이얼 [LEVEL] 
이 다이얼은 모니터링 헤드폰의 볼륨을 조정하는 데 사용됩니다. 
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운영 전 준비 

 장치의 전원 켜기 및 끄기  
 

  

1 [POWER] 스위치를 ON 위치로 설정합니다. 
기기에 전원이 공급되면 [POWER] 표시등이 켜집니다. 

장치를 시작하는 동안 PGM 버스 크로스포인트 버튼과 PST 버스 

크로스포인트 버튼이 순서대로 연한 파란색입니다. 모든 버튼이 

꺼지면 장치 시작이 완료된 것입니다. 

1 [POWER] 스위치를 OFF 위치로 설정합니다. 
기기의 전원이 꺼지고 [POWER] 표시등이 꺼집니다. 

 

 비디오 출력 확인  

다음은 장치의 비디오 출력을 확인하기 위해 외부 모니터에 장치의 OSD 메뉴를 표시하는 데 취한 단계입니다. 

 

 SDI 모니터에  OSD 메뉴  표시하기   

1 SDI 모니터를 본 장치의 SDI OUT 2에 연결합니다. 

1 HDMI 모니터를 본 장치의 HDMI OUT 커넥터에 
연결합니다. 

2 HDMI 모니터의 전원을 켭니다. 

3 기기의 전원을 켭니다. 

4 [MENU] 버튼을 길게 누릅니다. 

[MENU] 버튼 표시등이 켜지고 HDMI 모니터에 OSD 메뉴가 

표시됩니다. 

모니터에 OSD 메뉴가 나타나지 않으면 "OSD 메뉴를 강제로 

표시하는 방법"을 참조하십시오. 

커넥터. 

2 SDI 모니터의 전원을 켭니다. 

3 기기의 전원을 켭니다. 

4 [MENU] 버튼을 길게 누릅니다. 

[MENU] 버튼 표시등이 켜지고 OSD 메뉴가 SDI 모니터에 

표시됩니다. 

모니터에 OSD 메뉴가 나타나지 않으면 "OSD 메뉴를 강제로 

표시하는 방법"을 참조하십시오. 

 

 

전원 켜기 전원 끄기 

메모 

위의 단계를 수행한 후에도 HDMI 모니터에 OSD 메뉴가 나타나지 

않으면 HDMI 모니터가 본 장치의 HDMI 출력 형식을 지원하지 

않음을 의미할 수 있습니다. 

HDMI 모니터의 입력 사양을 확인하세요. 

노트 

OSD 메뉴는 SDI OUT 1 커넥터에서 출력할 수 없습니다. 

위의 단계를 수행한 후에도 SDI 모니터에 OSD 메뉴가 

나타나지 않으면 본 장치에 설정된 비디오 형식이 올바른 

형식이 아닐 수 있습니다. 

다음 섹션의 단계에 따라 장치의 비디오 형식을 변경합니다. 

 "비디오 형식 변경"을 참조하십시오. 

HDMI 모니터에 OSD 메뉴 표시하기 
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운영 전 준비 

 

 

 
전원이 꺼진 상태에서 비디오 형식을 지정한 다음 시스템을 시작할 수 있습니다. 

SDI 모니터가 본 장치에 연결되어 있어도 OSD 메뉴가 표시되지 않으면 비디오 형식을 변경해야 합니다. 

아래 단계에 따라 비디오 형식을 변경하십시오. 

PC 모니터를 사용하여 OSD 메뉴를 표시할 수 있는 경우 "시스템 포맷 설정"의 단계에 따라 비디오 포맷을 변경하십시오. 

1. 장치의 전원을 끕니다. 

2. SDI 모니터에서 지원하는 비디오 형식에 해당하는 버튼을 누른 상태에서 유닛의 전원을 켭니다. 

 

동시에 누르는 버튼 조합 비디오 포맷 

[MENU] + A bus crosspoint [1] 1080/59.94p 

[MENU] + A bus crosspoint [2] 1080/50p 

[MENU] + A bus crosspoint [3] 1080/59.94i 

[MENU] + A bus crosspoint [4] 1080/50i 

[MENU] + A bus crosspoint [5] 1080/29.97p 

[MENU] + A bus crosspoint [6] 1080/25p 

[MENU] + B bus crosspoint [1] 1080/24p 

[MENU] + B bus crosspoint [2] 1080/23.98p 

[MENU] + B bus crosspoint [3] 720/59.94p 

[MENU] + B bus crosspoint [4] 720/50p 

 

• 장치 시작이 완료될 때까지 버튼을 계속 누르십시오. 

3. [MENU] 버튼을 길게 누릅니다. 
[MENU] 버튼 표시등이 켜지고 OSD 메뉴가 SDI 모니터에 표시됩니다. 

 

비디오 형식 변경 

메모 

위의 단계를 수행한 후에도 SDI 모니터에 OSD 메뉴가 나타나지 않으면 SDI 모니터가 본 장치의 SDI 출력 형식을 지원하지 않음을 의미할 수 

있습니다. SDI 모니터의 입력 사양을 확인하십시오. 
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OSD(On-Screen Display) 메뉴 조작 
 

장치의 설정은 외부 모니터에 표시되는 OSD 메뉴를 사용하여 선택합니다. 여기에서는 OSD 메뉴를 조작하는 방법에 대해 설명합니다. 
 

 

[MENU] 버튼을 누르고 있으면 [MENU] 버튼 표시등이 켜지고 외부 모니터에 OSD 메뉴가 표시됩니다. 

OSD 메뉴가 표시된 상태에서 [MENU] 버튼을 누르고 있으면 [MENU] 버튼 표시가 꺼지고 OSD 메뉴 표시가 지워집니다. 
 

 

OSD 메뉴 출력 커넥터는 [12] Config의 Operate > Menu Out 항목을 사용하여 변경할 수 있습니다. 
 

SDI OUT2 메뉴는 SDI OUT 2 커넥터에서 출력됩니다. 

HDMI OUT 메뉴는 HDMI OUT 커넥터에서 출력됩니다. 

SDI2+HDMI 메뉴는 SDI OUT 2 커넥터와 HDMI OUT 커넥터에서 모두 출력됩니다. 

 

또한 [11] 출력의 OUT6 (UVC OUT) > 메뉴 출력 항목의 설정을 사용하여 USB 커넥터(USB STREAM OUT, Type-C 커넥터)의 OSD 메뉴 출력 설정을 

변경할 수 있습니다. 

On OSD 메뉴는 USB 커넥터(Type-C 커넥터)를 통해 출력됩니다. 

Off OSD 메뉴는 USB 커넥터(Type-C 커넥터)를 통해 출력되지 않습니다. 

 

기기 작동 중 [MENU] 버튼과 [SHIFT] 버튼을 동시에 누르면 다음이 자동으로 설정됩니다. 

• SDI OUT 2 커넥터와 HDMI OUT 커넥터는 OSD 메뉴를 출력하도록 설정되어 있습니다. 또한 USB 커넥터(Type-C 커넥터)에서 출력할 수 
있습니다. 

• HDMI OUT 커넥터에서 출력되는 화면 크기는 "자동"으로 설정되어 있습니다. 

  

OSD 메뉴 표시 및 지우기 

기본 조작 

OSD 메뉴를 출력하기 위한 커넥터 변경 

메모 

OSD 메뉴는 SDI OUT 1 커넥터에서 출력할 수 없습니다. 

OSD 메뉴를 강제로 표시하는 방법 
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 메뉴  구성  및  메뉴  간  이동  

 

OSD 메뉴는 여러 레이어가 있는 "메인 메뉴"와 "하위 메뉴"로 구성됩니다. 

메인 메뉴: 

하위 메뉴 항목이 나열됩니다. 

하위 메뉴: 

하위 계층의 하위 메뉴 항목이 표시됩니다. 그러면 설정 

항목과 설정이 표시됩니다. 이 화면에서 설정을 변경할 

수 있습니다. 
 

 

주 메뉴에서 하위 메뉴로 이동하기  

하위 메뉴 항목을 선택하려면 : 

OSD/TIME 다이얼을 돌려 항목을 선택합니다. 

하위 메뉴 항목에 대해 선택한 설정 입력: 
OSD/TIME 다이얼을 눌러 선택한 항목의 설정으로 들어갑니다. 

 

하위 메뉴에서 상위 계층의 하위 메뉴로 또는 주 메뉴로 이동 
[EXIT] 버튼을 눌러 상위 레이어의 하위 메뉴 또는 메인 메뉴로 돌아갑니다.  

 

 

 

메뉴에 많은 설정 항목이 포함되어 있으면 둘 이상의 페이지에 표시됩니다. 

이 설명서에서는 메뉴 화면이 두 페이지 이상으로 구성된 경우에도 하나의 메뉴 화면만 표시됩니다. 

장치의 메뉴 구성 

메인 메뉴와 하위 메뉴 간 이동 

두 개 이상의 페이지로 구성된 메뉴 표시 
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 하위  메뉴를  사용한  작업  

 

1. 설정 항목이 있는 라인을 선택합니다. 
강조 표시된 커서는 OSD/TIME 다이얼을 돌릴 때 위아래로 움직입니다. 

변경하려는 설정 항목의 라인에 커서가 있을 때 OSD/TIME 다이얼을 누르면 설정 값을 변경할 수 있습니다. 

또한 ">"는 추가 하위 메뉴가 있는 경우 항목 오른쪽에 표시됩니다. 아래 레이어의 하위 메뉴는 OSD/TIME 다이얼을 누를 때 표시됩니다. 

 

OSD/TIME 다이얼을 돌려  

항목을 선택합니다 

OSD/TIME 다이얼을 눌러 
항목을 입력합니다. 

이제 설정 값을 변경할 수  

있습니다. 

 

2. 설정을 변경합니다. 
설정 값을 변경하는 방법에는 다음과 같은 두 가지가 있습니다. 

• 풀다운 메뉴 

변경하려는 설정 항목의 라인에 커서가 있는 동안 OSD/TIME 다이얼을 누르면 설정할 수 있는 값이 있는 풀다운 메뉴가 표시됩니다. 

OSD/TIME 다이얼을 돌려 커서를 설정 값으로 이동한 다음 OSD/TIME 다이얼을 눌러 해당 값으로 업데이트합니다. 

• 숫자 값 변경 

설정을 변경할 수 있도록 변경하려는 설정 항목의 회선에서 OSD/TIME 다이얼을 누릅니다. OSD/TIME 다이얼을 돌려 설정을 

변경합니다. 다이얼을 더 빨리 돌리면 값이 더 빨리 변경됩니다. 

 

OSD/TIME 다이얼을 돌려 현재 깜박이는 설정을 변경합니다. 

 

[설정을 기본값으로 되돌리기] 
OSD/TIME 다이얼을 지금 누르고 있으면 값이 기본값으로 돌아갑니다. 

 

메모 

일반 설정 항목의 값이 변경되면 이러한 변경 사항이 즉시 반영되지만 일부 설정 항목(예: 형식)의 경우 변경 사항이 적용된 후 OSD/TIME 

다이얼을 누르지 않으면 변경 사항이 반영되지 않습니다. 

이 유형의 항목에서 커서가 깜박입니다. 
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 문자열  입력  

이 장치의 일부 설정 항목에서는 문자열을 입력해야 합니다. 
 

 

문자열을 입력할 수 있도록 변경하려는 설정 항목의 회선에서 OSD/TIME 다이얼을 누릅니다. 키보드와 유사한 문자열 선택 화면이 나타나고 

노란색 테두리는 선택을 나타냅니다. 

OSD/TIME 다이얼을 돌려 문자를 선택한 다음 OSD/TIME 다이얼을 눌러 문자를 입력합니다. 다음을 선택하면 사용 가능한 

문자 유형이 변경됩니다. 
 

[A-a] 대문자와 소문자 사이를 전환합니다. 

[BS] 한 문자를 삭제합니다. 

[123#+=] 숫자 및 기호 입력으로 전환합니다. 

[!? ~] 심볼 입력으로 전환합니다. 

[ ] 빈 칸 

[   ] 커서를 왼쪽으로 이동합니다. 

[   ] 커서를 오른쪽으로 이동합니다. 

[Enter] 문자열을 확인하고 설정 줄로 돌아갑니다. 

[Load TEXT] USB 메모리에서 문자열을 로드하기 위한 화면을 엽니다. 

[Load TEXT]를 선택하면 본 기기에서 포맷한 USB 메모리의 "HS\HSW10\TEXT" 폴더에 저장된 텍스트 파일(.txt)을 로드하고 내용을 사용하여 

문자열로 설정할 수 있습니다. USB 메모리가 연결되어 있지 않으면 [Load TEXT]를 선택할 수 없습니다. 
 

 

USB 메모리가 연결되어 있을 때 [Load TEXT]를 선택할 수 있습니다. 
 

[Load TEXT]에 관한 주의사항 
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[Load TEXT]를 선택한 후 표시된 대화 상자에서 로드할 텍스트 파일을 선택합니다. 
 

 

텍스트 파일에는 다음과 같은 제한 사항이 있습니다. 

• 일본어와 같이 멀티 바이트 문자를 포함할 경우 로드 오류가 발생합니다. 

• 사용 가능한 입력 문자열 길이 까지만 로드 할 수 있습니다. 

• 줄 바꿈 (Line feed) 문자는 자동으로 삭제됩니다. 

 

 이  사용  설명서에  사용된  표시  

설정 항목에 대한 작업은 아래와 같이 이 사용 설명서에 표시되어 있습니다. 

예: "[1] WIPE > BKGD 전환 > 방향" 항목을 조작하는 경우. 

서브 메뉴 

아이템 설정 
[1] > WIPE 

BKGD Transition > Direction 
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운영 전 준비 

 

 메뉴  위임  기능  

다음 버튼을 두 번 누르면 메뉴가 위임 메뉴로 전환됩니다. (메뉴 위임 기능) 

누른 버튼에 해당하는 작업도 실행됩니다. 

 

<메뉴 위임 기능 목록> 
 

버튼 메뉴 선택 

AUTO  

 

[5] Time 

FTB 

KEY 1 ON 

KEY 2 ON 

MIX/WIPE [1] WIPE 

KEY 1 F/S • PinP가 “On”인 경우 

[3] Key > PinP 

• PinP를 "Off"로 설정하고 키 타입으로 "Chroma"를 선택한 경우 

[4] ChromaKey 

• PinP가 "Off"이고 키 유형으로 "Chroma" 이외를 선택한 경우 

[3] Key 

KEY 2 F/S • PinP가 “On”인 경우 

[3] Key > PinP 

• PinP가 "Off"이고 키 유형으로 "Chroma" 이외를 선택한 경우 

[3] Key 

USER 1  

 

 

 

[12] Config > User Button 

USER 2 

USER 3 

USER 4 (SHIFT + USER 1) 

USER 5 (SHIFT + USER 2) 

USER 6 (SHIFT + USER 3) 

 

 

 버스  상태  표시  

OSD 메뉴가 표시되는 동안 [MENU] 버튼을 다시 누르면 상태 화면이 표시됩니다. 또한 A 버스, B 버스 또는 AUX 버스 크로스포인트 버튼을 

누르고 있으면 OSD 메뉴에 상태 화면이 표시됩니다.  
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 배경 전환  
 

 버스  선택  

크로스포인트 버튼 중 하나를 눌러 배경 전환에 사용할 소스를 

선택합니다. 

작동 상태에 따라 누른 버튼은 두 가지 색상 중 하나로 켜집니다. 

빨간색 조명 선택한 입력 신호가 PGM으로 출력될 때. 
(단, 표시 중에는 황색으로 켜집니다. 
FTB 작업.) 

초록색 조명 선택한 입력 신호가 PGM으로 출력되지 않는 
경우. 

 

 
  

• 크로스포인트 버튼을 누르고 있으면 크로스포인트 버튼을 누르고 
있는 동안 버튼 번호와 버튼에 할당된 입력 소스의 이름이 내장 
디스플레이에 목록 형태로 표시됩니다. 

 

 
 

 SHIFT 기능을  사용하여  버스  선택  

SHIFT 기능을 사용하면 전면 소스와 후면 소스의 두 가지 소스를 

하나의 버튼에 할당하고 [SHIFT] 버튼을 사용하여 소스를 선택할 수 

있습니다. 

전면 소스(1-6)와 후면 소스(7-12) 등 총 12개의 소스를 12개의 

크로스포인트 버튼으로 구성된 3개 그룹에 할당할 수 있습니다. 

이러한 버튼은 PGM/A 버스 크로스포인트 버튼, PST/B 버스 

크로스포인트 버튼 또는 AUX 버스 크로스포인트 버튼입니다. 

All SHIFT는 PGM/A 버스 크로스포인트 버튼, PST/B 버스 

크로스포인트 버튼 또는 AUX 버스 크로스포인트 버튼의 모든 소스를 

전면 소스에서 후면 소스로 또는 그 반대로 전환하는 데 사용됩니다. 

 

• 후면 소스(7~12)는 [SHIFT] 버튼을 누르고 있는 동안에만 
선택됩니다. 

 

버스  모드  선택  

설정 메뉴에서 A/B 버스 모드 또는 플립플롭 시스템(PGM/PST 

시스템)을 선택합니다. 

다음 메뉴 조작으로 버스 모드를 선택합니다. 

 

 [12] Config >  

Operate > Bus Mode 
 

 

전환  모드  선택  

[MIX] 및 [WIPE] 버튼을 사용하여 전환 모드를 선택합니다. 

 

[MIX/WIPE] 전환 버튼으로 배경 전환 모드를 전환합니다. 

선택한 모드의 LED가 켜집니다. 

  

A/B 페이더 레버가 A 측에 있으면 A 버스가 선택한 

신호가 PGM 버스 재료로 대체됩니다. 

페이더 레버가 B 측에 있으면 B 버스가 선택한 

신호가 PGM 버스 재료로 대체됩니다. 

PGM-

A/PST-B 

플립플롭 시스템을 사용하면 A 버스에서 선택한 

신호는 항상 PGM 버스 재료로 대체되고 B 버스에서 

선택한 신호는 항상 PST 버스 재료로 대체됩니다. 

PGM-

B/PST-A 

플립플롭 시스템을 사용하면 B 버스에서 선택한 

신호는 항상 PGM 버스 재료로 교체되고 A 버스에서 

선택한 신호는 항상 PST 버스 재료로 교체됩니다. 
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수동  전환  

T-Bar(페이더 레버)를 조작하여 수동으로 전환을 실행합니다. 

자동 전환 중에 페이더 레버를 조작한 경우 페이더 위치가 실행 중인 

전환의 양을 추월하는 즉시 자동 전환이 수동 작동으로 전환됩니다. 

페이더 레버 왼쪽에 있는 버스 탈리 LED는 프로그램 버스 출력 상태를 

나타냅니다. 
 

LED A만 켜짐 PGM/A 버스 출력 
LED A 및 B 켜짐 전환 중 
LED B만 켜짐 PST/B 버스 출력 

 

다음 메뉴 조작으로 전환 대상을 선택합니다. 

 

 [12] Config >  

Operate > Fader 
 

트랜지션이 실행될 다음 대상 중 하나는 페이더 레버를 조작하여 설정할 
수 있습니다. 
 

BKGD 배경 전환 
KEY1 키 전환 

BKGD+KEY1 배경 전환과 키 전환이 동시에 실행됩니다. 

No Assign 페이더 레버를 조작하는 경우에도 전환이 실행되지 
않습니다. 

 

 

 

 

 

 

 

자동  전환  

• [AUTO] 버튼을 누르면 설정된 전환 시간을 사용하여 자동으로 전환이 
실행됩니다. 

• 페이더 레버가 작동하는 동안 [AUTO] 버튼을 누르면 남은 시간에 

전환이 실행됩니다. 

 

자동 전환 시간 설정은 다음 메뉴 작업을 통해 이루어집니다: 

 

 [5] Time >  

BKGD 
 

다음 메뉴 작업으로 디스플레이 장치를 선택합니다: 

 

 [12] Config >  

Operate > Time Unit 
 

Sec 시간이 초 단위로 표시됩니다. 
Frame 시간이 프레임 수로 표시됩니다. 

0에서 999f 사이의 시간을 설정할 수 있습니다. 초를 표시 단위로 

사용할 때 설정할 수 있는 시간은 시스템 형식에 따라 다릅니다. 
 

59.94i 최대 33s09f 29.97p 최대 33s09f 
50i 최대 39s24f 25p 최대 39s24f 
59.94p 최대 16s39f 24p 최대 41s15f 
50p 최대 19s49f 23.98p 최대 41s15f 

 

• 페이더 레버 기능의 설정으로 "KEY1", "BKGD+KEY1" 또는 "No 
Assign"을 선택한 경우에도 배경은 항상 자동 전환을 실행하기 위한 
대상으로 사용됩니다. 

 

 컷  전환  
 

[CUT] 버튼을 누르면 전환이 즉시 실행됩니다. 

 

페이더 레버 기능의 설정으로 "KEY1", "BKGD+KEY1" 또는 "No Assign"을 
선택한 경우에도 배경은 항상 컷 전환을 실행하기 위한 대상으로 
사용됩니다. 
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와이프 (Wipe) 
 

 와이프  패턴  선택  

다음 메뉴 조작으로 와이프 패턴을 선택합니다. 

 [1] Wipe >  

BKGD Pattern 

<와이프 패턴 표> 

 

와이프 패턴 및 번호 
 

 
1 

 

 
2 

 

 
3 

 

 
4 

 

 
5 

 

 
6 

 

 
7 

 

 
8 

 

 
9 

 

 
10 

 

 
11 

 

 
12 

 

 
13 

 

 
14 

 

 
15 

 

 
16 

    

 

 와이프  방향  선택  

다음 메뉴 조작으로 배경 전환의 지우기 방향을 선택합니다. 

 

 [1] Wipe >  

BKGD Transition > Direction 

(키 전환은 메뉴에 의해 설정됩니다. 여기서 설정된 방향은 반영되지 
않습니다.) 
→ "키 전환"을 참조하십시오. 

 
 

[Normal]을 선택한 경우: 
와이프가 정상적인 방향으로 진행됩니다. 

[Reverse]를 선택한 경우: 
와이프가 반대 방향으로 진행됩니다. 

[N/R]을 선택한 경우: 
화면 전환이 완료되면 전환 방향이 반대 방향으로(또는 그 반대로) 

바뀝니다. 

 

 와이프  세부  항목 (테두리 ,  소프트  효과 )  

테두리 효과 또는 소프트 효과를 배경 전환의 지우기에 추가할 수 

있습니다. 

 
 

① 다음 메뉴 조작으로 테두리 On/Off를 선택합니다. 

 [1] Wipe >  

BKGD Transition > Border > Border 
 

② 다음 메뉴 조작으로 테두리 너비를 설정합니다. 

 [1] Wipe >  

BKGD Transition > Border > Widt 
 

③ 다음 메뉴 조작으로 소프트 효과의 양을 설정합니다. 

 [1] Wipe >  

BKGD Transition > Border > Soft 

 

테두리 항목 설정으로 "On"를 선택하면 테두리 너비에 대한 소프트 

효과의 비율이 소프트 효과의 양으로 표시됩니다. 

와이프에 소프트 효과 만 추가하려면 테두리 항목 설정으로 "Off"를 

선택하십시오. 

 

다음 메뉴 조작으로 테두리 색상의 Hue, Sat, Lum 을 조정합니다. 

 [1] Wipe >  

BKGD Transition > Border Color > Hue 
 

 [1] Wipe >  

BKGD Transition > Border Color > Sat 
 

 [1] Wipe >  

BKGD Transition > Border Color > Lum 
 

  

테두리 및 소프트 효과 설정 

테두리 색상 설정 
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■ 미리 설정된 색상을 호출하려면 

다음 메뉴 조작으로 사전 설정 색상을 선택하고 OSD/TIME 다이얼을 

누릅니다. 

 [1] Wipe >  

BKGD Transition > Border Color > Load 

• OSD/TIME 다이얼을 누르면 지금까지 설정한 내용이 취소되고 미리 
설정된 색상 값으로 바뀝니다. 

• 프리셋 컬러를 호출하기 전에 설정한 값을 저장하려면 "샷 
메모리"를 참조하십시오. 

 

 와이프  시작  위치  설정  

와이프 시작은 원하는 위치에서 설정할 수 있습니다. 
 

 

 

① 다음 메뉴 조작으로 지우기 시작 위치를 설정합니다. 

 [1] Wipe >  

BKGD Transition > Position > X-Position 
 

 [1] Wipe >  

BKGD Transition > Position > Y-Position 
 

 [1] Wipe >  

Key1 Transition > Position > X-Position 
 

 

이 설정은 배경 또는 키 패턴에 대해 대상 패턴을 선택한 경우에만 
가능합니다. 

 

② 페이더 레버를 조작하거나 [AUTO] 버튼을 눌러 와이프 조작을 
확인하십시오. 
 
(예를 들어, X-Position은 -50, Y-Position은 -50을 설정한 경우 
왼쪽 하단에서 다음 화면(또는 키)이 나타나고 화면(또는 키)이 
화면 중앙으로 이동하는 동안 지우기가 수행됩니다.) 

 

 

 

 

 

<X-위치, Y-위치 설정 범위> 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

  

 [1] Wipe >  

Key1 Transition > Position > Y-Position 

대상 패턴: 
9, 10, 11, 12, 13 
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 키 (Key) 
 

이 작업은 배경 이미지를 다른 이미지와 결합합니다. 

키 정의를 조정할 수 있으며 결합된 이미지에 가장자리를 추가할 수 

있습니다. 

Key1과 Key2는 배경 이미지를 구성하기 위한 소스로 사용할 수 

있습니다. 

우선 순위(이미지 위치 지정)에 대한 기본 설정은 아래 그림과 

같습니다. 

 

<우선 순위 기본 설정> 

 
 

Key1 및 Key2의 우선 순위를 변경할 수 있습니다. 

 "우선순위 설정"을 참조하십시오. 

 

키 조합의 작동 방식은 아래 그림에 나와 있습니다. 

 

<키 구성 작동 방식> 

 

 
 

 

 

 

 키  유형  선택  
 

① 다음 메뉴 조작으로 대상 키(Key1/Key2)를 선택합니다. 

 

② 다음 메뉴 조작으로 키 유형을 선택합니다. 

 

Lum(ChromaOff) 

(휘도 키· 크로마 끄기/ 

자체 키) 

키 소스 신호의 휘도 구성 요소에서 키 신호를 

생성하기 위한 것입니다. 

Lum(ChromaOn)  

(휘도 키· 크로마 끄기/ 

자체 키) 

키 Fill 신호의 휘도 구성 요소 또는 크로마 구성 

요소에서 키 신호를 생성하기 위한 것입니다. 

Linear 

(리니어 키 / 외부 

키) 

키 소스 신호의 휘도 구성 요소에서 키 신호를 

생성하기 위한 것입니다. 키 소스(Key) 신호와 키 

채우기(Fill) 신호가 다를 때 사용합니다. 

Chroma  

(크로마 키/자체 키) 

키 채우기 신호의 특정 색조를 참조로 사용하여 

키 신호를 생성하기 위한 것입니다. 

Full 

(전체 키/자체 키) 

전체 화면의 이미지를 주요 소스 신호로 

사용하여 키 신호를 생성하기 위한 것입니다. 

 

휘도 및 크로마 키는 자체 키로 작동되기 때문에 키 채우기 

신호는 키 소스 신호로 사용됩니다. 전체 키(Full Key)의 경우 

전체 화면의 이미지가 키 소스 신호로 사용됩니다. 

휘도 키, 크로마 키 또는 전체 키를 키 유형으로 선택하면 키 

소스 신호가 전환되더라도 키 신호는 변경되지 않습니다. 

리니어 키(Linear Key)를 사용할 때는 검은색 배경과 흰색 문자 

또는 키로 결합할 모양이 있는 소스를 키 소스 신호로 사용합니다. 

흑백이 아닌 소스는 명확하게 결합되지 않을 수 있습니다. 

흰색 배경과 검은색 문자 등이 있는 소스는 키 반전 기능을 사용하여 
반전시킬 수 있습니다. 

  

 [3] Key >  

Key Select 

 [3] Key >  

Key Type 
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③ 휘도 키가 선택되면, 크로마 구성 요소는 자체 키 적용을 

고려하여 키 신호의 생성에 포함될 수 있습니다. (리니어 키에는 

적용되지 않습니다.) 

키 유형으로 Lum(ChromaOn) 또는 Lum(ChromaOff)을 

선택합니다. 

 

④ 다음 메뉴 동작으로 채우기(fill) 유형을 선택합니다: 

 [3] Key >  

Fill 
 

 

키  구성  요소  선택  

 

AUX 버스 선택 영역에서 [KEY] 버튼을 누르고 키 채우기(Fill) 

신호(주황색 깜박임)와 키 소스(Key) 신호(녹색)의 선택을 전환합니다. 

 

<키 채우기(fill) 신호 선택> 

[KEY] 버튼 표시등이 황색으로 켜진 상태에서 AUX 버스 

크로스포인트 버튼 1~6 중 하나를 눌러 키 채우기 신호를 선택합니다. 

선택한 AUX 버스 크로스포인트 버튼 표시등이 황색으로 켜집니다. 

(선택한 신호가 PGM 커넥터에서 출력되는 경우 빨간색으로 

켜집니다.) 

 
 

 

 

 

<키 소스 신호 선택> 

[KEY] 버튼의 표시등이 녹색으로 켜진 상태에서 AUX 버스 

크로스포인트 버튼 1~6 중 하나를 눌러 키 소스 신호를 

선택합니다. 

선택한 AUX 버스 크로스포인트 버튼 표시등이 녹색으로 

켜집니다. (선택한 신호가 PGM 커넥터에서 출력되는 경우 

빨간색으로 켜집니다.) 휘도 및 크로마키는 셀프 키로 동작하기 

때문에 키 채우기 신호가 키 소스 신호로 사용됩니다. 휘도 키 

또는 크로마 키가 키 유형으로 선택되면 키 소스 신호가 

전환되어도 키 신호는 변경되지 않습니다.  

 
  

Chroma On 

(크로마 켜기) 

휘도 구성 요소 외에도 크로마 구성 요소도 주요 신호 

생성에 고려됩니다. 

이것은 주요 신호에 대해 낮은 휘도 구성 요소가 있는 

색상을 사용하기 위한 설정입니다(예: 
파란색 문자를 정의할 때와 같이). 

Chroma Off 

(크로마 끄기) 

키 신호는 휘도 구성 요소에서만 생성됩니다. 

Bus 버스 신호는 키 채우기 신호에 사용됩니다. 

Matte 내부 채우기 매트는 키 채우기(fill) 신호에 
사용됩니다. 

키 채우기 및 키 소스 신호 선택 
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① 다음 메뉴 조작으로 대상 키(Key1/Key2)를 선택합니다. 

 [3] Key >  

Key Select 

 

② 다음 메뉴 조작으로 키 신호 연결 (Key Signal Coupling)을 
설정합니다. 

 [3] Key >  

Key Signal Coupling 

 

③ 다음 메뉴 조작으로 Fill/Source를 설정합니다. 

 [12] Config >  

Key Source Signal Coupling > Fill/Source 

 

• 채우기/원본(Fill/Source)이 ‘채우기에서 소스로(Fill to 
Source)’인 경우 채우기의 원본으로 사용할 대상을 
선택합니다. 

• ‘소스에서 채우기로(Source to Fill)’인 경우 선택한 소스의 
채우기로 사용할 항목을 선택합니다. 

<키 신호 커플링> 

[KEY] 버튼이 황색으로 켜지면 키 채우기 신호를 선택할 수 있고 

녹색으로 켜지면 키 소스 신호를 선택할 수 있습니다. 

 

키 시그널 커플링 

 

 

 

 

 

 

 

<소스로 채우기(Fill to Source)> 

키 채우기 신호를 선택하면 키 소스 신호도 자동으로 전환됩니다. 

 

<채우기 할 소스(Source to Fill)> 

키 소스 신호를 선택하면 키 채우기 신호가 자동으로 전환됩니다. 

 

 

다음 메뉴 조작으로 채우기 매트의 Hue, Sat, Lum을 조정합니다. 

 [3] Key >  

Fill Matte > Hue 
 

 [3] Key >  

Fill Matte > Sat 
 

 [3] Key >  

Fill Matte > Lum 

 

■ 미리 설정된 색상을 호출하려면 

다음 메뉴 조작으로 사전 설정 색상을 선택하고 OSD/TIME 다이얼을 

누릅니다. 

 

 [3] Key >  

Fill Matte > Load 
 

• OSD/TIME 다이얼을 누르면 지금까지 설정한 내용이 취소되고 
미리 설정된 색상 값으로 바뀝니다. 

• 프리셋 컬러를 호출하기 전에 설정한 값을 저장하려면 "샷 
메모리"를 참조하십시오. 

  

Independent Fill to Source인 경우 Fill에 연결된 Source를 

독립적으로 설정할 수 있으며 다른 KEY와는 별도로 

설정할 수 있습니다. 

Source to Fill의 경우 Source에 연결되고 다른 KEY와는 

별도로 Fill을 독립적으로 설정할 수 있습니다. 

Coupling Key Source Signal Coupling 내의 Fill/Source 이외의 
항목 설정을 따릅니다. 

키 채우기(fill) 신호와 키 소스 신호 선택 연결 

채우기 매트 색상 설정 
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 키  전환  

 

①  다음 메뉴 조작으로 전환 모드를 선택합니다. 

 [12] Config >  

Operate > Fader 

 

다음에서 페이더 레버를 조작할 때 전환 대상을 설정할 수 

있습니다. 
 

BKGD 배경 전환 
KEY1 키 전환 

BKGD+KEY1 배경 전환과 키 전환이 동시에 실행됩니다. 

No Assign 페이더 레버를 조작하는 경우에도 전환이 실행되지 
않습니다. 

 

②  다음 메뉴 조작으로 전환 유형(MIX/WIPE)을 선택합니다. 
 

 [12] WIPE >  

Key1 Transition > Type 

 

WIPE를 선택하는 경우 다음 메뉴 조작으로 와이프 패턴을 

선택합니다. 
 

 

<와이프 패턴 표> 

와이프 패턴 및 번호 
 

 
1 

 

 
2 

 

 
3 

 

 
4 

 

 
5 

 

 
6 

 

 
7 

 

 
8 

 

 
9 

 

 
10 

 

 
11 

 

 
12 

 

 
13 

 

 
14 

 

 
15 

 

 
16 

    

 

③  다음 메뉴 조작으로 전환 시간을 설정합니다. 

 [5] Time >  

Key1 

 

 [5] Time >  

Key2 

 
전환 시간은 백그라운드 전환과 동일하게 설정합니다. 

 

 

④  다음 메뉴 조작으로 와이프 방향을 설정합니다. 
 

Normal 키 출력 패턴은 키 입력 패턴과 같은 방향으로 
이동합니다. 

Reverse 키 출력 패턴은 키 입력 패턴과 반대 방향으로 
이동합니다. 

 

<패턴 예> 
 

패턴 예 1 
패턴 예 2 

와이프 패턴 9 - 16 

Key in  

 

 

 
Key out 

(Normal) 

 

 

 

 
Key out 

(Reverse) 

 

 

 

 

: 키가 결합되는 영역을 나타냅니다. 

 

• 와이프 패턴 9에서 16은 패턴 예제 2처럼 동작합니다. 

 

⑤  화면 전환을 실행합니다. 

페이더 레버를 사용하여 전환을 수동으로 실행합니다. 

 

트랜지션 영역의 [KEY ON] 버튼을 누르면 설정된 트랜지션 

시간에 트랜지션이 자동으로 실행됩니다. 키 입력 중에는 [KEY 

ON] 버튼의 표시등이 빨간색으로 깜박이고 전환이 완료되면 

빨간색으로 켜집니다. 

영상이 완전히 입력된 상태에서 [KEY ON] 버튼을 누르면 키 

이미지 전환(키 출력)이 실행됩니다. 키 아웃 중에는 [KEY ON] 

버튼의 표시등이 빨간색으로 켜지고 전환이 완료되면 꺼집니다. 

전환 중에 [KEY ON] 버튼을 누르면 전환 방향이 반대로 바뀝니다. 

  

키 자동 전환 
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 키  미리보기  

키 미리보기 이미지는 미리보기 출력으로 출력할 수 있으며 키를 

조정하고 확인할 수 있습니다. 

 

다음 메뉴 조작으로 미리보기를 설정합니다. 

 [3] Key >  

PVW 
 

 
PVW 이미지 (PVW images) 

PVW가 꺼져 있을 때: 

PGM 상태가 PVW에 표시됩니다. 

그러나 이는 전환 상태에 반영되지 않습니다. 

PVW가 켜져 있을 때: 

PVW를 "On"으로 설정하면 PVW 후에 PGM 이미지가 

표시됩니다. 

 

PVW의 배경 (Background of the PVW) 

PVW용 BKGD 이미지는 설정에 관계없이 PST가 됩니다. 

On/Off가 할당된 사용자 버튼을 누르면 On(버튼 점등)과 Off(버튼 

꺼짐) 간에 번갈아 전환됩니다. 

(관련 사용자 버튼 항목은 KEY1_PVW/KEY2_ PVW입니다.) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 휘도  키와  선형  키  조정  

이러한 단계는 휘도 키와 선형 키 정의를 조정하기 위해 

수행됩니다. 

①  다음 메뉴 조작으로 키의 정의를 조정합니다. 

 [3] Key >  

Key Adjust > Clip 
 

 [3] Key >  

Key Adjust > Gain 
 

 [3] Key >  

Key Adjust > Density 
 

②  다음 메뉴 조작으로 키 반전을 설정합니다. 

 [3] Key >  

Key Adjust > Invert 

"On"을 선택하면 내부적으로 생성되는 키 신호가 반전됩니다. 
 

 

  

메뉴 사용자 버튼 사용자 버튼을 눌렀을 때 

On 조명 켜집 Off: 조명 꺼짐 

Off 조명 꺼짐 On : 조명 켜짐 

매개 변수 설정 설명 설정 범위 

Clip 주요 신호를 생성하기 위한 기준 레벨 0.0 ~ 108.0 

Gain 키 진폭 0.0 ~ 200.0 

Density 키 밀도 0.0 ~ 100.0 

Invert 키 신호 반전 On, Off 

메뉴 연결 (Linking of Menus) 
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 크로마  키  조정  
 

크로마 키를 정의하는 방법은 조정할 수 있습니다. 

 

조정을 진행하기 전에 아래 메뉴 항목을 사용하여 키 유형으로 

"Chroma"를 선택하십시오. 

 [3] Key >  

Key Type 
 

크로마키는 특정 색상을 기준으로 키 신호를 생성합니다. 

예를 들어, 키 신호는 특정 배경 색상 앞에 서 있는 사람의 영상에서 

배경의 색상을 검출하여 생성되고, 다른 배경이 결합됩니다. 

이 장치는 직사각형 프레임으로 영역이 지정된 영역 시스템을 

사용합니다. 그 영역 내부의 픽셀들의 색상을 평균한 결과를 

크로마키 기준 색상(키 기준)으로 사용하고, 평균값에서 최대 편차를 

크로마키 타원형의 반지름으로 사용합니다. 

크로마 스페이스 샘플(그림의 (C))에 충실한 크로마키를 생성할 수 

있습니다. 

 

 
 

 

 

 

 

 

배경이 삽입될 영역을 지정하면 크로마 구성 요소가 

샘플링됩니다. 

 

■ 마커 (Maker) 
 

 [4] ChromaKey >  

Marker 

PVW 이미지에 마커를 표시하기 위해 샘플 마커를 ON으로 

설정하는 데 사용됩니다. 

■ 마커 위치 (Maker Position) 
 

 [4] ChromaKey >  

Maker Posion 

이 항목은 샘플 마커의 X 좌표, Y 좌표 및 크기를 조정하는 데 

사용됩니다. 

■ 샘플 (Sample) 
 

 [4] ChromaKey >  

Sample 

OSD/TIME 다이얼을 눌러 샘플 마커로 선택한 영역의 색상 

성분을 샘플링합니다. 

 

• 샘플링이 완료되면 크로마키와 PVW 이미지를 결합하여 얻은 
이미지가 출력됩니다. (키의 PVW 기능을 ON으로 설정하십시오.) 

 

 

 

 

 

 

 

 

 

 

 

 

 
  

샘플링 자동 실행 
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■ 마커 종횡비 (Maker Aspect) 

 

 [4] ChromaKey >  

Maker Aspect 
 

이 항목은 샘플 마커의 종횡비를 변경하는 데 사용됩니다. 

 

■ 참조 조정 (Ref Adjust) 

 

 [4] ChromaKey >  

Ref Adjust 
 
이 항목을 사용하면 샘플링된 색상에서 크로마 키 참조로 사용할 
색상을 변경할 수 있습니다. 
 

Hue (색조) 참조로 사용할 색조 

Sat (채도) 참조로 사용할 색상 채도 

Lum (휘도) 참조로 사용할 휘도 

• 자동 샘플링이 완료되면 샘플링된 값이 표시됩니다. 

 

■ Y-인플루언스 

 

 [4] ChromaKey >  

Y-Influence 
 

이 항목은 Y(휘도) 구성 요소가 가하는 영향의 정도를 설정하는 데 
사용됩니다. 

값 집합이 높을수록 영향이 커지며 "0"으로 설정하면 광도 구성 요소가 
영향을 미치지 않습니다. 

 

■ 반지름 (Radius) 

 

 [4] ChromaKey >  

Radius 
 

이 항목은 정의할 색상의 범위를 설정하는 데 사용됩니다. 
 

Hue (색조 - 반경) 정의할 색조 범위의 범위입니다 

Sat (색상 -반경) 정의할 색상 채도 범위의 범위입니다 

• 자동 샘플링이 완료되면 샘플링 된 값이 표시됩니다. 

 

 

 

 

 

 

 

■ 부드러움 (Soft) 

 

 [4] ChromaKey >  

Soft 
 

이 항목은 정의할 색상의 경계에 대한 소프트 효과의 양을 조정하는 데 
사용됩니다. 

 

■ 취소 (Cancel) 

 

 [4] ChromaKey >  

Cancel 
 

색상 뮤팅의 양을 조절하는 데 사용되는 아이템입니다. 

배경 색상이 채우기 이미지 위에 겹쳐지면 색상 뮤팅이 조정됩니다. 

 

 

 

 

 

 

 

 

 

 

  

메모 
크로마 키를 조정하는 요령 

크로마 키 조정은 아래 단계에 따라 쉽게 할 수 있습니다. 

① 자동 샘플링을 시작하고 정의할 색상을 결정합니다. 

② "반경(Radius)"항목을 사용하여 배경색이 

완전히 정의되도록 조정합니다. 

③ "부드러움 (Soft)" 항목을 사용하여 키 신호 경계를 

미세하게 조정합니다. 

기타 크로마키 설정 
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 키  세부  설정  
 

테두리, 그림자 또는 기타 모서리를 키에 추가할 수 있습니다. 

 

 
 

①  다음 메뉴 조작으로 모서리 유형을 선택합니다. 

 [3] Key >  

Edge > Type 

 
Off 테두리가 추가되지 않습니다. 
Border 전체 가장자리 주위에 테두리가 추가됩니다. 
Drop 대각선 테두리가 추가됩니다. 
Shadow 그림자가 추가됩니다. 
Outline 윤곽선(채우기가 없는 테두리만)이 추가됩니다. 

 

 
 

②  다음 메뉴 조작으로 가장자리의 너비를 선택합니다. 

 [3] Key >  

Edge > Width 

 

③  다음 메뉴 조작으로 "Drop" 및 "Shadow"를 추가할 방향(45° 
단위)을 선택합니다. 

 [3] Key >  

Edge > Direction 

 
 

④ 다음 메뉴 조작으로 가장자리의 밀도를 선택합니다. 

 [3] Key >  

Edge > Density 

 

 

 

 

 

가장자리로 삽입할 소스를 설정할 수 있습니다. 

 

다음 메뉴 조작으로 가장자리의 소스를 선택합니다. 
 

 [3] Key >  

Edge > Fill 
 

 

Color 가장자리 색상(Edge Color)을 사용하여 설정된 색상이 
사용됩니다. 

CBGD1 
색상 배경이 사용됩니다. CBGD2 

Still 1 정지 이미지 비디오 메모리(Still1)가 사용됩니다. 
Still 2 정지 이미지 비디오 메모리(Still2)가 사용됩니다. 

 

다음 메뉴 조작으로 가장자리 색상의 Hue, Sat, Lum 을 조정합니다. 

 

 [3] Key >  

Edge > Color > Hue 
 

 [3] Key >  

Edge > Color > Sat 
 

 [3] Key >  

Edge > Color > Sat 
 

■ 미리 설정된 색상을 호출하려면 
다음 메뉴 조작으로 사전 설정 색상을 선택하고 OSD/TIME 다이얼을 

누릅니다. 
 

 [3] Key >  

Edge > Color > Load 
 

• OSD/TIME 다이얼을 누르면 지금까지 설정한 내용이 취소되고 
미리 설정된 색상 값으로 바뀝니다. 

• 프리셋 컬러를 호출하기 전에 설정한 값을 저장하려면 "샷 
메모리"를 참조하십시오. 

  

키 테두리 설정 

가장자리 채우기 설정 선택 

가장자리 색상 설정 
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 키  신호  마스킹  

이 단계는 상자 패턴의 마스크 신호를 사용하여 키 신호를 

마스킹하기 위해 수행됩니다. 

 

①  다음 메뉴 조작으로 마스크 모드를 설정합니다. 

 [3] Key >  

Mask > Size 

 
Off 키 신호는 마스킹되지 않습니다. 

Manual [마스크 조정] 하위 메뉴를 사용하여 설정한 영역은 
마스크됩니다. 

4:3 신호는 4:3 종횡비로 마스킹됩니다. 

 

②  다음 메뉴 조작으로 마스크 신호를 반전시킬지 여부를 
설정합니다. 

 [3] Key >  

Mask > Invert 
 
③  다음 메뉴 조작으로 마스크 영역을 설정합니다. 

 

 [3] Key >  

Mask > Position > Left 
 

 [3] Key >  

Mask > Position > Top 
 

 [3] Key >  

Mask > Position > Bottom 
 

 [3] Key >  

Mask > Position > Right 
 

 

 

 

왼쪽 설정은 오른쪽 설정을 초과할 수 없으며(반대의 경우도 

마찬가지) 마찬가지로 상단 설정은 하단 설정을 초과할 수 

없습니다(반대의 경우도 마찬가지). 

 

<Key Mask setting> (그림에 기본값이 표시됨) 

 

 
 

 우선  순위  설정  

Key1 및 Key2 이미지를 서로 겹칠 때 이미지의 상대적 위치를 

설정할 수 있습니다. 

다음 메뉴 조작으로 2번째 항목과 1번째 항목의 상대 위치를 

설정합니다. 
 

 [3] Key >  

Key Priority > Key* 
 

* [3] 키 > 키 선택에서 선택한 메뉴만 표시됩니다. 
 

1st 상단 이미지를 설정합니다. 

2nd 아래쪽 이미지를 설정합니다. 

 

 
  

매개 변수 설정 설명 
설정 범위/초기값 

Left 키 왼쪽 위치 
−50.00에서 50.00/ 

−25.00 

Top 키 상단 위치 
−50.00에서 50.00/ 

25.00 

Bottom 키 하단 위치 
−50.00에서 50.00/ 

−25.00 

Right 키 오른쪽 위치 
−50.00에서 50.00/ 

25.00 
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 PinP (픽처 인 픽처) 
 

다른 이미지를 배경 이미지와 결합할 수 있습니다. 본 기기는 Key1 및 
Key2의 2개 채널에 대해 PinP를 지원합니다. 

 

다음 메뉴 조작으로 PinP에 대한 활성화(On)/비활성화(Off)를 

설정합니다. 

 

 [3] Key >  

PinP > PinP 
 

P inP 채널  및  소스  선택  
 

AUX 버스 선택 버튼 중 [Key1] 또는 [Key2] 버튼을 누릅니다. 

누른 버튼에 불이 들어옵니다. 

이제 AUX 버스 크로스포인트 버튼에 대해 PinP 소스가 선택된 

상태가 설정됩니다. 

선택한 AUX 버스 크로스포인트 버튼이 주황색으로 켜집니다. 

(선택한 신호가 PGM 출력 신호인 경우 빨간색으로 켜집니다.) 

 

 
 

모양  선택  
 

사각형, 원, 하트, 꽃 또는 별을 PinP 이미지를 결합하는 데 사용되는 
모양으로 선택할 수 있습니다. 

• 이 설정은 [전체 키]가 [ON]인 경우에만 사용할 수 있습니다. 

 

①  다음 메뉴 조작으로 이미지를 결합할 때 모양을 선택합니다. 
 

 [3] Key >  

PinP > Shape 

 

②  다음 메뉴 조작으로 이미지를 결합할 때 투과율(농도)을 
선택합니다. 

 

 [3] Key >  

PinP > Density 
 

 

 

 

 

 

 

다음 메뉴 조작으로 Full Key에 대한 활성화(On)/비활성화(Off)를 
설정합니다. 

 

 [3] Key >  

PinP > Full Key 
 
On [3] Key > Key Type으로 설정한 값에 관계없이 PinP 

이미지는 Full Key로 구성됩니다. 
Off PinP 이미지는 [3] Key > Key Type에서 설정한 값에 

따라 구성됩니다. 

 

 P inP 조정  

X 및 Y 좌표와 크기를 다음 메뉴 조작으로 설정합니다. 

 

 [3] Key >  

PinP > Position > X-Position 
 

 [3] Key >  

PinP > Position > Y-Position 
 

 [3] Key >  

PinP > Position > Size 
 

  

전체 키 켜기/끄기 

PinP 위치 및 크기 조정 
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 Key1  PinP 및  Key2 P inP 연결  

 
Key1 PinP 및 Key2 PinP 이미지는 좌표가 설정된 축에 대해 대칭 
작업을 수행합니다. 참조 역할을 하는 이미지는 작동 중인 메뉴의 PinP 
이미지입니다. 

 

다음 메뉴 조작으로 참조로 사용할 위치를 선택합니다. 

 [3] Key >  

PinP > Sync > Symmetry 

 

기준이 되는 이미지는 작동 중인 메뉴의 PinP 이미지입니다. 

 
 

 

 

 

설정 값은 다음 메뉴 조작으로 복사할 수 있습니다. 

 [3] Key >  

PinP > Sync > Copy to Key 
 

Key1 PinP 설정을 Key2 PinP로 복사할 수 있으며, 마찬가지로 Key2 
PinP 설정도 Key1 PinP로 복사할 수 있습니다.  

• [3] Key > Key Select에서 선택되지 않은 소스 이름이 
표시됩니다. 

 

다음 메뉴 작업으로 OSD/TIME 다이얼을 누르면 Key1 PinP(또는 
Key2 PinP)의 설정 값이 복사되어 Key2 PinP(또는 Key1 PinP)의 
값으로 설정됩니다: 

 

 
  

메모 
다음 설정은 복사되지 않습니다. 

[3] Key > PinP > PinP 
[3] Key > PinP > Shape 
[3] Key > PinP > Density 
[3] Key > PinP > Full Key 
[3] Key > PinP > Trim > Trim 
[3] Key > PinP > Trim > Pair 
[3] Key > PinP > Trim > Preset  

설정 복사 

Key1 PinP 및 Key2 PinP 연결 
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 P inP 세부  설정  
 

테두리 또는 소프트 효과를 PinP에 추가할 수 있습니다. 

①  다음 메뉴 조작으로 테두리 켜기/끄기 설정: 

 [3] Key >  

PinP > Border > Border 

 

②  다음 메뉴 조작으로 테두리 너비를 설정합니다. 

 [3] Key >  

PinP > Border > Width 
 

③  다음 메뉴 조작으로 소프트 효과의 양을 설정합니다. 

‘0.0’을 설정하면 소프트 효과가 OFF됩니다. 

 [3] Key >  

PinP > Border > Soft 
 

테두리 항목 설정으로 "On"을 선택하면 테두리 너비에 대한 

소프트 효과의 비율이 소프트 효과의 양으로 표시됩니다. 

PinP에 소프트 효과만 추가하려면 테두리 항목 설정으로 "Off"를 

선택합니다. 

④  다음 메뉴 작업을 사용하여 테두리 너비 변동율을 설정합니다:  

 [3] Key >  

PinP > Border > Mode 
 

Fix 테두리 너비는 일정하게 유지됩니다. 
Variable 테두리 너비가 PinP 크기에 맞게 변경됩니다. 

 

 

다음 메뉴 조작으로 테두리 색상의 Hue, Sat, Lum 을 조정합니다. 

 [3] Key >  

PinP > Border > Color > Hue 
 

 [3] Key >  

PinP > Border > Color > Sat 
 

 [3] Key >  

PinP > Border > Color > Lum 
 

■ 미리 설정된 색상을 호출하려면 
다음 메뉴 조작으로 사전 설정 색상을 선택하고 OSD/TIME 다이얼을 

누릅니다. 

 [3] Key >  

PinP > Border > Color > Load 
 

• OSD/TIME 다이얼을 누르면 지금까지 설정한 내용이 취소되고 
미리 설정된 색상 값으로 바뀝니다. 

 

• 프리셋 컬러를 호출하기 전에 설정한 값을 저장하려면 "샷 
메모리"를 참조하십시오. 

 

트리밍  설정  

①  다음 메뉴 조작으로 트리밍 켜기/끄기 설정: 

 [3] Key >  

PinP > Trim > Trim 
 

On 트리밍이 수행됩니다. 
Off 트리밍 없음 

 

②  다음의 메뉴 조작으로 트리밍 타입을 설정합니다: 

 [3] Key >  

PinP > Trim > Preset 
 

 

 

③  다음 메뉴 동작으로 Pair On/Off 설정: 

 [3] Key >  

PinP > Trim > Pair 
 

 

  

16:9 가로 세로 비율이 16:9가 되도록 자동 트리밍합니다. 

12:9 가로 세로 비율이 12:9가 되도록 자동 트리밍합니다. 

9:9 가로 세로 비율이 9:9가 되도록 자동 트리밍. 

7:9 가로 세로 비율이 7:9가 되도록 자동 트리밍. 

6:9 가로 세로 비율이 6:9가 되도록 자동 트리밍합니다. 

Manual 트림(Trim) 하위 메뉴에 설정된 값을 사용하여 
트리밍합니다. 

On 왼쪽 및 오른쪽 트리밍 양과 위쪽 및 아래쪽 트리밍 양이 
같도록 설정이 변경됩니다. (이렇게 하면 위쪽-아래쪽 
및 왼쪽-오른쪽 대칭이 됩니다.) 

Off 페어링 설정이 이루어지지 않았습니다. 

테두리 색상 설정 
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④  다음 메뉴 동작으로 트리밍 값을 설정합니다: 

 [3] Key >  

PinP > Trim > Adjust > Left 
 

 [3] Key >  

PinP > Trim > Adjust > Top 
 

 [3] Key >  

PinP > Trim > Adjust > Bottom 
 

 [3] Key >  

PinP > Trim > Adjust > Right 
 

매개 변수 설정 설명 설정 범위/초기값 

Left 왼쪽의 트리밍 값 −50.00에서 50.00/ 

−50.00 

Top 상단의 트리밍 값 −50.00에서 50.00/ 

50.00 

Bottom 하단의 트리밍 값 −50.00에서 50.00/ 

−50.00 

Right 오른쪽의 트리밍 값 −50.00에서 50.00/ 

50.00 

 

<트리밍 설정> (그림은 기본값을 보여줍니다) 
 

 
 

 

 

 

 

 키 링크 (Key Link) 
 

Key1과 Key2를 연결할 수 있습니다. 

 

[KEY1 ON] 버튼과 [KEY2 ON] 버튼 On/Off(버튼 점등/버튼 꺼짐)를 
연결할 수 있습니다. 

 

 
 

다음 메뉴 조작으로 각 버튼에 대한 링크가 있는지 여부에 대해 
On/Off를 설정합니다. 

 

 [12] Config >  

Key1/2 Link 
 

• "Off"를 선택하면 링크가 해제됩니다. 
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 FTB (페이드 투 블랙) 
 

사용자는 프로그램 이미지에서 검은색 화면/흰색 화면/정지/색 배경 

화면으로 페이드 아웃 하거나 검은색 화면/흰색 화면/정지/색 배경에서 

프로그램 이미지로 페이드 아웃 할 수 있습니다. 

①  전환의 지속 시간을 설정합니다. 

다음 메뉴 조작을 사용하여 각 배경 전환에 대해 전환 시간을 

동일하게 설정합니다. 

 

 [5] Time >  

FTB > Trans Time 
 

 "자동 전환(Auto Transition)"을 참조하십시오. 

 

 
 

②  전환 영역에서 [FTB ON] 버튼을 누르면 설정된 전환 시간에 

화면이 설정 화면으로 페이드 아웃됩니다. 

페이드 아웃 중에는 [FTB ON] 버튼의 표시등이 빨간색으로 

깜박이고 전환(페이드 아웃)이 완료되면 빨간색으로 켜지고 

검은색 화면이 표시됩니다.* 

검은색 화면이 표시된 상태에서 [FTB ON] 버튼을 누르면 

프로그램 이미지의 페이드 인이 시작됩니다. 페이드 인 중에는 

[FTB ON] 버튼의 표시등이 빨간색으로 켜지고 전환(페이드 

인)이 완료되면 꺼집니다. 

전환 중 [FTB ON] 버튼을 아무 때나 누르면 전환 방향이 반대로 

바뀝니다. 

 

*: FTB 상태에서는 일반적으로 황색으로 빨간색으로 켜지는 

크로스포인트 버튼입니다. 

 

 

 

 

 

 

페이드 아웃에 사용할 이미지를 선택할 수 있습니다. 

다음 메뉴 조작으로 페이드 아웃 할 이미지를 선택합니다. 
 

 [5] Time >  

FTB > Source 
 

Still1 정지 영상 비디오 메모리(Still1)가 사용됩니다. 

Still2 정지 영상 비디오 메모리(Still1)가 사용됩니다. 

CBGD1 컬러 배경이 사용됩니다.  

CBGD2 

White 흰색 백그라운드 

Black 검은색 백그라운드 

 

 

  

오디오의 페이드 아웃을 이미지 페이드 아웃과 동기화할지 여부를 
선택할 수 있습니다. 

 

다음 메뉴 조작으로 오디오 페이드 아웃을 사용할지 여부를 
선택합니다. 

 

 [5] Time >  

FTB > Mute 

 

Off 이미지 페이드 아웃 동안 오디오 페이드 아웃이 
없습니다. 

On 이미지 페이드 아웃 중 오디오 페이드 아웃. 

 

 

 

 

 

 

 

 

 

 

 

  

오디오 음소거 

이미지 선택 
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 내부 색상 신호 (Internal color signal) 
 

이 장치는 두 세트의 내부 색상 신호를 지원합니다. 

 색상  배경  설정  

버스에서 사용할 색상 배경을 설정할 수 있습니다. 

두 가지 방법을 사용할 수 있습니다: 한 가지 방법에서는 Hue(색조), 

Sat(색상 채도) 및 Lum(휘도)을 설정하고 다른 방법에서는 8가지 

사전 설정 색상(흰색, 노란색, 청록색, 녹색, 자홍색, 빨간색, 파란색 

및 검정)을 호출합니다. 

호출된 색상의 Hue, Sat 및 Lum도 조정할 수 있습니다. 

 

①  다음 메뉴 조작으로 대상 색상 배경(CBGD1/CBGD2)을 
선택합니다. 

 

 [2] CBGD >  

CBGD Select 
 

②  다음 메뉴 조작으로 색상(Hue, Sat, Lum)을 조정합니다. 
 

 [2] CBGD >  

CBGD Main > Hue 
 

 

 [2] CBGD >  

CBGD Main > Sat 
 

 [2] CBGD >  

CBGD Main > Lum 
 

■ 미리 설정된 색상을 호출하려면 
다음 메뉴 조작으로 사전 설정 색상을 선택하고 OSD/TIME 다이얼을 
누릅니다. 
 

 [2] CBGD >  

CBGD Main > Load 
 

• OSD/TIME 다이얼을 누르면 지금까지 설정한 내용이 
취소되고 미리 설정된 색상 값으로 바뀝니다. 

• 프리셋 컬러를 호출하기 전에 설정한 값을 저장하려면 "샷 
메모리"를 참조하십시오. 

 

 

 

 

Wash 효과  설정  

 
색상 배경의 그라데이션 효과를 설정할 수 있습니다. 

 

①  다음 메뉴 조작으로 Wash (그라데이션) 효과를 설정합니다.  

 [2] CBGD >  

CBGD Wash > Wash 
 

On 그라디언트 이펙트가 추가됩니다.  
Off 그라디언트 이펙트가 추가되지 않습니다.  

 

②  Wash (그라데이션) 효과의 색상을 다음 메뉴 조작으로 
설정합니다. 

 

 [2] CBGD >  

CBGD Wash > Color 
 

Dual 이중 색상 그라데이션 효과가 추가됩니다. (그 

결과 두 가지 색상의 그라데이션이 생성됩니다. 

즉, CBGD1 메인 컬러와 CBGD1 

하위 색상.) 
Rainbow 무지개 색상 그라데이션 효과가 추가됩니다. 

 

③  "Dual"을 선택한 경우 다음 메뉴 조작으로 하위 색상의 색상(Hue, 
Sat, Lum)을 조정합니다. 

 

 [2] CBGD >  

CBGD Sub > Hue 
 

 [2] CBGD >  

CBGD Sub > Sat 
 

 [2] CBGD >  

CBGD Sub > Lum 
 

  

색상 조정 

[Wash] 효과 선택 및 색상 설정 



51 

기본 운영  

 

 

 
①  다음 메뉴 조작으로 계조의 웨이브폼을 선택합니다. 

 [2] CBGD >  

CBGD Wave > Pattern 
 

 

Sine 사인파가 선택됩니다. 
Saw 톱니 파가 선택됩니다. 

 

②  다음 메뉴 조작으로 계조 주기를 선택합니다. 
 

 [2] CBGD >  

CBGD Wave > Cycle 

 

③  다음 메뉴 조작으로 그라데이션 단계를 선택하십시오. 
 

 [2] CBGD >  

CBGD Wave > Phase 

 

④  다음 메뉴 조작으로 그라데이션 각도를 선택합니다. 
 

 [2] CBGD >  

CBGD Wave > Angle 
 

 

①  다음 메뉴 조작으로 그라데이션의 움직임을 설정합니다. 

 [2] CBGD >  

CBGD Move > Move 
 

Off 움직임이 설정되지 않았습니다. 
Roll 그라데이션이 스크롤됩니다. 
Rotation 그라데이션이 회전합니다. 

 

②  다음 메뉴 조작으로 이동 속도를 설정합니다. 

 [2] CBGD >  

CBGD Move > Speed 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

  

Wash 웨이브폼 조정 

Wash 동작 설정 
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 내부 컬러바 신호 (Internal color bar signal) 

이 장치는 1개의 내부 컬러바 신호를 지원합니다. 

 

 컬러  바  신호  선택  

다음 메뉴 설정을 사용하여 기본 제공 색상 막대 유형을 Type1에서 

3으로 설정할 수 있습니다. 

 

 [12] Config >  

CBAR > Type 
 

Type1 

 

Type2 

 

Type3 

 

 

• 색상 막대는 색상 단계를 조정하기 위한 것입니다. 바의 너비와 
위치는 다른 모델과 다를 수 있습니다. 

 

색상  막대  신호  이동  설정  
 

컬러 바 신호 이동 속도는 2단계로 설정할 수 있습니다. 

 

다음 메뉴 조작으로 이동 속도를 설정합니다. 

 [12] Config >  

CBAR > Move 
 

Normal 컬러 바 신호가 빠르게 움직입니다. 
Low 컬러 바 신호가 느리게 움직입니다. 
Off 컬러 바 신호가 움직이지 않습니다. 

 

 

 테스트  톤  설정  

컬러 바 신호로 출력되는 테스트 톤 신호(1kHz)와 관련된 

설정을 지정할 수 있습니다. 

 

다음 메뉴 조작으로 테스트 톤 기능을 설정합니다. 

 

 [12] Config >  

CBAR > Test Tone 
 

Normal 테스트 톤은 일반 볼륨(-12dB)으로 출력됩니다. 

Low 테스트 톤은 더 낮은 볼륨(-20dB)으로 출력됩니다. 
Off 테스트 톤이 출력되지 않습니다. 
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 내장 테스트 패턴 신호 
 

이 장치는 테스트 패턴 신호를 출력할 수 있습니다. 

연결된 장치의 종횡비와 같은 요소를 확인할 수 있습니다. 

본 기기에 설정된 시스템 형식에 해당하는 화각이 있는 테스트 패턴 

신호가 선택됩니다. 

비디오 메모리의 Still1 또는 Still2에 로드되며 내부 소스로 사용할 

수 있습니다. 

 

<시스템 모드가 1080일 때의 테스트 패턴> 
 

 
 

<시스템 모드가 720일 때의 테스트 패턴> 
 

 

 

 

 
①  다음 조작으로 테스트 패턴 신호가 출력될 장치를 선택합니다. 

 [6] Still >  

Still Select 

 

②  다음 메뉴에서 OSD/TIME 다이얼(Excute)을 눌러 선택한 비디오 
메모리에 로드합니다. 

 

 [6] Still >  

Test Pattern > Load 
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 AUX 출력 전환 
 

 AUX 출력  소스  선택  

 
AUX 버스(AUX1, AUX2)의 출력 신호를 선택할 수 있습니다. 

①  AUX 버스 선택 버튼 중 [AUX1], [AUX2] 버튼 중 하나를 
누릅니다. 

선택한 버튼이 주황색으로 켜집니다. 

②  AUX 버스 크로스포인트 버튼 중 하나를 누릅니다. 

선택한 신호는 누른 [AUX1], [AUX2] 버튼으로 출력됩니다. 

 

 
<AUX 버스로 선택할 수 있는 신호> 

 

• "MV"가 선택된 AUX 버스가 멀티뷰 디스플레이의 하위 화면에 

표시되면 두 개의 미러가 서로 마주보고 있는 것처럼 영상이 

루프됩니다. 

 

 

 

 

 

 

 AUX1/2 트랜지션  

 
AUX1/2에 설정된 출력 신호가 전환되면 MIX 전환이 실행됩니다. 

①  AUX 버스 선택 버튼의 [AUX1] 또는 [AUX2] 버튼을 누릅니다. 

선택한 버튼과 해당 AUX 버스 크로스포인트 버튼이 황색으로 

켜집니다. 

②  출력 신호로 전환할 AUX 버스 크로스포인트 버튼을 누릅니다. 

이제 Time(시간) 메뉴를 사용하여 설정한 전환 시간 길이에 

대해 MIX(믹스) 전환이 시작됩니다. 

전환이 진행되는 동안 전환 소스 AUX 버튼이 녹색으로 켜지고 

전환 대상 AUX 버튼이 황색으로 깜박입니다. 

전환이 완료되는 즉시 전환 소스 AUX 버튼이 꺼지고 전환 

대상 AUX 버튼이 황색으로 점등됩니다. 

또한 전환 중간 지점에서 다른 신호가 선택되면 그 중간 

지점부터 전환 처리가 계속됩니다. 

 

 
 

• Shot Memory가 리콜될 때 AUX 버스 전환은 Shot Memory 용해 
시간과 연결됩니다. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

신호 이름 신호 설명 

IN1 SDI/HDMI 입력 신호 1 

IN2 SDI 입력 신호 2 

IN3 SDI 입력 신호 3 

IN4 SDI 입력 신호 4 

IN5 HDMI 입력 신호 2 

IN6 IP 입력 신호 1 

IN7 IP 입력 신호 2 

IN8 IP 입력 신호 3 

IN9 IP 입력 신호 4 

PGM 비디오 신호 프로그래밍 

PVW 비디오 신호 미리보기 

CLN 클린 시그널 

MV 멀티뷰 디스플레이 출력 신호 

KeyOut 키 출력 신호 

Black 블랙 시그널 

CBGD1, CBGD2 색상 배경 1, 2 

CBAR 컬러 바 

Still1, Still2 비디오 메모리(정지 이미지) 1, 2 
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AUX1/2 전환에  대한  활성화 /비활성화  설정  
 

AUX1/2 전환 시간 및 전환 활성화/비활성화를 설정할 수 있습니다. 

 

①  다음 메뉴 조작으로 전환 시간을 설정합니다. 
 

 [5] Time >  

Aux1 Bus Trans > Trans Time 
 

 [5] Time >  

Aux2 Bus Trans > Trans Time 
 

0에서 999f 사이의 시간을 설정할 수 있습니다. 초를 표시 단위로 
사용할 때 설정할 수 있는 시간은 시스템 형식에 따라 다릅니다. 
 

59.94i 최대 33s09f 29.97p 최대 33s09f 

50i 최대 39s24f 25p 최대 39s24f 

59.94p 최대 16s39f 24p 최대 41s15f 

50p 최대 19s49f 23.98p 최대 41s15f 

 

②  다음 메뉴 조작으로 전환에 대한 활성화/비활성화를 설정합니다. 
 

 [5] Time >  

Aux1 Bus Trans > Transition 
 

 [5] Time >  

Aux2 Bus Trans > Transition 
 

 

On 사용 

Off 비활성화 
 

전환에 대해 비활성화가 설정된 경우 AUX1/2에 설정된 출력 신호가 
전환될 때 출력 신호가 전환 없이 전환됩니다. 
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 샷 메모리 (Shot memories)  

배경 전환 패턴, PinP 크기, 테두리 너비 및 기타 비디오 효과를 메모리에 등록하고 불러올 수 있습니다. 이를 위해 사용되는 메모리를 샷 메모리라고 

합니다. 이펙트 디졸브를 설정하면 현재 이미지에서 샷 메모리에 등록된 이미지 또는 조작으로의 전환을 원활하게 변경할 수 있습니다. 
 

 등록하고  불러올  수  있는  메모리  항목   
 

항목 소스 선택 트랜지션 패턴 메뉴 

BKGD • PGM/A bus 

• PST/B bus 

• Fader amount 

• Wipe direction 

• BKGD patterns 

(MIX, WIPE) 

• [1] WIPE 

Key1 • Key1 Fill bus 

• Key1 Source bus 

• Key1 On/Off 

• Fader amount 

• Wipe direction 

• KEY patterns 

(MIX, WIPE) 

• [1] WIPE 

• [3] Key 

• [4] ChromaKey 

Key2 • Key2 Fill bus 

• Key2 Source bus 

• Key2 On/Off  • [3] Key 

AUX1 • AUX1 bus    

AUX2 • AUX2 bus    

CBGD    • [2] CBGD 

 

메모리에  설정  저장하기 (Store) 

등록할 이미지와 조작을 설정한 다음 메모리에 등록할 수 있습니다. 

 
 

①  장치를 사용하여 메모리에 저장할 이미지 또는 작업을 
설정합니다. 

②  다음 메뉴로 메모리에 등록할 항목을 설정합니다: 
 

 [7] Shot Memory >  

Target Select > BKGD 
 

 [7] Shot Memory >  

Target Select > Key1 
 

 [7] Shot Memory >  

Target Select > Key2 
 

 [7] Shot Memory >  

Target Select > AUX1 
 

 [7] Shot Memory >  

Target Select > AUX2 
 

 [7] Shot Memory >  

Target Select > CBGD 
 

 "등록 및 불러올 수 있는 메모리 항목"을 참조하십시오. 

 

③  [SHOT MEM] 버튼을 누릅니다. 

[SHOT MEM] 버튼이 주황색으로 바뀝니다. 

④  등록할 메모리 번호의 AUX BUS 선택 버튼(1 - 12)을 누르고 
있습니다. (약 1초) 

등록이 완료되면 메모리 번호의 AUX BUS 선택기 버튼이 
녹색으로 켜집니다. 

• AUX BUS 선택 버튼 1에서 6은 [SHIFT] 버튼을 누르는 동안 
7에서 12로 작동합니다. 

• 녹색 또는 황색으로 점등되는 AUX BUS 선택기 버튼에 이미 
메모리가 등록되어 있음을 의미합니다. 

 

⑤  위의 단계를 반복하여 다른 종류의 설정을 등록합니다. 
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메모리에  저장된  작업  불러오기 (Recal l )  
 

 
 

①  다음 메뉴를 사용하여 메모리에서 불러올 대상을 선택합니다. 
 

 [7] Shot Memory >  

Target Select > BKGD 
 

 [7] Shot Memory >  

Target Select > Key1 
 

 [7] Shot Memory >  

Target Select > Key2 
 

 [7] Shot Memory >  

Target Select > AUX1 
 

 [7] Shot Memory >  

Target Select > AUX2 
 

 [7] Shot Memory >  

Target Select > CBGD 
 

 "등록 및 불러올 수 있는 메모리 항목"을 참조하십시오. 

 

②  다음 메뉴를 "ON"으로 하면 "Material selection (소스 선택)" 
항목에 등록된 소스를 사용하는 대신 제어판의 크로스 포인트 
버튼을 사용하여 소스를 선택합니다. 

 [7] Shot Memory >  

XPT Disable 
 

 "등록 대상 및 재생 대상 선택"을 참조하십시오. 

 

③  [SHOT MEM] 버튼을 누릅니다. 

[SHOT MEM] 버튼이 주황색으로 바뀝니다. 

④  메모리 번호의 AUX BUS 선택 버튼(1 - 12)을 눌러 불러옵니다. 

• AUX BUS 선택 버튼 1에서 6은 [SHIFT] 버튼을 누르는 동안 
7에서 12로 작동합니다. 

• 샷 메모리의 경우 비디오 효과가 불러오고 재생이 시작됩니다. 
재생 중에는 메모리 번호의 AUX BUS 선택 버튼이 주황색으로 
켜집니다. 

사용자 버튼에서 메모리 작업을 불러올 때는 "사용자 버튼 설정"을 
참조하십시오 

 

 

메모리에  저장된  작업  삭제하기 (De lete) 

 

 
 

①  [SHOT MEM] 버튼을 길게 누릅니다. 

[SHOT MEM] 버튼이 주황색으로 깜박입니다. 

메모리가 등록된 AUX BUS 선택 버튼도 녹색 또는 

주황색으로 깜박입니다. 

②  삭제할 메모리 번호의 AUX BUS 선택 버튼(1-12)을 약 1초 동안. 

눌린 AUX BUS 선택 버튼이 꺼집니다. 

• AUX BUS 선택 버튼 1에서 6은 [SHIFT] 버튼을 누르는 동안 
7에서 12로 작동합니다. 
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등록할  대상과  재생할  대상  선택  
 

 
 

샷 메모리를 생성할 때 저장할 항목을 선택합니다. 

다음 메뉴 작업을 통해 저장할 항목에 대해 "On"을 설정합니다: 

 

 [7] Shot Memory >  

Target Select > BKGD > Target 
 

 [7] Shot Memory >  

Target Select > Key1 > Target 
 

 [7] Shot Memory >  

Target Select > Key2 > Target 
 

On 메모리에 대상 설정을 등록합니다. 
Off 메모리에 대상 설정을 등록하지 않습니다. 

 

 [7] Shot Memory >  

Target Select > BKGD > XPT 
 

 [7] Shot Memory >  

Target Select > Key1 > XPT 
 

 [7] Shot Memory >  

Target Select > Key2 > XPT 
 

On 메모리에 "소스 선택"항목을 등록합니다. 

Off 메모리에 "소스 선택"항목을 등록하지 않습니다. 

 

 [7] Shot Memory >  

Target Select > AUX1 
 

 [7] Shot Memory >  

Target Select > AUX2 
 

 [7] Shot Memory >  

Target Select > CBGD 
 

On 메모리에 대상 설정을 등록합니다. 
Off 메모리에 대상 설정을 등록하지 않습니다. 

 

 

 

 

 

 

 

 

 
샷 메모리를 재생할 때 재생할 항목과 "Material selection" 항목을 
선택합니다. 

다음 메뉴 작업으로 재생할 항목에 대해 "On"을 설정합니다: 
 

 [7] Shot Memory >  

Target Select > BKGD > Target 
 

 [7] Shot Memory >  

Target Select > Key1 > Target 
 

 [7] Shot Memory >  

Target Select > Key2 > Target 
 

On 대상 (Target) 항목을 재생합니다. 

메모리에 등록되어 있지 않으면 재생되지 않습니다. 
Off 대상 (Target) 항목을 재생하지 않습니다. 

 

 [7] Shot Memory >  

Target Select > BKGD > XPT 
 

 [7] Shot Memory >  

Target Select > Key1 > XPT 
 

 [7] Shot Memory >  

Target Select > Key2 > XPT 
 

On "Material selection" 항목을 재생합니다. 

메모리에 등록되지 않으면 재생되지 않습니다. 
Off "Material selection" 항목을 재생하지 않습니다. 

 

 [7] Shot Memory >  

Target Select > AUX1 
 

 [7] Shot Memory >  

Target Select > AUX2 
 

 [7] Shot Memory >  

Target Select > CBGD 
 

On 대상 (Target) 항목을 재생합니다. 

메모리에 등록되어 있지 않으면 재생되지 않습니다. 
Off 대상 (Target) 항목을 재생하지 않습니다. 

 

 [7] Shot Memory >  

XPT Disable 
 

On BKGD, Key1 및 Key2의 "Material selection" 항목을 
재생하지 않습니다. 

Off BKGD, Key1, Key2의 "Material selection" 항목을 
재생합니다. 
메모리에 등록되지 않으면 재생되지 않습니다. 

메모리 등록 시 대상 및 "Material selection" 항목 선택 

메모리 재생 시 대상 및 "Material selection" 항목 선택 
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 설정  효과  디졸브 (샷  메모리 )  
 

현재 이미지에서 이미지로 전환하거나 샷 메모리에 저장된 작업을 
원활하게 수행할 수 있습니다. 

①  다음 메뉴 조작으로 이미지를 전환할 때 효과를 설정합니다. 

 [7] Shot Memory >  

Effect 
 

Cut 이미지는 잘라내기 효과를 사용하여 전환됩니다. 

Dissolve 이미지는 디졸브 효과를 사용하여 전환됩니다. 

 

• 다음 메뉴 조작으로 디졸브 효과의 시간을 설정합니다. 

 [5] Time >  

Effect Dissolve 

 

②  다음 메뉴 조작으로 색상을 변경할 때 효과를 선택합니다. 

 [7] Shot Memory >  

Hue Path 
 

다음 색상은 Hue의 대상입니다. 

• 색상 배경의 색상 

• 테두리의 색상 

• 가장자리의 색상 

• 채우기 매트의 색상 
 

Short 벡터 스코프에서 색상이 더 적은 색조로 변경됩니다. 

Long 벡터 스코프에서 색상이 더 많은 색조로 변경됩니다. 

CW 색조는 벡터 스코프에서 시계 방향으로 변경됩니다. 

CCW 색조는 벡터 스코프에서 시계 반대 방향으로 변경됩니다. 

 

• 작업이 전환되면 눌린 AUX BUS 선택 버튼이 주황색으로 
켜집니다. 

• 작업이 전환되는 동안 효과 항목을 "Dissolve"에서 "Cut"로 
변경하면 디졸브 효과가 해제되고 이미지가 선택한 샷 메모리의 
이미지로 순식간에 전환됩니다. 

• 작업 전환 중에는 페이더의 작동 레버가 취소됩니다. 

• 작업이 전환되는 동안에는 다른 메모리 작업을 불러올 수 
없습니다 
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 비디오 메모리  
 

이 장치는 정지 이미지 메모리(Still)를 두 개의 채널로 저장하여 

사용할 수 있습니다. 

• 키 신호가 있는 이미지는 비디오 메모리(정지 이미지 및 
동영상)에 저장할 수 있습니다. 

• 비디오 메모리 데이터는 USB 메모리에 저장하고 USB 
메모리에서 읽을 수 있습니다. 

• 본 기기의 시스템 형식이 1080과 720 사이에서 변경되면 
저장된 비디오 메모리가 삭제됩니다. 

시스템 형식을 변경하기 전에 비디오 메모리를 USB 메모리 또는 

프로젝트 파일에 저장하십시오. 

■ 비디오 메모리 입력/출력 

이미지 입력 자료는 AUX 버스(AUX1, AUX2)의 출력 신호에서 

선택할 수 있습니다. 

 

<비디오 메모리의 이미지 시스템> 

 
 

 

 

 

 

 

 

 정지  이미지  촬영하기 (스틸 )  

①  다음 메뉴 조작으로 "Still1" 또는 "Still2"를 선택합니다. 

 [6] Still >  

Still Select 
 

②  다음 메뉴 조작으로 비디오 메모리에 기록할 이미지를 
설정합니다. 

 [6] Still >  

CaptureSetting > Video 
 

AUX1, AUX2 AUX 버스(AUX1, AUX2)의 출력 신호가 소스로 
기록됩니다. 

 

③  다음 메뉴 조작으로 검토 표시를 설정합니다. 

 [6] Still >  

Capture Setting > Review 
 

On 이미지가 기록된 후 AUX 버스에 기록된 비디오 
메모리의 이미지가 표시됩니다(약 2초 동안). 

Off 리뷰 표시가 표시되지 않습니다. 

 

④  정지 이미지는 다음 메뉴에서 OSD/TIME 다이얼 (실행)을 누르는 
동시에 기록됩니다. 

 [6] Still >  

Capture 
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 USB 메모리  

본 기기의 비디오 메모리 데이터 및 설정 데이터를 프로젝트 파일로 USB 메모리에 저장할 수 있습니다. 반대로, 이 데이터는 

USB 메모리에서 장치로 로드할 수 있습니다. 

또한 장치의 소프트웨어를 업데이트할 수 있습니다. 

• USB 메모리에 고화질의 정지 이미지 파일을 저장하는 데 시간이 걸릴 수 있습니다. 

 

비디오 메모리 (정지 이미지 데이터: Still1, Still2): 
<지원되는 파일 형식> 

 

 

• 이 장치는 24비트 비압축 또는 32비트 비압축 TARGA 파일을 지원합니다. 

다른 유형의 TARGA 파일이 장치에 로드되면 검정 이미지가 썸네일로 표시되고 장치가 파일을 인식할 수 없습니다. 

• 비디오 메모리의 정지 이미지를 GIF 형식으로 메모리 카드에 저장하면 화질이 저하될 수 있습니다. 

<적용 가능한 크기> 
 

• 이미지의 크기는 "적용 가능한 크기"와 일치하지 않는 경우 자동으로 변환됩니다. 

• "적용 가능한 크기"와 일치하지 않는 이미지는 크기가 변경되지 않고 출력 중앙에 배치됩니다. 크기가 크면 크기 밖으로 돌출 된 부분이 
잘립니다. 이미지의 크기가 스위처 프로젝트 설정보다 작으면 빈 부분이 검게 표시됩니다. 

프로젝트 파일 데이터(Project): 
"프로젝트 파일 데이터"는 다음 데이터를 제외하고 장치에 저장된 모든 데이터를 나타냅니다. 프로젝트 파일을 저장할 수 

있습니다. 

 

업데이트용 소프트웨어(Update): 
업데이트를 위한 소프트웨어가 로드되었습니다. 

이 소프트웨어는 아래 주소가 제공된 웹 사이트의 "서비스 및 지원"에서 구할 수 있습니다. 

https://pro-av.panasonic.net/en/ 

업데이트 절차는 다운로드 파일에 포함된 지침의 단계를 따르십시오. 

로그 파일(Log): 
장치에 저장된 로그 파일을 저장할 수 있습니다. 

 

비트맵(bmp), JPEG(jpg), TARGA(tga), TIFF(tif), GIF(gif), PNG(png) 

HD / 1080i : 1920×1080 
HD/1080p: 1920×1080 

HD/720p: 1280×720 

Date, time, network settings 

● USB 메모리에 관하여 
본 장치에 사용되는 USB 메모리는 USB 2.0 표준을 준수해야 합니다. 장치를 사용하여 USB 메모리를 포맷하십시오. 

FAT 또는 exFAT로 포맷된 메모리 카드를 사용합니다. (NTFS로 포맷된 USB 메모리는 인식할 수 없습니다.) 

다음 USB 메모리 장치에 대해 본 기기와의 작동이 확인되었습니다. 

• KIOXIA 트랜스메모리 U301(32GB, 64GB, 128GB) 
• 샌디스크 크루저 글라이드 CZ600 (32GB, 64GB, 128GB) 

사용 설명서에서 사용할 수 없는 최신 정보를 보려면 다음 웹 사이트를 방문하십시오. https://pro-av.panasonic.net/en/ 

• 메모리 카드가 있을 수 있는 환경에서 사용하거나 보관해서는 안 됩니다. 

• 고온/습도 노출; 

• 물방울 노출; 또는 

• 전기적 충전 
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데이터는 USB 메모리의 다음 폴더에 저장됩니다. 

데이터를 로드하려면 먼저 해당 폴더에 데이터를 저장한 다음 파일을 로드합니다. 

 

<데이터 폴더 구성> 

데이터 형식 저장 유형 항목 저장 폴더 확장 

프로젝트 파일(project) Project (*1) “HS\COMM\PROJECT” 001, 002, … (*3) 

비디오 메모리(스틸 파일) Still1, Still2 (*2) “HS\COMM\IMAGE” bmp, tga, png, jpg(jpeg), tif(tiff), gif 

파일 업데이트 – “HS\HSW10\UPDATE” 10d 

로그 파일 Log “HS\HSW10\LOG” log 

TEXT 파일로드 (29 페이지)  “HS\HSW10\TEXT” txt (*4) 

*1 프로젝트 파일은 다음 메뉴 조작으로 선택한 설정 데이터, 촬영 메모리 데이터 및 정지 이미지 데이터를 함께 저장합니다. 

 

 [18] USB Memory >  

Save > Setup 
 

 [18] USB Memory >  

Save > Shot 
 

 [18] USB Memory >  

Save > Still 
 

*2 키 신호가 연결된 정지 이미지 데이터가 비디오 메모리에 저장된 경우 파일 형식으로 "tga" 또는 "png"를 선택하십시오. 

다른 파일 형식의 정지 이미지 데이터는 키 신호를 첨부하여 저장할 수 없습니다. 

*3 프로젝트 파일은 HS\COMM\PROJECT 폴더 아래에 생성된 파일 이름 폴더로 생성된 폴더에 저장됩니다. 

저장되는 프로젝트 파일이 큰 경우 파일이 분할되고 각 파일에 일련 번호 확장자(001, 002 등)가 추가됩니다. 

*4 [Load TEXT]를 선택하면 본 기기에서 포맷한 USB 메모리의 "HS\HSW10\TEXT" 폴더에 저장된 텍스트 파일(.txt)을 로드하고 콘텐츠를 사용하여 문자열로 

설정할 수 있습니다. USB 메모리가 연결되어 있지 않으면 [Load TEXT]를 선택할 수 없습니다. 

 

  

USB 메모리 취급 주의 사항 
• USB 메모리를 제거하기 전에 "마운트 해제"하십시오. 

"마운트 해제" 없이 USB 메모리를 제거하면 전환이 일시 중지되거나 USB 메모리에 저장된 콘텐츠가 손실될 수 있습니다. 

• 예를 들어 USB 메모리에 저장된 데이터는 USB 메모리를 잘못 배치하거나 잘못된 작업을 수행하여 손실될 수 있습니다. 중요한 

데이터는 컴퓨터나 다른 장치에 저장하는 것이 좋습니다. 

 

exFAT 작업 시 주의 사항 
• exFAT를 사용할 때 표시되는 타임스탬프는 컴퓨터에 표시되는 것과 다를 수 있습니다. 

이 단위는 UTC 표준 시간대와 함께 작동하므로 예를 들어 일본 표준 시간대(UTC +9)에서 실행되는 컴퓨터를 사용하는 경우 컴퓨터의 

타임스탬프 표시에 9시간 차이가 있습니다. 
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USB 메모리  포맷  
 

본 기기에서 USB 메모리를 사용하기 전에 먼저 본 기기에서 USB 

메모리를 포맷해야 합니다. 포맷을 실행하면 USB 메모리가 

포맷되고 전용 디렉토리가 생성됩니다. (USB 메모리에 저장된 

모든 파일이 삭제됩니다.) 

 

①  USB 메모리를 본 장치의 USB 커넥터(Type-A 커넥터)에 
삽입합니다. 

②  다음 메뉴에서 OSD/TIME 다이얼(Execute)을 눌러 포맷합니다. 

 

 [18] USB Memory >  

Format 

 
USB 메모리가 삽입되지 않은 경우 항목이 회색으로 표시됩니다. 

• 포맷하려면 확인 화면에서 "YES"를 선택합니다. 

• 취소하려면 "아니오"를 선택하십시오. 

 

본 기기에서 사용할 수 있도록 USB 메모리를 포맷하십시오. 

 

 

 

 

 

 

 

 

 

 USB 메모리에  데이터  저장하기  

 

①  본 기기에서 포맷된 USB 메모리를 USB 커넥터(Type-A 
커넥터)에 삽입하십시오. 

②  다음 메뉴 조작으로 USB 메모리에 저장할 데이터를 선택합니다. 
 

 [18] USB Memory >  

Save > Save Type 

 

정지 이미지를 저장할 때: 

다음 메뉴 조작으로 정지 이미지를 저장할 파일 형식을 

선택합니다. 

 [18] USB Memory >  

Save > File Format 
 

프로젝트 파일을 저장할 때: 

다음 메뉴 조작으로 프로젝트 파일로 저장할 항목을 "On"으로 

설정합니다. 

 

 [18] USB Memory >  

Save > Setup 
 

 [18] USB Memory >  

Save > Shot 
 

 [18] USB Memory >  

Save > Still 

 

③  다음 메뉴에서 OSD/TIME 다이얼(Excute)을 눌러 파일 선택 
화면을 표시합니다. 

 

 [18] USB Memory >  

Save > Save 

 
데이터가 저장되는 대상은 <Data folder configuration>을 
참조하십시오. 

• 비디오 메모리의 정지 이미지를 USB 메모리에 GIF 형식으로 
저장하면 화질이 저하될 수 있습니다. 

• 영숫자 문자와 기호는 다음과 같은 용도로 사용할 수 있습니다. 
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 USB 메모리에서  데이터  로드  

 

①  데이터가 저장된 USB 메모리를 USB 커넥터(Type-A 커넥터)에 

삽입합니다.  

데이터가 각 폴더에 저장된 후 파일을 로드합니다. 다른 폴더에 

저장된 데이터는 장치에서 인식되지 않습니다.  

데이터가 저장되는 대상은 <데이터 폴더 구성>을 참조하십시오. 

 

②  다음 메뉴에서 OSD/TIME 다이얼(Excute)을 눌러 파일 선택 
화면을 표시합니다. 

 

 [18] USB Memory >  

Load > Load 

 

<파일 선택 화면에 표시되는 내용의 예> 
 

 
 

③  다음 메뉴 조작으로 로드할 파일 유형을 선택합니다. 

 [18] USB Memory >  

Load > Load Type 

 

①  OSD/TIME 다이얼을 돌려 파일 이름을 로드합니다. 로드되는 

파일 이름이 11자를 초과하는 경우 축약된 파일 이름이 표시될 수 

있습니다.  

로드할 파일의 이름이 33자 이상이면 파일 선택 화면에 표시되지 

않습니다. 

• 영숫자 문자와 기호는 파일 이름에 사용할 수 있습니다. 

다른 문자를 사용하는 파일은 본 장치에 표시할 수 없습니다. 

②  OSD/TIME 다이얼을 눌러 파일을 로드합니다. 

 

 

 USB 메모리  정보  표시  

 

①  데이터가 저장된 USB 메모리를 USB 커넥터(Type-A 커넥터)에 
삽입합니다. 

②  다음 메뉴를 표시합니다. 
 

 [18] USB Memory >  

Free 
 

 [18] USB Memory >  

Total 
 

 

Free USB 메모리의 남은 여유 공간이 표시됩니다. 

Total 메모리 카드의 용량이 표시됩니다. 
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기본 운영  

 

 내부 저장소  

이 장치의 설정 데이터는 내부 저장소에 프로젝트 파일로 저장할 수 있습니다. 또한 내부 저장소에서 

본 기기로 설정 데이터를 로드 할 수도 있습니다. 

• 고화질의 정지 이미지 파일을 내부 저장소에 저장할 때 시간이 걸릴 수 있습니다. 

• 다음 데이터를 선택하여 저장하거나 프로젝트 파일로 로드할 수 있습니다. 셋업 데이터, 샷 메모리 데이터, 스틸 비디오 메모리 

• 날짜, 시간 및 네트워크 설정은 저장할 수 없습니다. 

 

프로젝트  파일  관리  화면  
 

다음 메뉴를 표시합니다. 
 

 [14] Project >  
 

• 이 메뉴 화면을 사용하여 내부 저장소에서 프로젝트 파일을 로드, 
저장, 삭제 및 이름을 바꿀 수 있습니다. 
가장 최근에 로드된 프로젝트 파일에 대한 정보도 볼 수 있습니다. 

 

 프로젝트  파일을  내부  저장소에  저장  

①  다음 메뉴를 사용하여 저장할 파일을 선택합니다. 

 [14] Project >  

Project File > Project 1 
 

 [14] Project >  

Project File > Project 2 
 

 [14] Project >  

Project File > Project 3 
 

• 이미 저장 되어있는 프로젝트 파일을 덮어쓸 수 있습니다. 

• 보호 항목이 "On"인 파일은 덮어쓸 수 없습니다. 

 

②  Save 항목에서 OSD/TIME 다이얼(Excute)을 눌러 내부 
저장소에서 프로젝트 파일을 저장합니다. 

 

 

 

 

 

 

 

 

 

 

 

 

 

내부  저장소에서  프로젝트  파일  로드  
 

①  다음 메뉴와 함께 로드할 파일을 선택합니다.  

②   [14] Project >  

Project File > Project 1 
 

 [14] Project >  

Project File > Project 2 
 

 [14] Project >  

Project File > Project 3 
 

②  Load 항목의 OSD/TIME 다이얼(Execute)을 눌러 내부 
저장소에서 프로젝트 파일을 로드합니다. 

③  Protect 항목을 설정하여 대상 파일을 보호할 수 있습니다. 

• 보호 항목이 "On"인 프로젝트 파일은 덮어쓰거나, 삭제하거나, 
파일 이름을 변경할 수 없습니다. 

 

내부  저장소에서  프로젝트  파일  삭제  

 

①  다음 메뉴에서 삭제할 파일을 선택합니다. 
 

③   [14] Project >  

Project File > Project 1 
 

 [14] Project >  

Project File > Project 2 
 

 [14] Project >  

Project File > Project 3 

 

②  Delete 항목의 OSD/TIME 다이얼(Execute)을 눌러 내부 
저장소에서 프로젝트 파일을 로드합니다. 

• 보호 항목 "On"이 있는 파일은 삭제할 수 없습니다. 

③  3 Protect 항목을 설정하여 대상 파일을 보호할 수 있습니다. 

• 보호 항목이 "On"인 프로젝트 파일은 덮어쓰거나, 삭제하거나, 
파일 이름을 변경할 수 없습니다. 
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내부  저장소에  저장된  프로젝트  파일의  파일  

이름  변경  
 

①  다음 메뉴를 사용하여 이름을 변경할 프로젝트 파일을 
선택합니다. 

 

④   [14] Project >  

Project File > Project 1 
 

 [14] Project >  

Project File > Project 2 
 

 [14] Project >  

Project File > Project 3 
 

 

②  내부 저장소에 저장된 프로젝트 파일의 이름을 이름 항목으로 
변경할 수 있습니다. 

• 파일 이름은 최대 32자까지 가능합니다. 

<파일 이름에 사용할 수 있는 문자> 

 

③  보호 항목을 설정하여 대상 파일을 보호할 수 있습니다. 

• 보호 항목이 "On"인 프로젝트 파일은 덮어쓰거나, 삭제하거나, 
파일 이름을 변경할 수 없습니다. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

A부터 Z까지, A부터 Z까지, 0부터 9까지, 공백, 

! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > / 
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입력 / 출력 신호 설정  

 

입력 / 출력 신호 설정 

 입력 신호 설정  

사용 가능한 입력은 다음과 같습니다. 

 

논리형 입력 이름 물리적 입력 이름 
제한 

IN1 SDI IN1/HDMI IN1 SDI/HDMI 상호 배타적, 간소화된 UC/DC, 스케일러 포함 

IN2 SDI IN2 간소화된 UC/DC 

IN3 SDI IN3 UC/DC 사용 

IN4 SDI IN4 UC/DC 사용 

IN5 HDMI IN2 스케일러 포함 

IN6 LAN SRT/NDI|HX 

IN7 LAN SRT/NDI|HX  

IN8 LAN NDI, 호환성 모드(key&fill)로 동작할 때 IN9는 비활성화 됨 

IN9 LAN NDI 

*UC : Up converting, DC : Down Converting 

 

입력 신호를 설정할 때는 먼저 다음 메뉴에서 설정하려는 입력 신호를 선택하십시오. 
 

 [10] Input >  

IN1 > SDI/HDMI 

 

 [10] Input >  

INx > Streaming Mode 
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<입력 신호별 설정 목록> 

 

 

입력 커넥터 

이 설명서의 설정 메뉴 및 페이지 

Status FS Freeze Limited Name 
Up/Down 

Converter 
C/C HDMI Status 

P69 P70 P70 P71 P71 P71 P72 P74 

SDI IN 1    –  –  – 

SDI IN 2    –  –  – 

SDI IN 3    –    – 

SDI IN 4    –    – 

HDMI IN 1 – –    –   

HDMI IN 2 – –    –   

IP IN1 – – – –  – – – 

IP IN2 – – – –  – – – 

IP IN3 – – – –  – – – 

IP IN4 – – – –  – – – 

 

 

 

입력 커넥터 

이 설명서의 설정 메뉴 및 페이지 

HDMI Input Scale SRT Status SRT Input NDI Status NDI Input 
Camera Setting 

P73 P73 P75 P75 P77 P76 P104 

SDI IN 1 – – – – – –  

SDI IN 2 – – – – – –  

SDI IN 3 – – – – – –  

SDI IN 4 – – – – – –  

HDMI IN 1   – – – –  

HDMI IN 2   – – – –  

IP IN1 – –  *1  *1  *2  *2   

IP IN2 – –  *1  *1  *2  *2   

IP IN3 – – – –       

IP IN4 – – – –       
 

✓ : 설정 가능 

- : 설정 불가 
 

*1 SRT 설정에만 해당 

*2 NDI/NDI|HX 설정에만 해당 
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입력 / 출력 신호 설정  

 

 

익스크루시브  입력  커넥터에  대한  설정  
 

1번 입력 (IN 1)은 SDI 입력(SDI IN 1) 또는 HDMI 입력 (HDMI IN 1) 중 

한가지를 선택해서 사용하는 익스크루시브 입력으로 동작됩니다. 

다음 메뉴 조작으로 두가지 중 하나로 입력 신호 유형을 설정합니다. 

 

 [10] Input >  

IN1 > SDI/HDMI 
 

SDI IN IN1에 대해 SDI IN 1에 입력되는 SDI 신호를 
선택합니다. HDMI 신호가 입력되더라도 본 기기에 
입력되지 않습니다. 

HDMI IN IN1의 경우 HDMI IN1에 대한 HDMI 신호 입력을 
선택합니다. SDI 신호가 입력되더라도 본 기기에 
입력되지 않습니다. 

 

 

 입력  신호  상태  확인  

입력 신호의 상태를 확인할 수 있습니다. 

 

다음 메뉴를 표시합니다. 

 

 [10] Input >  

INx > Status Information 

장치는 입력 신호의 내용을 자동으로 판단하여 다음과 같은 정보를 

표시합니다. 

Format 입력되는 SDI 신호에 대한 이미지 포맷 정보를 
표시합니다. 

Audio 입력되는 SDI 신호에 대한 오디오 정보를 표시합니다. 

Status 감지: 

본 기기의 시스템 형식에 적합한 입력 신호 

형식입니다. 
지원 되지 않는: 
이 장치의 시스템 형식에 적합하지 않은 입력 신호 

형식입니다. 
감지 안 함: 
장치에 입력되는 비디오 신호가 없습니다. 

 

 

 

 

 

 

 

 

 
다음 메뉴를 표시합니다. 

 

 [10] Input >  

INx > Status Information 

본 장치는 입력 신호의 내용을 자동으로 결정하고 다음 정보를 

표시합니다. 
 

Size 입력되는 HDMI 신호에 대한 해상도 정보를 표시합니다. 

Dot Clock 입력되는 HDMI 신호에 대한 도트 클럭 정보를 
표시합니다. 

H-Frequency 입력되는 HDMI 신호에 대한 수평 주파수 정보를 
표시합니다. 

V-Frequency 입력되는 HDMI 신호에 대한 수직 주파수 정보를 
표시합니다. 

Status Detect : 

본 기기의 시스템 형식에 적합한 입력 신호 

형식입니다. 

Unsupported : 

이 장치의 시스템 형식에 적합하지 않은 입력 신호 

형식입니다. 

Not Detect : 

장치에 입력되는 비디오 신호가 없습니다. 

 

 
 

 "SRT 입력 신호 정보 표시"를 참조하십시오. 

 

 "NDI 입력 신호 정보 표시"를 참조하십시오. 

  

HDMI 입력 신호의 경우 

SRT 입력 신호의 경우 

SDI 입력 신호의 경우 

NDI 입력 신호의 경우 
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 프레임  동기화 (FS)  장치  설정  

 
프레임 싱크로나이저(FS)는 각 SDI 입력에 대해 On/Off로 설정할 수 

있습니다. 

HDMI 입력의 경우 프레임 싱크로나이저가 항상 작동됩니다. 

켜기에서 끄기로 또는 그 반대로 설정할 수 없습니다. 

 

다음 메뉴 조작으로 프레임 동기화 장치를 설정합니다. 
 

 [10] Input >  

INx > FS Mode 
 

Off 프레임 동기화기를 끕니다. 이 경우 라인 동기화기 

기능이 작동합니다. 

라인 싱크로나이저 기능은 입력 비디오 신호의 

위상을 수평 동기 신호의 위상에 맞게 자동으로 

조정합니다. 

Normal 프레임 싱크로나이저 기능을 활성화합니다. 시스템 
형식과 다른 신호가 입력되면 화면이 검게 변합니다. 

Auto 프레임 싱크로나이저 기능을 활성화합니다. 시스템 
형식과 다른 신호가 입력되어도 화면이 검게 변하지 
않습니다. 이 경우 비디오 출력이 중단될 수 있습니다. 

• 출력 신호 위상을 [0H]로 설정하면 FS 항목 설정으로 "Off"를 
선택할 수 없습니다. 

FS 항목을 "Off"로 설정하면 Normal로 변경됩니다. 

• 3G-SDI 레벨 B 매핑 신호를 입력할 때 프레임 동기화 장치 설정을 
"자동"으로 설정하십시오. 

 

 

 지연  시간  설정  

입력 신호가 지연될 수 있습니다. 

• 이 설정은 SDI IN1에서 4까지의 입력 신호에 대한 것입니다. 

• 포함된 오디오에는 영향을 주지 않습니다. 

 

다음 메뉴 조작으로 지연 시간을 설정합니다. 

 

 [10] Input >  

INx > FS Delay 
 

 

 

 

 

 

 

 

 

 

 

 입력  신호  프리즈  (Freez) 

SDI/HDMI 입력 신호는 프리즈하여 사용할 수 있습니다. 신호가 정지되는 
동안에는 해당 입력의 집계 신호가 출력되지 않습니다. 

 

 

①  다음 메뉴 조작으로 고정 동작을 선택합니다. 
 

 [10] Input >  

INx > Freeze Select 
 

Frame 이미지는 프레임별로 고정됩니다. 

Field 이미지는 필드별로 고정됩니다. 이것은 

동영상을 고정하는 데 사용됩니다. 

그러나 인터레이스 신호의 경우 대각선 

움직이는 부분이 들쭉날쭉하게 나타날 수 있습니다. 

• 이미지가 고정되어 있는 동안에도 프레임 또는 필드를 선택할 수 
있습니다. 

②  다음 메뉴 조작으로 입력 이미지를 고정하고 해제합니다. 
 

 [10] Input >  

INx > Freeze 
 

• "Disable(비활성화)"을 "Enable(활성화)"로 변경하면 이미지 신호가 

고정됩니다. 

• "Enable"을 "Disable"로 변경하면 이미지 신호가 동결 상태에서 

해제됩니다. 

멀티 뷰 디스플레이로 출력하도록 설정된 신호를 고정하면 소스 

이름 앞에 "F" 표시가 표시됩니다. 

• 프레임 싱크로나이저 기능을 OFF로 본 장치를 사용하면 동결을 

실행할 때 출력 이미지가 방해를 받을 수 있지만 고정된 이미지에는 

부정적인 영향을 미치지 않습니다. 

• 스위처가 프레임 싱크로나이저와 함께 사용되는 경우 

기능이 OFF일 때 "Enable"이 고정 설정으로 설정되면 프레임 

싱크로나이저 기능이 자동으로 ON으로 전환됩니다. 

 

 

 

 

  

프리즈(Freez) 설정 
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입력 / 출력 신호 설정  

 

 

 제한 (L imited)  설정  

이 장치에서는 카메라와 같은 연결된 입력 장치의 HDMI 톤 레벨에 

맞게 전체 범위 및 제한 범위를 설정할 수 있습니다. 

 

 [10] Input >  

INx > Limited 
 

• 전체 범위: HDMI 입력은 RGB 0에서 255를 지원합니다. 

• 제한된 범위: HDMI 입력은 RGB 16에서 235를 지원합니다. 이를 
비디오 범위라고도 합니다. 

 

 소스  이름  설정  

입력 신호에 소스 이름을 지정할 수 있습니다. 

이러한 이름은 기본 설정 또는 사용자 설정에서 선택할 수 있습니다. 

 

다음 메뉴 조작으로 소스 이름 유형을 선택합니다. 
 

 [10] Input >  

INx > Name Type 
 

Default 

(default settings) 

다음 소스 이름이 자동으로 선택됩니다. 
IN1에서 IN9 

User 

(user settings) 

소스 이름은 최대 32자까지 설정할 수 
있습니다. 

<파일 이름에 사용할 수 있는 문자> 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

업  컨버터  설정  
 

아래 나열된 옵션 장치에 내장된 SDI IN3, SDI IN4의 설정을 선택합니다: 

①  다음 메뉴 동작으로 영상 동작 감지 감도를 설정합니다: 

 

 [10] Input >  

INx > Up/Down Converter > Move Detect 
 

 
 

②  다음 메뉴 조작으로 이미지 가장자리의 선명도를 설정합니다. 
 

 [10] Input >  

INx > Up/Down Converter > Sharp 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

  

Off HDMI 입력의 톤 레벨이 전체 범위일 때 선택합니다. 

On HDMI 입력의 톤 레벨이 제한된 범위일 때 
선택합니다. 

A부터 Z까지, A부터 Z까지, 0부터 9까지, 공백, 

! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > / 
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제작 : ㈜디브이네스트 1544-5596 

 

 색상  보정  (Color  Corrector )  

 
SDI/HDMI에 내장된 색상 보정을 설정합니다. 

 

다음 메뉴 조작으로 Color Corrector에 대한 활성화(On)/비활성화(Off)를 
설정합니다. 
 

 [10] Input >  

INx > Color Correct > C/C 

 

 

①  다음 메뉴 조작으로 Y 신호 게인 값을 설정합니다. 
 

 [10] Input >  

INx > Color Correct > C/C Process > Y-Gain 
 

②  다음 메뉴 조작으로 페데스탈 수준 값을 설정합니다. 
 

 [10] Input >  

INx > Color Correct > C/C Process > Pedestal 
 

③  다음 메뉴 조작으로 채도의 게인 값을 설정합니다. 
 

 [10] Input >  

INx > Color Correct > C/C Process > C-Gain 
 

④  다음 메뉴 조작으로 색조의 변화량을 설정합니다. 
 

 [10] Input >  

INx > Color Correct > C/C Process > Hue 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

색상 보정 설정 

프로세스 제어 



73 

입력 / 출력 신호 설정  

 

 HDMI  입력  신호  설정  

HDMI 입력 신호를 설정합니다. 

다음 해상도의 신호를 입력할 수 있습니다. 

 

<HDMI 입력 신호 호환성 차트> 

HDMI 입력 신호 

시스템 포맷 

1080/ 

59.94p 

1080/ 

50p 

1080/ 

29.97p 

1080/ 

25p 

1080/ 

24p 

1080/ 

23.98p 

1080/ 

59.94i 

1080/ 

50i 

720/ 

59.94p 

720/ 

50p 

1080/59.94p 
(1920 x 1080)/ 
59.94 Hz, 60 Hz 

 
 

 
– 

 
– 

 
– 

 
– 

 
– 

 
 

 
– 

 
 

 
– 

1080/50p 
(1920 x 1080)/50 Hz –  – – – – –  –  

1080/29.97p 
(1920 x 1080)/ 
29.97 Hz 

 
– 

 
– 

 
 

 
– 

 
– 

 
– 

 
– 

 
– 

 
– 

 
– 

1080/25p 
(1920 x 1080)/25 Hz – – –  – – – – – – 

1080/24p 
(1920 x 1080)/24 Hz – – – –  – – – – – 

1080/23.98p 
(1920 x 1080)/ 
23.98 Hz 

 
– 

 
– 

 
– 

 
– 

 
– 

 
 

 
– 

 
– 

 
– 

 
– 

1080/59.94i 
(1920 x 1080)/ 
59.94 Hz, 60 Hz 

 
 

 
– 

 
 

 
– 

 
– 

 
– 

 
 

 
– 

 
 

 
– 

1080/50i 
(1920 x 1080)/50 Hz –  –  – – –  –  

720/59.94p 
(1280 x 720)/59.94 Hz, 60 Hz  – – – – –  –  – 

720/50p 
(1280 x 720)/50 Hz –  – – – – –  –  

WSXGA+ 
(1680 x 1200)/60 Hz           

SXGA 
(1280 x 1024)/60 Hz           

WXGA 
(1280 x 768)/60 Hz           

XGA 
(1024 x 768)/60 Hz           

 

✓ : 설정 가능 

- : 설정 불가 

 

• 다른 해상도 또는 주파수의 신호가 입력되면 신호를 올바르게 가져올 수 없습니다. 이와 같이 출력되는 이미지는 검게 보이거나 흐트러질 수 
있습니다. 

• 이 장치는 HDCP(High-bandwidth Digital Content Protection)와 호환되지 않습니다. 

 

다음 메뉴 조작으로 스케일링 모드를 선택합니다. 

 [10] Input >  

INx > Scale 
 

Fit-V 입력 이미지의 종횡비는 유지되고 이미지의 크기는 수직 해상도에 따라 증가하거나 축소됩니다. 

Fit-H 입력 이미지의 종횡비는 유지되고 이미지의 크기는 수평 해상도에 따라 증가하거나 축소됩니다. 

Full 입력 이미지의 크기는 시스템 해상도에 따라 증가하거나 축소됩니다. (입력 이미지의 종횡비는 동일하게 
유지되지 않습니다. 세로 방향과 가로 방향에서 이미지 크기가 증가하거나 축소되는 속도가 다릅니다. 
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제작 : ㈜디브이네스트 1544-5596 

 

 HDMI  입력  신호  정보  표시하기  

HDMI 입력 신호 이미지에 관한 정보를 표시하는 데 사용됩니다. 정보는 변경할 수 없습니다. 

 

다음 메뉴를 표시합니다. 
 

 [10] Input >  

INx > Status Information 
 

Size 이미지의 픽셀 수를 나타냅니다. 

Dot Clock 이미지의 도트 클럭 주파수를 나타냅니다. 

H-Frequency 이미지의 수평 주파수를 나타냅니다. 

V-Frequency 이미지의 수직 주파수를 나타냅니다. 

Status Detect : 

본 기기의 시스템 형식에 적합한 입력 신호 형식입니다. 

Unsupported : 

이 장치의 시스템 형식에 적합하지 않은 입력 신호 형식입니다. 

Not Detect : 
장치에 입력되는 비디오 신호가 없습니다. 

 

지원되는 형식은 다음과 같습니다. 

 

<HDMI 형식 지원> 

 

HDMI 입력 신호 
도트 클럭 주파수(MHz) 

주파수 

수평(kHz) 수직 (Hz) 

XGA 1024×768 Digital 65.0 48.36 60.00 

WXGA 1280×768 Digital 79.5 47.78 59.87 

SXGA 1280×1024 Digital 108.0 63.98 60.02 

WSXGA+ 1680×1050 Digital 146.2 65.29 59.95 

720/59.94p 1280×720 Digital 74.25/1.001 44.96 60.00/1.001 

720/50p 1280×720 Digital 74.25 37.50 50.00 

1080/59.94i 1920×1080 Digital 74.25/1.001 33.72 60.00/1.001 

1080/50i 1920×1080 Digital 74.25 28.13 50.00 

1080/23.98p 1920×1080 Digital 74.2 27.0 24.00/1.001 

1080/24p 1920×1080 Digital 74.2 27.0 24.00 

1080/25p 1920×1080 Digital 74.2 28.1 25.00 

1080/29.97p 1920×1080 Digital 74.2 33.7 30.00 

1080/59.94p 1920×1080 Digital 148.5/1.001 67.50/1.001 60.00/1.001 

1080/50p 1920×1080 Digital 148.5 56.25 50.00 

 

• 입력 신호의 형식이 지원되지 않는 경우 신호를 제대로 가져오지 못할 수 있으며 검은색 이미지 또는 왜곡된 이미지가 나타날 수 있습니다. 
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입력 / 출력 신호 설정  

 

 SRT 입력  신호  설정  
 

이 장치는 최대 2개의 SRT 신호를 입력할 수 있습니다. 

SRT를 지원하는 입력에 대한 SRT 설정은 "입력 신호 설정"에서 
사용할 수 있습니다. 

SRT 입력 신호를 설정할 때는 먼저 다음 메뉴에서 설정하려는 입력 
신호를 설정하십시오. 

 

 [10] Input >  

INx > Streaming Mode 
 

①  다음 메뉴 조작으로 연결 모드를 설정합니다. 

 [10] Input >  

INx > Mode 
 

Caller 본 기기에서 전송 시작 요청을 보낼 전송 소스의 서버 
URL 및 포트 번호를 지정할 때 지정합니다. 

Listener 외부에서 전송을 시작할 때 대기 포트를 지정할 때 
지정합니다. 

 

②  다음 메뉴 조작으로 전송 소스의 서버 URL 및 포트 번호를 
설정합니다(Caller만 해당). 

 [10] Input >  

INx > Server URL 

• 1자에서 254자 사이로 설정할 수 있습니다. 

 [10] Input >  

INx > Server Port 
 

③  다음 메뉴 조작으로 본 기기의 대기 포트 번호를 
설정하십시오(Listener만 해당). 

 [10] Input >  

INx > Port 
 

• 사용할 수 없는 포트 중 하나를 선택하면 메시지가 표시됩니다. 

④  다음 메뉴 조작으로 스트림 ID를 설정합니다. 

 [10] Input >  

INx > Stream ID 
 

• 최대 512자까지 설정할 수 있습니다. 

⑤  다음 메뉴 조작으로 전송된 이미지의 암호화 모드를 설정합니다. 

 [10] Input >  

INx > Encryption 
 

 

⑥  다음 메뉴 조작으로 수신된 이미지를 디코딩하기 위한 문구를 
설정합니다. 

 [10] Input >  

INx > Passphrase 
 

• 10자에서 79자 사이로 설정할 수 있습니다. 

 SRT 입력  신호  정보  표시  

본 기기에 입력되는 SRT 신호의 상태를 확인할 수 있습니다. 

다음 메뉴를 표시합니다. 
 

 [10] Input >  

INx > Status Information 
 

이 장치는 SRT 입력 신호의 내용을 자동으로 결정하고 다음 

정보를 표시합니다. 
 

Format 입력 중인 SRT 신호의 영상 형식 정보를 표시합니다. 

Sampling 

Rate 

입력 중인 SRT 신호의 샘플링 속도 정보를 표시합니다. 

Audio 
Channel 

입력 중인 SRT 신호의 서라운드 정보를 표시합니다. 

Compress 입력 중인 SRT 신호의 압축 형식 정보를 표시합니다. 

Level H.264/H.265 해상도와 프레임 레이트의 상한을 
나타내는 레벨을 표시합니다. 

Status Detect : 

본 기기의 시스템 형식에 적합한 입력 신호 

형식입니다. 

Unsupported : 

이 장치의 시스템 형식에 적합하지 않은 입력 신호 

형식입니다. 

Not Detect : 
장치에 입력되는 비디오 신호가 없습니다. 

 

 소스  이름  설정 (SRT 입력  신호 )   

입력 신호에 소스 이름을 지정할 수 있습니다. 

이러한 이름은 기본 설정 또는 사용자 설정에서 선택할 수 

있습니다. 

다음 메뉴 조작으로 소스 이름 유형을 선택합니다. 

 [10] Input >  

INx > Name Type 
 

 

Default 

(default settings) 

다음에서 소스 이름을 선택합니다. 
IN1에서 IN9 

User 

(user settings) 

소스 이름은 최대 32자까지 설정할 수 
있습니다. 

<파일 이름에 사용할 수 있는 문자> 
 

 
 

  

Disable 수신된 이미지는 디코딩되지 않습니다. 암호화되지 않은 
이미지를 처리할 수 있습니다. 

Enable 수신된 이미지를 디코딩합니다. 

A부터 Z까지, A부터 Z까지, 0부터 9까지, 공백, 

! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > / 
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제작 : ㈜디브이네스트 1544-5596 

 

 NDI/NDI |HX  
 

이 장치는 최대 총 2개의 NDI/NDI에 대해 2개의 HB 신호와 4개의 HX 
신호를 입력할 수 있습니다.HX 신호. 

 

 NDIHX 
 

이 장치는 NDI|HX 버전 1과 NDI|HX 버전 2를 모두 지원합니다. 

NDI|HX 버전1과 NDI|HX 버전2는 모두 H.264를 이미지 압축 
표준으로 지원하며, NDI|HX 버전2도 H.265를 지원합니다. 

 

 NDI  입력  신호  설정  
 

NDI를 지원하는 입력에 대한 NDI 설정은 "입력 신호 설정"에서 사용할 
수 있습니다. 

NDI 입력 신호를 설정할 때는 먼저 다음 메뉴에서 설정하려는 입력 
신호를 설정하십시오. 

 

 [10] Input >  

INx > Streaming Mode 

 

①  다음 메뉴 조작으로 네트워크에서 NDI 입력 소스를 검색하는 데 
사용할 모드를 선택합니다. 

 [10] Input >  

INx > Scan Mode 
 

HB/HX v2 NDI 또는 NDI |HX 버전2 입력 소스. 검색 

HX v1 NDI|HX version1 입력 소스. 검색 

 

②  다음 메뉴에서 OSD/TIME 다이얼(Excute)을 눌러 장치 검색을 
실행합니다. 

 [10] Input >  

INx > Scan 
 

• 검색 결과는 MACHINE NAME(SOURCE NAME) 형식으로 
목록에 표시됩니다. 

• 네트워크에서 컴퓨터 검색에는 다소 시간이 걸릴 수 있습니다. 

③  입력 소스와 NDI 이미지 소스로 설정할 장치의 조합을 선택한 
다음 OSD/TIME 다이얼로 확인합니다. 

• "없음"을 선택하여 선택을 취소할 수 있습니다. 

 

 

 

 

 

 

 

 

 

 

 수신  프로토콜  설정  

NDI 송신기와 함께 사용할 프로토콜을 설정합니다. 

①  다음 메뉴 조작으로 NDI 송신기와 함께 사용할 프로토콜을 

설정합니다. 

 [10] Input >  

INx > Protocol 
 

 

TCP TCP를 NDI 송신기와 함께 사용할 프로토콜로 

설정합니다. (기본값) 
sTCP를 사용한 통신을 허용합니다. 

UDP UDP를 NDI 송신기와 함께 사용할 프로토콜로 

설정합니다. 
UDP 및 sTCP를 사용한 통신을 허용합니다. 

• 우수한 프로토콜은 NDI 전송 측의 프로토콜 설정과의 협상을 
통해 선택됩니다. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

노트 

sTCP(single TCP): 데이터의 정확한 전달을 보장하지만 UDP에 

비해 통신 속도가 느린 연결 중심의 통신 방식입니다. 

UDP: 고속 데이터 전송을 가능하게 하는 비연결형 통신 

방식이지만 해당 데이터의 신뢰성은 TCP보다 낮습니다. 

멀티캐스트 전송을 수행할 때 프로토콜을 UDP로 고정할 필요가 

있습니다. 

PC를 포함한 NDI 소스의 장치 이름은 반드시 영문과 숫자로 

이루어져 있어야 합니다. 한글 등 2바이트 문자의 경우 NDI 

소스가 표시되지 않을 수 있습니다.  
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 NDI  입력  신호  정보  표시  

본 기기에 입력되는 NDI 신호의 상태를 확인할 수 있습니다. 

다음 메뉴를 표시합니다. 

 [10] Input >  

INx > Status Information 
 

이 장치는 NDI 입력 신호의 내용을 자동으로 결정하고 다음 

정보를 표시합니다. 
 

Format 입력되는 NDI 신호에 대한 이미지 형식 정보를 
표시합니다. 

Sampling 
Rate 

입력되는 NDI 신호에 대한 샘플링 속도 정보를 
표시합니다. 

Audio 
Channel 

입력되는 NDI 신호에 대한 서라운드 정보를 표시합니다. 

Frame Data 입력되는 NDI 신호에 대한 색상 정보를 표시합니다. 

Compress 입력되는 NDI 신호에 대한 압축 형식 정보를 표시합니다. 

Streaming Mode 입력되는 NDI 신호에 대한 형식 정보를 표시합니다. 

Level H.264/H.265 해상도와 프레임 속도의 상한을 나타내는 
레벨을 표시합니다. 고대역폭 NDI에 대해서는 표시되지 
않습니다. 

Status Detect : 

본 기기의 시스템 형식에 적합한 입력 신호 

형식입니다. 

Unsupported : 

이 장치의 시스템 형식에 적합하지 않은 입력 신호 

형식입니다. 

Not Detect : 
장치에 입력되는 비디오 신호가 없습니다. 

 

 

 소스  이름  설정 (NDI  입력  신호 )   

입력 신호에 소스 이름을 지정할 수 있습니다. 

이러한 이름은 기본 설정 또는 사용자 설정에서 선택할 수 

있습니다. 

 

다음 메뉴 조작으로 소스 이름 유형을 선택합니다. 

 [10] Input >  

INx > Name Type 
 

Default 

(default settings) 

다음 소스 이름이 자동으로 선택됩니다. 
IN1에서 IN9 

User 

(user settings) 

소스 이름은 최대 32자까지 설정할 수 
있습니다. 

 

<파일 이름에 사용할 수 있는 문자> 

 

 

 알파  채널이  있는  소스에  대한  입력  설정  

이 장치는 일반 NDI 신호와 함께 알파채널 (α channel) 이 포함된 
NDI 신호를 입력할 수 있으며, 이를 사용하여 스위칭 소스로 사용할 
수 있습니다. 

최대 1세트의 α 채널 NDI 신호를 입력할 수 있으며, 아래 차트에 

표시된 설정은 입력 모드를 전환하여 가능합니다: 
 

 알파 채널 설정 
Disabled Enabled 

IN8 Fill Fill 
IN9 Fill Key 

 

다음 메뉴를 사용하여 알파 채널의 활성화/비활성화를 선택합니다 : 
 

 [10] Input >  

INx > Alpha Setting > Use alpha 

 

 그룹  설정  
 

NDI 송신기 및 수신기를 각각 속한 그룹으로 설정하여 기계 검색을 
수행할 때 검색할 그룹을 지정할 수 있습니다. 

여러 그룹을 쉼표로 구분하여 지정할 수 있습니다. 

NDI|HX 버전 1에서는 이 기능을 사용할 수 없습니다. 

①  다음 메뉴 조작으로 그룹 검색 기능에 대한 활성화 또는 
비활성화를 선택하십시오. 

 [10] Input >  

INx > Group > Group 
 

Enable 그룹 검색 기능이 활성화 됩니다. 
Disable 그룹 검색 기능을 사용할 수 없습니다. (기본값) 

 

②  다음 메뉴 조작으로 그룹 이름을 입력합니다. 

 [10] Input >  

INx > Group > Group Name 
 

• 최대 64자의 문자열을 입력할 수 있습니다. 

<파일 이름에 사용할 수 있는 문자> 
 

 

  

A부터 Z까지, A부터 Z까지, 0부터 9까지, 공백, 
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 디스커버리  서버  (D iscovery Server )  설정  

NDI 소스를 자동으로 검색하여 외부 서버에 중앙 등록할 수 있는 

기능을 설정할 수 있습니다. 

이 설정을 활성화하는 것은 네트워크에 많은 양의 NDI 소스가 있고 

트래픽 증가를 피하는 것이 바람직하거나 멀티캐스트 전송이 

불가능하거나 바람직하지 않을 때 효과적입니다. 

 

①  다음 메뉴 조작으로 외부 서버를 설정할지 여부를 선택합니다.  

 [10] Input >  

INx > Use Discovery server >  

Use Discovery server 
 

Enable 외부 서버 설정을 사용할 수 있습니다. 
Disable 외부 서버 설정을 사용할 수 없습니다. (기본값) 

 

③  다음 메뉴 조작으로 외부 서버의 IP 주소를 입력합니다. 

 [10] Input >  

INx > Use Discovery server >  

Use Discovery IP 
 

RTSP 포트  설정  

연결할 카메라의 RTSP 포트 설정과 일치하도록 이 장치의 포트와 

요청 URL을 설정할 수 있습니다. 

이 기능은 NDI|HX 버전 1에서 유효합니다. 

①  다음 메뉴 조작으로 카메라 설정에 맞게 RTSP 포트 번호를 
입력합니다. 

 [10] Input >  

INx > RTSP > Port 
 

• 포트 번호 10668, 10669 및 10670은 사용할 수 없습니다. 
 

④  2 다음 메뉴 조작으로 카메라 설정에 맞게 요청 URL을 
입력합니다.  

 

 [10] Input >  

INx > RTSP > Request URL 
 

• 최대 255자의 문자열을 입력합니다. 

<파일 이름에 사용할 수 있는 문자> 

 

⑤  포트 및 요청 URL을 입력한 후 다음 메뉴에서 OSD/TIME 
다이얼(Excute)을 눌러 변경 사항으로 설정을 업데이트합니다. 

 

 [10] Input >  

INx > RTSP > Connect 

 

아날로그  오디오  입력  신호  설정  

아날로그 오디오는 본 기기의 두 개의 입력 채널(왼쪽 채널 및 오른쪽 

채널)에 입력할 수 있습니다. 

①  다음 메뉴 조작으로 아날로그 오디오 입력을 활성화합니다. 

 

 [15] Ancillary/Audio >  

Analog IN > Audio 
 

Off 아날로그 오디오 입력이 비활성화 됩니다. 
On 아날로그 오디오 입력이 활성화 됩니다. 

 

⑥  다음 메뉴 조작으로 아날로그 오디오 입력 레벨을 설정합니다. 

 [15] Ancillary/Audio >  

Analog IN > Input Type 
 

Line 라인 입력 레벨로 설정합니다. 
MIC 마이크 입력 레벨로 설정합니다. 

 

⑦  다음 메뉴 조작으로 게인을 설정합니다. 

 

 [15] Ancillary/Audio >  

Analog IN > Gain 

• -36에서 12dB 사이의 범위로 입력할 수 있습니다. 

 

⑧  다음 메뉴 조작으로 지연 시간을 설정합니다. 

 [15] Ancillary/Audio >  

Analog IN > Delay (ms) 
 

• 0에서 512ms 사이의 범위로 입력할 수 있습니다. 

 

 

 

 

  A부터 Z까지, A부터 Z까지, 0부터 9까지, 공백, 
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 출력 신호 설정  

사용 가능한 출력은 다음과 같습니다. 

 

<출력 (공통)> 

논리 출력 이름 물리적 출력 이름 제한 

OUT1 SDI OUT1  

OUT2 SDI OUT2  

OUT3 HDMI OUT  

OUT4 LAN SRT/RTMP/NDI 

OUT5 LAN SRT/RTMP/NDI 

OUT6 USB STREAM OUT UVC 고정 할당 

 

출력 신호 설정을 진행하기 전에 먼저 출력 하위 메뉴를 사용하여 설정할 출력 신호를 선택합니다. 

 

 [11] Output >  

OUT4 > Streaming Mode 
 

 [11] Output >  

OUT5 > Streaming Mode 

 

<출력 신호별 설정 목록> 

 

 

출력 커넥터 

이 설명서의 설정 메뉴 및 페이지 

Assign SDI Output 
HDMI 

Output 

Down 

Converter 
Scale 

SRT 

Output 
NDI Output 

RTMP 

Output 

UVC 

Output 

P80 – P80 – P80 P81 P82 P84 P84 

SDI OUT 1   – – – – – – – 

SDI OUT 2   – – – – – – – 

HDMI OUT  –  –  – – – – 

IP(OUT4)  – – – –    – 

IP(OUT5)  – – – –    – 

UVC OUT  – – – – – – –  

✓ : 설정 가능 

- : 설정 불가 
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출력  신호  할당하기  

 
출력 신호를 각 출력에 할당합니다. 

 

다음 메뉴 조작으로 출력 신호 유형을 설정합니다. 

 [11] Output >  

OUTx > Assign 
 

 

PGM 와이퍼, 믹스, 키, 다운스트림 키 또는 기타 효과가 적용된 
상태로 스위치의 메인 최종 영상이 출력됩니다. 

PVW 다음 작업을 실행하기 전에 확인할 수 있는 미리 보기 
출력입니다. 

CLN 클린 신호(키, 다운스트림 키 또는 기타 효과가 PGM 
신호에서 제거되었을 때 생성되는 영상)가 출력됩니다. 

AUX1, AUX2 AUX 버스의 2개 라인(AUX1, AUX2)에서 선택한 신호가 
출력됩니다. 

MV 멀티 뷰 디스플레이 신호가 출력됩니다. 여러 입력 
신호와 출력 신호의 크기가 줄어들고 하나의 화면으로 
출력됩니다. 

KeyOut 키 신호가 출력됩니다. 
 

 HDMI  출력  신호  설정  

HDMI 출력 신호를 설정합니다. 

①  다음 메뉴 조작으로 출력 신호 유형을 설정합니다. 

 [11] Output >  

OUT3 > Assign 
 

 "출력 신호 할당"을 참조하십시오. 

②  다음 메뉴 조작으로 출력할 비디오의 해상도를 선택합니다. 

 [11] Output >  

OUT3 > Size 
 

Auto 출력 대상의 장비 정보는 HDMI 신호에 의해 캡처되고 
이미지는 최적의 해상도로 출력됩니다. 

XGA (1024 × 768) / 60Hz 

WXGA (1280 × 768) / 60 Hz 

SXGA (1280 × 1024) / 60Hz 

WXGA+ (1680 × 1050) / 60Hz 

Native 시스템 형식과 동일한 형식이 출력됩니다. 

 

 

 

 

 

 

 

③  다음 메뉴 조작으로 출력 색 공간을 설정합니다. 
 

Auto 연결 대상에 대한 장치 정보는 HDMI 신호를 통해 
얻어지며 출력은 그에 따라 최적의 색 공간을 
사용합니다. 

RGB 색 공간은 RGB 형식으로 설정됩니다. 

YUV444 색 공간은 Y, Cb, Cr을 4:4:4로 설정합니다. 

(이 방법을 사용하면 4개의 수평 픽셀에 대해 각각 4개의 

픽셀이 휘도 성분과 2개의 색차 성분을 샘플링합니다.) 

YUV422 색 공간은 Y, Cb, Cr을 4:2:2로 설정합니다. 

(이 방법으로, 2개의 수평 픽셀 각각에 대해, 각각 1개의 

픽셀이 색차 성분의 샘플링되고, 각각의 픽셀이 휘도 

성분의 샘플링됨) 

 

④  다음 메뉴 조작으로 스케일링 모드를 선택합니다. 

 [11] Output >  

OUT3 > Scale 
 

 

Fit-V 출력된 영상의 종횡비는 유지되며, 수직 해상도에 따라 

영상의 크기가 증가하거나 감소합니다. 

(이미지가 없는 부분에는 검은색 띠를 삽입합니다. 

이미지의 돌출된 부분은 잘라냅니다.) 

Fit-H 출력 영상의 종횡비는 유지되고 수평 해상도에 따라 

영상의 크기가 증가하거나 감소합니다. 

(이미지가 없는 부분에는 검은색 띠를 삽입합니다. 

이미지의 돌출된 부분은 잘라냅니다.) 

Full 출력 이미지의 크기는 시스템 해상도에 따라 
증가하거나 축소됩니다. 

Full80% 출력 이미지의 크기는 시스템 해상도의 80% 크기에 따라 
증가하거나 축소됩니다. 

Full90% 출력 이미지의 크기는 시스템 해상도의 90% 크기에 따라 
증가하거나 축소됩니다. 

• 가로 세로 비율은 전체, 전체 80% 또는 전체 90% 설정에서 
유지되지 않습니다. 
영상 크기가 수직 방향과 수평 방향으로 증가 또는 감소하는 
비율이 다릅니다. 

 

⑤  다음 메뉴 조작으로 이미지 모션 감지 감도를 설정하십시오. 

 [11] Output >  

OUT3 > Move Detect 
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 SRT 출력  신호  설정  

이 장치는 최대 2개의 SRT 신호를 출력할 수 있습니다.  

SRT 출력 신호를 할당합니다. 

①  다음 메뉴 조작으로 출력 신호 유형을 설정합니다. 

 [11] Output >  

OUTx > Assign 
 

 "출력 신호 할당"을 참조하십시오. 

⑨  2 다음 메뉴 조작으로 연결 모드를 설정합니다.  

 [11] Output >  

OUTx > Mode 
 

 

⑩  다음 메뉴 조작으로 URL, 포트 및 스트림 ID를 설정합니다 
(Caller만 해당). 
 

 [11] Output >  

OUTx > Destination URL 
 

 [11] Output >  

OUTx > Destination Port 
 

 [11] Output >  

OUTx > Stream ID 

 

 

• 연결된 서버의 도메인 이름을 확인하려면 DNS 설정이 
필요합니다. 

• 도착 URL은 1자에서 254자 사이로 설정할 수 있습니다. 

<대상 URL에 사용할 수 있는 문자입니다> 
 

 
• 스트림 ID는 최대 512자까지 설정할 수 있습니다. 

<스트림 ID에 사용할 수 있는 문자입니다> 
 

 
⑪  다음 메뉴 조작으로 대기 포트를 설정합니다( Listener만 해당). 

 [11] Output >  

OUTx > Port 

• 사용할 수 없는 포트 중 하나를 선택하면 메시지가 표시됩니다. 

 

⑤  다음 메뉴 조작으로 TTL/HOP 제한을 설정합니다. 

 [11] Output >  

OUTx > TTL/HOP limit 
 

⑥  다음 메뉴 조작을 사용하여 이미지가 전송되는 시점과 수신 
장치에서 재생되는 시점 사이의 시간을 설정합니다. 

 [11] Output >  

OUTx > Latency(ms) 
 

• 네트워크 대역폭에 따라 설정 시간이 보장되지 않을 수 
있습니다. 

⑦  다음 메뉴 조작으로 전송할 이미지의 암호화 모드를 설정합니다. 

 [11] Output >  

OUTx > Encryption 
 

Disable 이미지는 암호화 없이 전송됩니다. 

AES128 이미지는 AES-128 암호화로 전송됩니다. 

AES256 이미지는 AES-256 암호화로 전송됩니다. 

 

⑧  다음 메뉴 조작으로 암호화된 이미지를 디코딩하기 위한 문구를 
설정합니다. 

 [11] Output >  

OUTx > Passphrase 
 

• 10자에서 79자 사이로 설정할 수 있습니다. 

⑫  다음 메뉴 조작으로 이미지 형식으로 H.264 또는 H.265를 
선택합니다. 

 [11] Output >  

OUTx > Codec 
 

⑬  다음 메뉴 조작으로 이미지 형식에 대한 비트 전송률 제어 
모드를 설정합니다.  

 [11] Output >  

OUTx > Rate Control Mode 
 

CBR 전송은 목표 비트 전송률에 설정된 비트 전송률로 
이루어집니다. 

VBR 최대 비트 레이트로 설정된 비트 레이트를 최대로 하여 

Target 비트 레이트로 설정된 비트 레이트에 접근하도록 

전송이 이루어집니다. 실제 비트 속도는 전송되는 

비디오에 따라 다릅니다. 

 

⑭  다음 메뉴 조작으로 전송을 위한 목표 비트 전송률을 설정합니다.  

 [11] Output >  

OUTx > Target bit rate 

 

⑮  다음 메뉴 조작으로 전송을 위한 최대 비트 전송률을 
설정합니다(VBR만 해당). 

 [11] Output >  

OUTx > Max bit rate 

Caller 이 장치에서 전송 시작 요청을 보낼 전송 대상의 서버 
URL 및 포트 번호를 지정할 때 지정합니다. 

Listener 외부에서 전송을 시작할 때 대기 포트를 지정할 때 
지정합니다. 

Destination URL 연결된 서버의 URL 
Destination Port 연결된 서버의 포트 
Stream ID 연결된 서버의 스트림 ID 

A부터 Z까지, A부터 Z까지, 0부터 9까지, -, . 

A부터 Z까지, A부터 Z까지, 0부터 9까지, 공백, 

! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > / 
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제작 : ㈜디브이네스트 1544-5596 

 

 NDI  출력  신호  설정  

이 장치는 최대 2개의 NDI 신호를 출력할 수 있습니다. 

NDI|HX 출력은 불가능합니다. 

NDI 신호의 경우, 각 NDI 출력에 대해 High Bandwidth 

1개의 출력과 Low Bandwidth 1개의 출력이 일정하게 

있습니다. 

 

 NDI  |  HX 

이 장치는 Full NDI 신호만 출력할 수 있으며 NDI | HX 버전1/2 

출력을 지원하지 않습니다. 

 

 NDI  출력  신호  할당  

NDI 출력 신호를 할당합니다. 

 

다음 메뉴 조작으로 출력 신호 유형을 설정합니다. 

 [11] Output >  

OUTx > Assign 
 

 "출력 신호 할당"을 참조하십시오. 

 

 일반  NDI  출력  신호  설정  
 

이 장치에서는 NDI 수신기에서 검색할 때 표시되는 Machine Name 
및 Source Name을 문자열로 설정할 수 있습니다. 

①  다음 메뉴 조작으로 NDI 수신기에 표시할 이름을 설정합니다. 

 [11] Output >  

OUTx > Machine Name 
 

• 최대 20자의 문자열을 입력할 수 있습니다. 

16  다음 메뉴 조작으로 NDI 수신기에 표시할 이름을 설정합니다. 

 [11] Output >  

OUTx > Source Name 
 

• 최대 32자의 문자열을 입력할 수 있습니다. 

<파일 이름에 사용할 수 있는 문자> 

 

 

 

 

 

 

 

 

 

 NDI  전송  프로토콜  설정  

NDI 수신기와 함께 사용할 프로토콜을 설정합니다. 

①  다음 메뉴 조작으로 NDI 수신기와 함께 사용할 프로토콜을 
설정합니다. 

 [11] Output >  

OUTx > Protocol 
 

TCP  TCP는 NDI 수신기와 함께 사용할 프로토콜로 

설정됩니다. (기본값) 
sTCP를 사용한 통신을 허용합니다. 

UDP UDP는 NDI 수신기와 함께 사용할 프로토콜로 

설정됩니다. 
UDP 및 sTCP를 사용한 통신을 허용합니다. 

• 우수한 프로토콜은 NDI 전송 측의 프로토콜 설정과의 협상을 
통해 선택됩니다. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

A부터 Z까지, a부터 z까지, 0부터 9까지, 공백, -, _ 

노트 

sTCP(single TCP): 데이터의 정확한 전달을 보장하지만 UDP에 

비해 통신 속도가 느린 연결 중심의 통신 방식입니다. 

UDP: 고속 데이터 전송을 가능하게 하는 비연결형 통신 

방식이지만 해당 데이터의 신뢰성은 TCP보다 낮습니다. 

멀티캐스트 전송을 수행할 때 프로토콜을 UDP로 고정할 필요가 

있습니다. 
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입력 / 출력 신호 설정  

 

 

NDI  멀티캐스트  설정  

NDI 수신기에 대한 멀티캐스트 전송을 활성화 또는 비활성화할지 

여부를 설정합니다. 

멀티캐스트 전송을 활성화하려면 IP 주소, 서브넷 마스크 및 

TTL/HOP 제한에 대한 설정에 따라 전송이 이루어집니다. 

이 장치를 사용하면 동일한 서브넷 내에서 멀티캐스트 전송을 수행할 

수 있습니다. 

①  다음 메뉴 조작으로 멀티캐스트 전송에 대한 활성화 또는 
비활성화를 설정합니다. 
 

 [11] Output >  

OUTx > Multicast > Multicast 
 

Enable NDI 수신기로의 멀티캐스트 전송이 활성화됩니다. 

Disable NDI 수신기에 대한 멀티캐스트 전송이 비활성화됩니다. 
(기본값) 

 

17  다음 메뉴 조작으로 IP 주소, 서브넷 마스크 및 TTL을 
설정합니다.  

 [11] Output >  

OUTx > Multicast > IP Address 
 

 [11] Output >  

OUTx > Multicast > Subnet Mask 
 

 [11] Output >  

OUTx > Multicast > TTL/HOP Limit 
 

 NDI  그룹  설정  
 

NDI 발신자와 수신자를 각각 속한 그룹으로 설정하면 기계 검색을 
수행할 때 검색할 그룹을 지정할 수 있습니다. 
여러 그룹을 쉼표로 구분하여 지정할 수 있습니다. 

①  다음 메뉴 조작으로 그룹 검색 기능에 대한 활성화 또는 
비활성화를 설정합니다. 

 [11] Output >  

OUTx > Group > Group 
 

Enable 그룹 검색 기능이 활성화 됩니다. 
Disable 그룹 검색 기능이 비활성화 됩니다. (기본값) 

 

②  다음 메뉴 조작으로 그룹 이름을 입력합니다. 

 [11] Output >  

OUTx > Group > Group Name 
 

• 최대 64자의 문자열을 입력할 수 있습니다. 

<파일 이름에 사용할 수 있는 문자> 

 

디스커버리  서버  (D iscovery Server )  설정  

NDI 소스를 자동으로 검색하여 외부 서버에 중앙 등록할 수 있는 

기능을 설정할 수 있습니다. 

이 설정을 활성화하는 것은 네트워크에 많은 양의 NDI 소스가 있고 

트래픽 증가를 피하는 것이 바람직하거나 멀티캐스트 전송이 

불가능하거나 바람직하지 않을 때 효과적입니다. 

 

②  다음 메뉴 조작으로 외부 서버를 설정할지 여부를 선택합니다.  

 [11] Output >  

OUTx > Use Discovery server >  

Use Discovery server 
 

Enable 외부 서버 설정을 사용할 수 있습니다. 
Disable 외부 서버 설정을 사용할 수 없습니다. (기본값) 

 

18  다음 메뉴 조작으로 외부 서버의 IP 주소를 입력합니다. 

 [11] Output >  

OUTx > Use Discovery server >  

Use Discovery IP 
 

 

 

  

A부터 Z까지, A부터 Z까지, 0부터 9까지, 공백, 

! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > / 



84 

 

 
 

제작 : ㈜디브이네스트 1544-5596 

 

 RTMP 출력  신호  설정  

이 장치는 최대 2개의 RTMP 신호를 출력할 수 있습니다. 

RTMP 출력 신호를 할당합니다. 

①  다음 메뉴 조작으로 출력 신호 유형을 설정합니다. 

 [11] Output >  

OUTx > Assign 
 

 "출력 신호 할당"을 참조하십시오. 

②  다음 메뉴 조작으로 서버의 URL과 Stream Key를 설정합니다. 

 [11] Output >  

OUTx > Server URL 

 

 [11] Output >  

OUTx > Stream Key 

 

 

• 연결된 서버의 도메인 이름을 확인하려면 DNS 설정이 
필요합니다. 

• 서버 URL은 1자에서 254자 사이로 설정할 수 있습니다. 

• 스트림 키는 최대 512자까지 설정할 수 있습니다. 

<파일 이름에 사용할 수 있는 문자> 

 
 

③  다음 메뉴 조작으로 이미지 형식에 대한 비트 전송률 제어 모드를 
설정합니다. 

 [11] Output >  

OUTx > Rate Control Mode 

 
CBR기 전송은 목표 비트 전송률에 설정된 비트 전송률로 

이루어집니다. 
VBR 최대 비트 레이트로 설정된 비트 레이트를 최대로 하여 

Target 비트 레이트로 설정된 비트 레이트에 접근하도록 

전송이 이루어집니다. 실제 비트 속도는 전송되는 

비디오에 따라 다릅니다. 

 

④  다음 메뉴 조작으로 전송을 위한 목표 비트 전송률을 설정합니다. 

 [11] Output >  

OUTx > Target bit rate 

 

⑤  다음 메뉴 조작으로 전송을 위한 최대 비트 전송률을 
설정합니다(VBR만 해당). 

 [11] Output >  

OUTx > Max bit rate 

 

 UVC 출력  신호  설정  

본 기기는 UVC(USB 비디오 클래스) 및 UAC(USB 오디오 클래스) 

출력을 지원합니다. 

USB 커넥터(Type-C 커넥터)를 컴퓨터에 연결하면 본 기기를 웹 

카메라처럼 사용할 수 있습니다. 

본 기기와 컴퓨터 간의 연결을 위해 USB3.0을 지원하는 USB 

케이블을 사용하십시오. 

 

UVC 출력 신호를 할당합니다. 

①  다음 메뉴 조작으로 출력 신호 유형을 설정합니다. 

 [11] Output >  

OUTx > Assign 

 "출력 신호 할당"을 참조하십시오. 

 

②  다음 메뉴 조작으로 출력 신호 해상도를 설정합니다. 

 [11] Output >  

Mode 
 

Normal 1080 해상도로 출력합니다. 
720p 720 해상도로 출력합니다. 

• 시스템 형식이 720/59.94p 또는 50p인 경우 이 항목은 
회색으로 표시되고 출력은 720입니다. 

 

 

 
 

 

  

서버 URL 연결된 서버의 URL 
스트림 키 연결된 서버의 스트림 키 

A부터 Z까지, A부터 Z까지, 0부터 9까지, 공백, 

! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > / 

메모 

시스템 형식 설정을 변경하여 출력 형식이 변경된 경우 컴퓨터에서 

UVC 이미지를 수신하는 앱을 다시 시작해야 합니다. 
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 아날로그  오디오  출력  설정  

이 장치에는 1개의 헤드폰 커넥터 [  ](Φ3.5mm, 스테레오)가 
있습니다. 
미니 잭). 

 

아날로그 출력 신호를 할당합니다. 

①  다음 메뉴 조작으로 출력 신호 유형을 설정합니다. 

 [15] Ancillary/Audio >  

Analog OUT > Assign 
 

PGM 선택한 소스의 오디오 데이터를 출력합니다. 
PVW 
AUX1, 2 
CLN 

 

②  모니터 볼륨 다이얼로 볼륨을 조정합니다. 값은 다음 메뉴에서 볼 
수 있습니다. 

 [15] Ancillary/Audio >  

Analog OUT > Volume 
 

③  아날로그 오디오 출력은 모니터 볼륨 조정에 관계없이 음소거 할 
수 있습니다. 

다음 메뉴로 설정합니다. 

 [15] Ancillary/Audio >  

Analog OUT > Mute 
 

Off 오디오 출력이 음소거되지 않습니다. 

On 오디오 출력이 음소거 됩니다.  

③  로 설정된 볼륨 값은 변경되지 않습니다. 
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제작 : ㈜디브이네스트 1544-5596 

 

 SRT/RTMP 신호에  대한  전송  작업  

SRT/RTMP 신호에 대한 시작 및 중지 작업은 [STREAM] 버튼으로 수행됩니다. 

 

 
 

Off 전원을 켤 때의 초기 설정입니다. 신호는 전송되지 않습니다. 
[STREAM] 버튼이 꺼져 있습니다. 

Stand by 이 모드에 설정된 이미지가 전송됩니다. [STREAM] 버튼이 
녹색으로 켜집니다. 

On Air 이 모드에 설정된 이미지가 전송됩니다. [STREAM] 버튼이 
빨간색으로 켜집니다. 

 

[SHIFT] 버튼을 눌러 작업 대상을 변경합니다. 
 

[SHIFT]를 누르지 않음 IP 출력1 
[SHIFT]를 누름 IP 출력2 

 

IP OUT1/2의 상태는 다음 메뉴 조작으로 연결할 수 있습니다. 

 [11] Output > 

OUTx > Streaming Link 

 

또한 다음 메뉴 조작으로 SRT/RTMP 출력 중에 대기에 대한 이미지 

신호를 할당할 수 있습니다. 

 [11] Output > 

OUTx > Assign STDBY 
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입력 / 출력 신호 설정  

 

 동기 신호 설정  
 

시스템에서 사용할 동기 신호를 선택할 수 있습니다. 

외부 동기화 (External sync): 

외부 동기 신호(gen-lock)와 동기화합니다. 

기준 입력 신호는 루프를 통해 출력됩니다. 
 

BB 블랙 버스트 신호(0H의 수직 위상) 
Tri-level sync 트라이 레벨 동기 신호(0H의 수직 위상) 

Internal 내부 참조 신호(INT)와 동기화합니다. 
REFOUT 신호(블랙 버스트 신호)는 두 개의 레퍼런스 
단자에서 출력됩니다. 

• 이 단위는 시스템 형식과 동일한 필드 주파수에 대한 동기화 신호를 지원합니다. 

 

①  다음 메뉴 조작으로 동기화 신호를 선택하고 OSD/TIME 다이얼을 눌러 선택한 콘텐츠를 확인합니다. 

 [13] System >  

Reference > Sync Select 
 

19  젠록 상태는 다음 메뉴에 표시됩니다. 

 [13] System >  

Reference > Status 
 

Locked 외부 동기 신호 또는 내부 기준 신호와 동기화됩니다. 

UnLock 외부 동기 신호 또는 내부 기준 신호와 동기화되지 
않습니다. 
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 출력 신호 위상 조정  
 

출력 비디오 신호의 위상을 조정할 수 있습니다. 

①  다음 메뉴 조작으로 "0H" 또는 "1H"를 선택합니다. 

 [13] System >  

Output Phase > System 
 

 

0H 출력 비디오 신호는 동위상을 사용하여 시스템 기준 
신호로 출력됩니다. 프레임 싱크로나이저 기능은 모든 
입력 신호에 대해 ON 상태입니다. 

1H 출력 비디오 신호는 1H 지연으로 시스템 기준 신호로 

출력됩니다. 

프레임 싱크로나이저 기능이 ON일 때 출력 비디오 

신호는 다음과 같이 출력됩니다. 
1 프레임 + 1H 지연. 

 

20  다음 메뉴 조작으로 H 위상을 조정합니다. 

 [13] System >  

Output Phase > H-Phase 
 

H-Phase는 -0.50H ~ +0.49H 범위 내에서 조정할 수 있습니다. 

• 메뉴에 표시되는 설정은 시스템 형식에 따라 다릅니다. 

 

21  다음 메뉴 조작으로 V 위상을 조정합니다. 

 [13] System >  

Output Phase > V-Phase 
 

V-Phase는 -100H ~ +100H범위 내에서 조정할 수 있습니다. 

  



89 

입력 / 출력 신호 설정  

 

 AUX 버스, PGM 및 PVW에 대한 보조 설정  
 

SDI/HDMI 입력 신호의 V 보조 데이터 및 임베디드 오디오 데이터를 
통과하는 기능을 설정합니다. 

 
 

 

①  다음 메뉴 조작으로 On/Off를 선택합니다. 

 [15] Ancillary/Audio >  

Ancillary > AUX 
 

 

 

②  다음 메뉴 조작으로 On/Off를 선택합니다. 

 [15] Ancillary/Audio >  

Ancillary > PGM 
 

Off PGM 출력의 보조 데이터 및 임베디드 오디오는 
전달되지 않습니다. 

On PGM 출력의 보조 데이터 및 임베디드 오디오는 
통과됩니다. 

 

 

 

③  다음 메뉴 조작으로 On/Off를 선택합니다. 

 [15] Ancillary/Audio >  

Ancillary > PVW 
 

Off PVW 출력의 보조 데이터 및 임베디드 오디오는 
전달되지 않습니다. 

On PVW 출력의 보조 데이터 및 임베디드 오디오는 
통과됩니다. 

 

 

 

 

 

 

 

 

 

 

 

 

④  다음 메뉴 조작으로 On/Off를 선택합니다. 

 [15] Ancillary/Audio >  

Ancillary > CLN 
 

 

 

⑤  다음 메뉴 조작으로 PGM/PVW/Off를 선택합니다. 

 

 [15] Ancillary/Audio >  

Ancillary > MV 
 

PGM PGM의 보조 데이터 및 임베디드 오디오는 모든 MV 
출력으로 전달됩니다. 

PVW PVW의 보조 데이터 및 임베디드 오디오는 모든 MV 
출력으로 전달됩니다. 

Off 보조 데이터 및 임베디드 오디오는 MV 출력을 통해 
전달되지 않습니다. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Off AUX 버스(AUX1, AUX2) 출력의 보조 데이터 및 
임베디드 오디오는 전달되지 않습니다. 

On AUX 버스(AUX1, AUX2) 출력의 보조 데이터 및 
임베디드 오디오가 통과됩니다. 

Off CLN 출력의 보조 데이터 및 임베디드 오디오는 전달되지 
않습니다. 

On CLN 출력의 보조 데이터 및 임베디드 오디오는 
통과됩니다. 

노트 

키가 결합되면 해당 오디오도 중첩됩니다. 

입력 신호의 형식이 시스템 형식과 다른 경우 VANC 데이터가 

전달되지 않습니다. 

사전view 출력 신호 설정 

AUX 버스(AUX1, AUX2)의 출력 신호 설정 

클린 출력 신호를 위한 설정 

멀티 뷰 디스플레이의 출력 신호 설정 

프로그램 출력 신호 설정 
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 AUX 버스, PGM 및 PVW에 대한 오디오 설정  

각 입력 신호에 대해 하나의 오디오 데이터를 선택하고 각 출력 신호의 통과 기능을 설정합니다. 

각 출력 신호에 대해 다음에서 1개의 입력 신호만 선택할 수 있습니다. 
 

IN1 ~ 9 각 입력 신호에 포함된 오디오는 통과(Pass through)됩니다. 

Analog 오디오 입력 커넥터의 오디오 데이터가 전달됩니다. 

Follow Video 버스에 의해 선택된 입력 신호에 내장된 오디오는 통과됩니다. 

OFF 포함된 오디오는 전달되지 않습니다. 

이 기능을 활성화하려면 각 버스에 대한 보조 설정을 켜야 합니다. 

 

①  다음 메뉴 조작으로 오디오 데이터를 통과할 입력 신호를 설정합니다. 

 [15] Ancillary/Audio >  

Audio Assign > AUX1 
 

 [15] Ancillary/Audio >  

Audio Assign > AUX2 
 

 

②  다음 메뉴 조작으로 오디오 데이터를 통과할 입력 신호를 설정합니다. 

 [15] Ancillary/Audio >  

Audio Assign > PGM 
 

 

③  다음 메뉴 조작으로 오디오 데이터를 통과할 입력 신호를 설정합니다. 

 [15] Ancillary/Audio >  

Audio Assign > PVW 
 

 

④  다음 메뉴 조작으로 오디오 데이터를 통과할 입력 신호를 설정합니다. 

 [15] Ancillary/Audio >  

Audio Assign > CLN 
 

  

AUX 버스(AUX1, AUX2)의 출력 신호에 대한 오디오 설정 

프로그램 출력 신호에 대한 오디오 설정 

프리뷰 (preview) 출력 신호에 대한 오디오 설정 

깨끗한 출력 신호를 위한 오디오 설정 
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멀티뷰 디스플레이 설정  

 

멀티뷰 디스플레이 설정 
 

 화면  레이아웃  설정  

 
화면 레이아웃에 대해 다음 10가지 패턴 중 하나를 선택할 수 있습니다.  

이 장치의 멀티 뷰 디스플레이는 MV를 지원합니다. 
 

4Split 5-aSplit 5-bSplit 6-aSplit 6-bSplit 
9Split 10-aSplit 10-bSplit 12Split 16Split 

 

다음 신호의 표시는 서브 스크린 1에서 16까지 할당할 수 있습니다. 
 

 

*1 IP OUT1(OUT4) 또는 IP OUT2(OUT5)가 SRT 또는 RTMP로 설정된 경우 상태가 표시됩니다. 

이미지 인코딩과 달리 표시된 비트 전송률은 표시 간격의 우선 순위로 계산됩니다. 즉, 출력 설정에 다른 값이 있는 경우가 있습니다. 

 

①  다음 메뉴 조작으로 분할 표시 모드를 설정합니다. 

 [9] MultiView >  

Split 
 

②  다음 메뉴 조작으로 분할 화면의 크기 모드를 설정합니다. 

 [9] MultiView >  

Size 
 

Fit 분할 프레임과 분할 화면의 크기는 동일합니다. 

SQ 분할 프레임과 분할 화면의 크기는 더 작아지고 소스 이름, 레벨 미터 등은 분할 화면 외부에 표시됩니다. 

 

③  다음 메뉴 조작으로 하위 화면(1 - 16)에 표시할 신호 이름을 설정합니다. 

 [9] MultiView >  

Source Select 
 

• 입력 신호(IN1 - 9)를 선택하면 문자와 기호에 따라 다음 메뉴에서 설정한 소스명의 표시가 달라집니다. 

 [10] Input >  

Inx > Name Type 
 

 [10] Input >  

Inx > Name 
 

• AUX 버스(AUX1, AUX2)를 입력 신호로 선택하면 [ ] 안에 표시되는 소스명은 문자와 기호에 따라 다릅니다. 

• "MV"가 선택된 AUX 버스가 멀티뷰 디스플레이의 서브 화면에 표시되면 두 개의 거울이 서로 마주보고 있는 것처럼 이미지가 반복됩니다. 

• 720p의 경우 12분할 프레임을 선택할 수 없습니다. 

  

할당할 수 있는 신호 

IN1 to 9, Black, CBGD1, CBGD2, CBAR, Still1V, Still1K, Still2V, Still2K, PGM, PVW, CLN, Key Out, AUX1, AUX2, Clock, Analog IN, IP 

OUT1, IP OUT2*1 
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<디스플레이 모드> 
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멀티뷰 디스플레이 설정  

 

 

분할  프레임과  문자  설정  

 
분할 화면의 프레임, 문자 밝기 및 배경을 멀티 뷰 디스플레이에 

표시하도록 설정합니다. 

 

①  분할 프레임의 밝기와 분할 프레임의 표시를 다음 메뉴 
조작으로 설정합니다. 

 [9] MultiView >  

MV Frame 
 

LUM0%, 
LUM25%, 
LUM50%, 
LUM75%, 
LUM100% 

분할 프레임(그레이 스케일)의 밝기에 대해 다음 설정 중 

하나를 선택합니다. 

Off 분할 프레임이 표시되지 않습니다. 

 

②  다음 메뉴 조작으로 문자의 밝기와 문자 표시를 설정합니다. 

 [9] MultiView >  

MV Chracter 
 

LUM0%, 
LUM25%, 
LUM50%, 
LUM75%, 
LUM100% 

문자(그레이 스케일) 밝기 설정 중 하나를 선택합니다. 

Off 문자가 표시되지 않습니다. 
캐릭터 배경도 표시되지 않습니다. 

 

③  다음 메뉴 조작으로 문자 배경(하프톤) 표시를 설정합니다.  

 [9] MultiView >  

MV Label 

 

• Fir mode가 켜져 있을 때 활성화됩니다. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 탈리 (Tal ly )  표시  설정  

 
탈리 디스플레이가 멀티뷰 디스플레이의 분할 프레임에 

겹쳐지도록 설정합니다. 

이 유닛에는 2개의 탈리 그룹을 설정할 수 있으며 각 그룹에 

대해 소스를 설정할 수 있습니다. 

빨간색 탤리와 녹색 탤리는 멀티 뷰 디스플레이에 표시될 수 

있습니다. 

 

①  다음 메뉴 조작으로 빨간색 탤리와 초록색 탤리에 할당할 
소스를 선택합니다. 

 [13] System >  

Tally Settings > Tally Target > Red Tally 
 

 [13] System >  

Tally Settings > Tally Target > Green Tally 
 

Off 신호 없음 
PGM 비디오 신호 프로그래밍 
PVW 비디오 신호 미리보기 
CLN 클린 시그널 
KeyOut 키 출력 신호 
AUX1 AUX1 버스 출력 신호 
AUX2 AUX2 버스 출력 신호 
IP OUT1 IP OUT1 출력 신호 
IPOUT2 IP OUT2 출력 신호 

 

②  다음 메뉴를 표시합니다. 
 

 [9] MultiView >  

Red Tally 
 

 [9] MultiView >  

Green Tally 
 

• 위의 ①에서 설정한 빨간색 탈리와 녹색 탈리를 Multi View 
디스플레이에 표시하도록 설정할 수 있습니다. 

 

③  탈리 디스플레이가 멀티 뷰 디스플레이의 분할 프레임에 
겹쳐지도록 설정합니다. 

 
 

 
  

On 문자 배경이 표시됩니다. 
Off 문자 배경은 표시되지 않습니다. 

On 탈리가 표시됩니다. 
Off 탈리가 표시되지 않습니다.  
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 소스  이름  변경 (입력  신호 )  

 
멀티뷰 디스플레이에서 설정할 입력 신호(IN1 - 9)의 소스명을 

변경할 수 있습니다. 

이러한 이름은 기본 설정 또는 사용자 설정에서 선택할 수 

있습니다. 

 

①  다음 메뉴 조작으로 소스 이름 유형을 선택합니다.  

 [10] Input >  

Inx > Name Type 

 

 
 

①  다음 메뉴 조작으로 소스 이름 유형을 "사용자"로 설정합니다. 

 [10] Input >  

Inx > Name Type 

 

②  다음 메뉴 조작으로 소스 이름을 입력합니다. 

 [10] Input >  

Inx > Name 

<파일 이름에 사용할 수 있는 문자> 

 
 

소스  이름  변경 (출력  신호 )   

 
멀티뷰 디스플레이에서 설정할 출력 신호(AUX1, AUX2)의 소스명을 
변경할 수 있습니다. 

이러한 이름은 기본 설정 또는 사용자 설정에서 선택할 수 있습니다. 

 

다음 메뉴 조작으로 AUX1 및 AUX2의 소스 이름 유형을 선택합니다. 

 [12] Config >  

AUX Name > AUX1 Type 
 

 [12] Config >  

AUX Name > AUX2 Type 
 

Default 

(default settings) 

다음 소스 이름이 자동으로 선택됩니다. 
AUX1, AUX2 

User 

(user settings) 

소스 이름은 최대 32자까지 설정할 수 
있습니다. 

 

 

①  다음 메뉴 조작으로 소스 이름 유형을 "사용자"로 설정합니다. 

 [12] Config >  

AUX Name > AUX1  Type 
 

 [12] Config >  

AUX Name > AUX2  Type 

②  다음 메뉴 조작으로 소스 이름을 입력합니다. 

<파일 이름에 사용할 수 있는 문자> 

  

 

 레벨  미터  설정  

각 분할 화면에 각 입력 및 출력과 함께 전송되는 오디오 신호의 레벨 

미터를 표시할 수 있습니다. 

Left display : 그룹 1의 채널 1 

Right display : 그룹 2의 채널 1 

 

다음 메뉴 조작으로 레벨 미터 표시를 설정합니다. 

 [9] MultiView >  

Display > Level Meter 
 

OFF 레벨 미터는 표시되지 않습니다. 

IN ON 입력 신호(오디오 입력 커넥터 포함)에 대한 레벨 
미터와 색상 막대가 표시됩니다. 

OUT ON PGM/PVW/CLN/AUX에 대한 레벨 미터가 표시됩니다. 

IN/OUT ON 입력 신호(오디오 입력 커넥터 포함), 색상 막대 및 
PGM/PVW/CLN/AUX에 대한 레벨 미터가 
표시됩니다. 

  

  

Default 

(default settings) 

다음 소스 이름이 자동으로 선택됩니다. 
IN1에서 IN9 

User 
(user settings) 

소스 이름은 최대 32자까지 설정할 수 
있습니다. 

사용자 유형 설정 절차 

A부터 Z까지, A부터 Z까지, 0부터 9까지, 공백, 

! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > / 

A부터 Z까지, A부터 Z까지, 0부터 9까지, 공백, 

! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > / 

사용자 유형 설정 절차 
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멀티뷰 디스플레이 설정  

 

 

입력  신호  표시  설정  

 
입력 신호의 상태를 분할 화면에 표시되는 소스 이름 앞에 표시할 수 
있습니다. 

"F" 표시: 
이것은 입력 신호가 동결(Frozen)될 때 나타납니다. 

" ! " 마크: 
신호가 입력되지 않거나 다른 형식의 신호가 입력될 때 나타납니다. 

• "F" 표시가 표시되면 "!" 표시가 표시되지 않습니다. 

 

다음 메뉴 조작으로 입력 신호 상태 표시를 설정합니다. 
 

 [9] MultiView >  

Display > Input Status 
 

 

On 입력 신호 상태가 표시됩니다. 
Off 입력 신호 상태가 표시되지 않습니다. 

 

 마커  설정   
 

멀티뷰 소스에 대한 안전 마커를 표시할 수 있습니다.  

①  다음 메뉴 조작으로 마커 표시를 설정합니다. 

 [9] MultiView >  

Display > Marker 
 

4:3 마커는 4:3 종횡비를 사용하여 표시됩니다. 

16:9 마커는 16:9 종횡비를 사용하여 표시됩니다. 

Off 마커가 표시되지 않습니다. 

 

②  다음 메뉴 조작으로 마커 크기를 설정합니다. 

 [9] MultiView >  

Display > Maker Size 
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제작 : ㈜디브이네스트 1544-5596 

 

시스템 설정 

 시스템 형식 설정  
 

하나의 시스템 형식(입력/출력 신호)을 선택할 수 있습니다. 다음 메뉴 조작으로 형식을 선택하고 OSD/TIME 다이얼을 눌러 
선택한 콘텐츠를 확인합니다. 

 [13] System >  

System Format 
 

 

 
 

 크로스포인트 설정 
 

 크로스포인트에  신호  할당  

외부 비디오 입력 신호 및 내부에서 생성된 신호는 크로스포인트 

버튼 1 ~ 12에 할당할 수 있습니다. 

크로스포인트 버튼 1에서 12까지의 할당 상태는 크로스포인트 버튼 

1에서 12를 누르고 있는 동안 OSD 메뉴 출력 대상에 표시됩니다. 

크로스포인트 버튼에 의해 선택된 신호의 현재 할당을 

변경하면 켜진 크로스포인트 버튼의 위치가 할당 변경에 따라 

변경됩니다. 이때 출력되는 이미지는 변경되지 않습니다. 

 

아래 표에는 할당할 수 있는 소스가 나열되어 있습니다. 
 

 

신호 

디스플레이에 

나타나는 내용 

 

설명 

IN1에서 IN9 IN1에서 IN9 입력 1 - 9 

고급 신호 할당에 대해서는 "입력 신호 

설정"을 참조하십시오. 

Black Black 내부 생성 신호(검정색) 

CBGD1, 

CBGD2 

CBGD1, 

CBGD2 

내부에서 생성된 신호(색상 배경) 

CBAR CBAR 내부에서 생성된 신호(컬러 바) 

Still1V, 

Still1K, 

Still2V, 

Still2K 

Still1V, 

Still1K, 

Still2V, 

Still2K 

정지 이미지 비디오 메모리 

CLN CLN CLN(AUX 버스 및 내장 디스플레이 

이미지만 해당) 

KeyOut KeyOut KeyOut(AUX 버스 및 내장 디스플레이 

이미지만 해당) 

None None 할당되지 않음 

• "None"이 할당된 버튼을 눌러도 이미지가 변경되지 않습니다. 

 

 

아래 표에는 기본 설정이 나열되어 있습니다. 
 

 

버튼 

디스플레이에 

나타나는 내용 

 

버튼 

디스플레이에 

나타나는 내용 

XPT1 IN1 XPT7 IN7 

XPT2 IN2 XPT8 IN8 

XPT3 IN3 XPT9 IN9 

XPT4 IN4 XPT10 CBAR 

XPT5 IN5 XPT11 CBGD1 

XPT6 IN6 XPT12 CBGD2 

 

 크로스포인트  전환  설정  

크로스포인트가 전환되는 타이밍을 설정할 수 있습니다. 

이 전환에는 크로스포인트 버튼과 [Cut] 버튼의 조작이 

포함됩니다. 

 

다음 메뉴 조작으로 전환 타이밍을 선택하십시오. 

 [8] XPT Assign >  

Switch Timing 
 

Any 크로스포인트는 가장 가까운 필드에서 전환됩니다. 
이는 라이브 애플리케이션에 적합합니다. 

Field1 크로스포인트는 필드 1에서 전환됩니다. 이것은 
편집 응용 프로그램에 적합합니다. 

Field2 크로스포인트는 필드 2에서 전환됩니다. 이것은 
편집 응용 프로그램에 적합합니다. 

 

 

 

다음 작업 중에는 형식을 변경하지 마십시오. 

• 메모리 카드에서 읽거나 USB 메모리에 저장할 때 

• 비디오 메모리에서 데이터를 복원하거나 내부 저장소에 

데이터를 저장하는 경우 

• 동영상 또는 정지 이미지를 촬영할 때 
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시스템 설정  

 

 

 버튼 할당 
 

 사용자  버튼  설정  

 
사용자는 메뉴 항목을 사용하여 설정할 수 있는 여러 기능을 6개의 

사용자 버튼(U1 - U6)에 할당할 수 있습니다. 

사용자 버튼은 할당된 기능이 켜져 있을 때 황색으로 켜지고 할당된 

기능이 꺼져 있을 때 꺼집니다. 

사용자 버튼을 누를 때마다 기능 설정이 ON과 OFF 사이에서 번갈아 

나타납니다. 

 

아래 표에는 사용자 버튼(U1 - U6)에 할당할 수 있는 기능이 

나열되어 있습니다. 
 

함수 이름 기능 설명 

Key1 PVW KEY1 이미지를 미리보기 출력으로 출력합니다. 

Key2 PVW KEY2 이미지를 미리보기 출력으로 출력합니다. 

GPII-EN GPI-In을 활성화하거나 비활성화합니다. 

GPIO-EN GPI-Out을 활성화하거나 비활성화합니다. 

AUX Trans AUX 버스 전환을 활성화하거나 비활성화합니다. 

AUX1 Trans AUX1 버스 전환을 활성화하거나 비활성화합니다. 

AUX2 Trans AUX2 버스 전환을 활성화하거나 비활성화합니다. 

Effect Dissolve ON과 OFF 사이에서 효과 디졸브를 전환합니다. 

Capture Still1 AUX 버스(AUX1, AUX2)의 출력 신호는 Still1에 

소스로 기록됩니다. 

Capture Still2 AUX 버스(AUX1, AUX2)의 출력 신호는 Still2에 

소스로 기록됩니다. 

None 아무 것도 할당되지 않습니다. 

Shot 

Memory 1 - 12 

샷 메모리 1부터 12까지 회상합니다. 

XPT Disable 샷 메모리 XPT 비활성화를 활성화/비활성화합니다. 

 

■ 기본 설정 

 

 

 

 

 

<설정 방법> 

다음 메뉴 조작으로 U1에서 U6 버튼에 할당할 기능을 선택합니다. 
 

 [12] Config >  

User Button > User 1 
 

 [12] Config >  

User Button > User 2 
 

 [12] Config >  

User Button > User 3 
 

 [12] Config >  

User Button > User 4 
 

 [12] Config >  

User Button > User 5 
 

 [12] Config >  

User Button > User 6 
 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

  

버튼 함수 이름 버튼 함수 이름 

U1 Key1 PVW U4 Shot Memory2 

U2 Key2 PVW U5 Shot Memory3 

U3 Shot Memory1 U6 Shot Memory4 



98 

 

 
 

제작 : ㈜디브이네스트 1544-5596 

 날짜 및 시간 설정 

사용자는 USB 메모리의 타임스탬프로 사용할 날짜와 시간을 설정할 수 

있습니다. 

USB 메모리를 사용할 때는 반드시 설정하십시오. 

 

①  날짜/시간 > 날짜 설정 메뉴에서 OSD/TIME 다이얼을 눌러 년, 월, 일 순으로 설정합니다. 
 

 [13] System >  

Date/Time > Date Setting 
 

②  요일 설정 상태에서 OSD/TIME 다이얼을 눌러 년, 월, 일을 확인합니다. 

 

①  날짜/시간 > 시간 설정 메뉴에서 OSD/TIME 다이얼을 눌러 시, 분, 초 순서로 설정합니다. 
 

 [13] System >  

Date/Time > Time Setting 
 

②  초 설정 상태에서 OSD/TIME 다이얼을 눌러 시, 분, 초를 확인합니다. 

  

날짜 설정 

시간 설정 
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시스템 설정  

 

 네트워크 설정 
 

LAN을 통한 소프트웨어 버전 업데이트와 같은 작업을 수행하려면 

네트워크 설정을 진행해야 합니다. 

네트워크 초기 설정은 IP 주소: 192.168.0.8, 서브넷 마스크: 

255.255.255.0입니다. 

초기 설정과 일치하는 설정으로 호스트 컴퓨터를 사용하는 경우 

메뉴를 통해 설정할 필요가 없습니다. 

 

다음 메뉴 조작으로 IP 주소를 설정합니다. 

 [13] Network >  

LAN > IP Address 
 

 

 

다음 메뉴 조작으로 서브넷 마스크를 설정합니다. 

 [13] Network >  

LAN > Subnet Mask 
 

 

 

다음 메뉴 조작으로 기본 게이트웨이를 설정합니다. 

 [13] Network >  

LAN > Default Gateway 
 

 

 

다음 메뉴를 사용하여 MAC 주소를 표시합니다. 

 [13] Network >  

LAN > MAC Address 
 

 

 

다음 메뉴 조작으로 주 DNS 서버와 보조 DNS 서버를 설정합니다. 

 [13] Network >  

Primary DNS > IP Address 
 

 [13] Network >  

Secondary DNS > IP Address 
 

• 이는 SRT 또는 RTMP를 사용한 도메인 이름 확인에 필요합니다. 

• 설정되지 않은 경우 비어 있습니다. 

 

IP 주소 입력 

서브넷 마스크 입력 

기본 게이트웨이 설정 

MAC 주소 표시 

DNS 서버 설정 
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 버튼 조명 설정 

 

버튼 표시기는 항상 켜져 있을 수 있습니다. 이렇게 하면 어두운 

곳에서 장치를 작동할 때도 버튼 근처에 인쇄된 텍스트를 쉽게 볼 수 

있습니다. 

①  다음 메뉴 조작으로 선택한 버튼에 대한 설정을 지정합니다. 

 [12] Config >  

Button Illumination > Button Illumination >  

Lighting 

 

80 % ~ 150 % 버튼 조명이 켜집니다. 밝기는 80%에서 150% 사이에서 
조정할 수 있습니다. 

 

②  다음 메뉴 조작으로 기기가 꺼져 있을 때 버튼을 설정하십시오. 

 [12] Config >  

Button Illumination > Button Illumination >  

XPT Color 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

③  다음 메뉴 작업을 통해 버튼 조명에 대한 [R], [G] 및 [B] 설정을 
수행합니다: 

 [12] Config >  

Button Illumination > Button Color Group1 

 

 [12] Config >  

Button Illumination > Button Color Group2 

 

 [12] Config >  

Button Illumination > Button Color Group3 

 

 [12] Config >  

Button Illumination > Button Color Group4 

 

 [12] Config >  

Button Illumination > Button Color Group5 

 

 [12] Config >  

Button Illumination > Button Color Group6 

 

 [12] Config >  

Button Illumination > Button Color Group7 

 

 [12] Config >  

Button Illumination > Button Color Group8 

 

④  ① 에서 설정할 수 없는 다음 버튼 조명을 다음 메뉴 조작으로 
설정합니다. 

 [12] Config >  

Button Illumination > Button Illumination > 

Dimmer 

 

USER1, USER2, USER3, Shot Memory 버튼, SHIFT 버튼, MENU 
버튼 

 

 

 

  

Input 컬러 그룹 IN, 컬러 그룹 내부, 컬러 그룹 스틸, 컬러 그룹 
기타 소스 각각에 대해 [컬러 그룹1]을 [컬러 그룹8]로 
설정합니다. 

Color Group 1 
- 8 

8 가지 색상을 설정할 수 있습니다. 

On 버튼 조명을 켭니다. 

Off 버튼 조명을 끕니다. 

버튼 조명 
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시스템 설정  

 

 상태 표시 

 

장치의 전원 또는 냉각 팬 문제에 대해 경고하는 알람은 OSD 메뉴 

출력 대상에 표시됩니다. 

다음 메뉴를 표시합니다. 
 

 [13] System >  

Alarm > Power 
 

 [13] System >  

Alarm > Fan 
 

 [13] System >  

Alarm > Temperature 
 

전원 공급 장치의 경고 상태가 전원 항목에 표시됩니다. 

냉각 팬의 경고 상태가 팬 항목에 표시됩니다. 

내부 온도의 경고 상태가 온도 항목에 표시됩니다. 
 

No Alarm 알람 없음 
Alarm 알람 설정됨 

 

알람이 발생하면 OSD 메뉴 출력 대상에 메시지가 표시됩니다. 

이러한 메시지는 OSD 메뉴가 표시되는 경우에만 표시됩니다. 
 

알람 메시지 표시 
문제의 종류 해결방안 

ALARM ! Fan Stop 냉각 팬이 멈춤  

OK를 누르면 알람 

메시지가 지워집니다. 

• 즉시 대리점에 

문의하십시오. 

ALARM ! Power 

Stop 

공급 전압이 낮음 

ALARM ! High 

temperature 

장치 내부의 온도 

상승 

 

장치의 소프트웨어 및 하드웨어에 대한 버전 정보를 표시합니다. 

다음 메뉴를 표시합니다. 

 

 [13] System >  

System Information 
 

• 장치의 시스템 버전 정보가 시스템 버전 항목에 표시됩니다. 

  

알람 상태 표시 

알람 메시지 

버전 정보 표시 



102 

 

 
 

제작 : ㈜디브이네스트 1544-5596 

 초기화 
 

 설정  데이터  초기화  

 
초기화는 설정된 데이터를 공장 출하 상태로 되돌립니다. 

설정 데이터가 초기화되면 비디오 메모리는 삭제되지만 내부 
저장소에 저장된 프로젝트 파일은 삭제되지 않습니다. 

 

<초기화되지 않은 항목 및 데이터> 

• 아래 나열된 메뉴의 항목: 
 

 [13] System >  

Date/Time 
 

 [16] Network 

 

①  다음 메뉴에서 OSD/TIME 다이얼(Execute)을 눌러 
초기화합니다. 

 

 

②  초기화하려면 OSD/TIME 다이얼을 조작하여 "YES"를 누릅니다. 

• 취소하려면 OSD/TIME 다이얼을 조작하여 "NO"를 
누르십시오. 

 

 페이더  초기화  
 

트랜지션을 실행하는 범위는 페이더 레버를 조작하여 초기화할 수 
있습니다. 

페이더 레버를 끝까지 움직인 경우에도 전환이 끝까지 완료되지 
않은 경우 초기화를 수행해야 합니다. 

 

①  다음 메뉴에서 OSD/TIME 다이얼(Execute)을 눌러 
초기화합니다. 

 

 [13] System >  

Initial > Initial Fader 
 

②  초기화하려면 OSD/TIME 다이얼을 조작하여 "YES"를 누릅니다. 

• 취소하려면 OSD/TIME 다이얼을 조작하여 "NO"를 
누르십시오. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 [13] System >  

Initial > Initial Settings 
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원격 카메라 연결 (Remote camera link) 기능 
 

LAN을 통해 최대 9대의 원격 카메라를 본 기기에 연결하고 원격 제어할 수 있습니다. 

연결할 수 있는 원격 카메라 제품과의 호환성은 다음 웹 사이트의 AV-HSW10 페이지를 참조하십시오. https://pro-av.panasonic.net/en/ 

 

■ 연결의 예 

 
 

• 장치와 원격 카메라 간의 연결을 위해 GbE 호환 스위칭 허브와 카테고리 5e 이상의 STP LAN 케이블을 사용하십시오. 

• 또한 장치와 원격 카메라의 IP 주소가 동일한 서브넷 내에 있도록 네트워크 설계를 사용하십시오. 
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본 기기에 연결된 리모트 카메라의 제어 기능은 다음과 같습니다. 

• IP 주소 자동 감지 

• 본 기기의 탈리 상태에 연결된 연결된 원격 카메라를 탈리 제어할 수 있습니다. 

 

 리모트 카메라 연결 설정 
 

리모트  카메라  연결을  위한  단자  선택  
 

다음 메뉴에서 리모트 카메라가 연결된 입력 신호를 선택합니다. 

 

 [10] Input 
 

• IN1에서 9까지의 입력에 따라 다음과 같은 리모트 카메라 설정이 
가능합니다. 

 

 IP 주소  설정  
 

 
연결된 리모트 카메라에 설정된 IP 주소를 스캔하여 본 기기에 

설정할 수 있습니다. 

다음 메뉴 조작으로 연결된 리모트 카메라의 IP 주소를 스캔합니다. 

 [10] Input >  

Inx > Camera Setting > Scan IP Address 

• 스캔 결과가 IP 주소 항목 목록에 표시됩니다. 

 [10] Input >  

Inx > Camera Setting > IP Address 
 

• "Select From List"이 표시되면 OSD/TIME 다이얼을 사용하여 
IP 주소 항목에서 연결된 리모트 카메라의 IP 주소를 
선택합니다. 

• 리모트 카메라의 IP 주소를 감지할 수 없는 경우 "Not 
Detected"이 표시됩니다. 

• 본 장치 또는 리모트 카메라의 IP 주소를 수정하고 중복이 
없도록 설정하십시오. 

• "Duplicate IP Address Detected. (ErrNo = – 650)" 오류 
메시지는 리모트 카메라의 IP 주소가 중복되는 경우 
표시됩니다. 

 

본 기기의 연결된 리모트 카메라에 설정된 IP 주소를 직접 설정할 수 
있습니다. 

 

다음 메뉴 조작으로 연결된 리모트 카메라의 IP 주소를 입력합니다. 

 [10] Input >  

Inx > Camera Setting > Edit IP Address 
 

 

 

 

원격  카메라  포트  설정  
 

다음 메뉴 조작으로 연결된 원격 카메라의 포트를 설정합니다. 

 [10] Input >  

Inx > Camera Setting > Port 
 

 원격  카메라  인증  설정  

①  다음 메뉴 조작으로 연결된 리모트 카메라로 인증하는 데 
사용되는 사용자 이름을 설정합니다. 

 [10] Input >  

Inx > Camera Setting > Edit User Name 
 

②  다음 메뉴 조작으로 연결된 리모트 카메라로 인증하는 데 
사용되는 비밀번호를 설정합니다. 

 [10] Input >  

Inx > Camera Setting > Edit Password 
 

<파일 이름에 사용할 수 있는 문자> 
 

 
 

 

 

 

 

 

 

 

  

자동으로 설정하려면 

수동으로 설정하려면 

A에서 Z까지, A에서 Z까지, 0에서 9까지, 

! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > / 
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리모트  카메라  연결  상태  확인하기  
 

①  리모트 카메라에 설정된 카메라 이름은 다음 메뉴에 표시됩니다. 

 [10] Input >  

Inx > Camera Setting > Name 
 

②  본 장치와 리모트 카메라의 IP 연결 상태는 다음 메뉴에 
표시됩니다. 

 [10] Input >  

Inx > Camera Setting > Network Status 
 

No IP address 입력 메뉴에 카메라의 IP 주소가 입력되지 않았습니다. 

Now Checking… 장치와 원격 카메라가 통신하고 있습니다. 

Connected 장치와 리모트 카메라가 연결되었습니다. 

Unauthorized 인증 정보가 입력되지 않았거나 올바르지 않습니다. 

Not Connected 통신 오류가 있습니다. 

 

 원격  카메라  탈리  제어  설정  
 

본 기기에 연결된 원격 카메라의 빨간색 및 녹색 탈리 컨트롤을 본 
기기의 빨간색 및 녹색 탈리 컨트롤에 연결할 수 있습니다. 

 

①  다음 메뉴 조작을 사용하여 본 장치의 빨간색 탈리 컨트롤과 
리모트 카메라의 빨간색 탈리 컨트롤 사이의 링크를 
설정하십시오. 

 [10] Input >  

Inx > Camera Setting > Red Tally 
 

Enable 연결.됨 
Disable 연결되지 않음 

 

②  다음 메뉴 조작을 사용하여 본 장치의 녹색 탈리 컨트롤과 리모트 
카메라의 녹색 탈리 컨트롤 사이의 링크를 설정합니다. 

③   [10] Input >  

Inx > Camera Setting > Green Tally 
 

Enable 연결.됨 
Disable 연결되지 않음 
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외부 인터페이스 

 GPI I/O 설정 
 

사용자는 GPI 포트에서 제어할 기능을 설정하고 제어 활성화 여부를 

설정할 수 있습니다. 

①  enable(켜기) 및 disable(끄기)을 설정하여 다음 메뉴 조작을 
통해 포트에서 컨트롤을 수행합니다. 

 

④   [12] Config >  

GPI > GPI-In Setting > GPI-In-Enable 
 

⑤   [12] Config >  

GPI > GPI-Out Setting > GPI-Out-Enable 
 

②  다음 메뉴 조작으로 탈리를 알리는 AUX 버스를 설정합니다. 
 

⑥   [12] Config >  

GPI > GPI-In Setting > AUX Sel 
 

⑦   [12] Config >  

GPI > GPI-In Setting > AUX Tly Sel 
 

③  다음 메뉴 조작으로 각 핀 번호에 기능을 할당합니다. 
 

⑧   [12] Config >  

GPI > GPI-In Port > Port1 Assign 
 

⑨   [12] Config >  

GPI > GPI-In Port > Port2 Assign 
 

⑩   [12] Config >  

GPI > GPI-In Port > Port3 Assign 
 

⑪   [12] Config >  

GPI > GPI-In Port > Port4 Assign 
 

⑫   [12] Config >  

GPI > GPI-In Port > Port5 Assign 
 

⑬   [12] Config >  

GPI > GPI-Out Port > Port1 Assign 
 

⑭   [12] Config >  

GPI > GPI-Out Port > Port2 Assign 

 

⑮   [12] Config >  

GPI > GPI-Out Port > Port3 Assign 
 

1    [12] Config >  

GPI > GPI-Out Port > Port4 Assign 

 

 

1    [12] Config >  

GPI > GPI-Out Port > Port5 Assign 
 

1    [12] Config >  

GPI > GPI-Out Port > Port6 Assign 
 

1    [12] Config >  

GPI > GPI-Out Port > Port7 Assign 
 

2    [12] Config >  

GPI > GPI-Out Port > Port8 Assign 
 

 "GPI 입력 포트를 사용하여 제어" 및 "GPI 출력 포트에서 

출력"을 참조하십시오. 

• GPI-In 활성화(또는 GPI-Out 활성화) 항목에 대한 설정은 사용자 
버튼 중 하나에 할당할 수 있습니다. 

 "사용자 버튼 설정"을 참조하십시오. 
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■ GPI 입력 포트를 사용하여 제어 
 

항목 할당 할당된 기능에 대한 설명 제어 방법 

KEY 1/2 ON 전환 영역의 KEY1, KEY2 버튼  

 

 

 

 

 

작동은 접점 입력(30ms 이상)을 사용하여 

수행됩니다. 

FTB ON 전환 영역의 FTB 버튼 

BKGD AUTO AUTO 버튼을 누릅니다(배경이 선택된 경우) 

BKGD CUT 배경이 선택된 경우 CUT 버튼 

KEY1 AUTO AUTO 버튼 (키 선택 시) 

KEY1 CUT CUT 버튼 키를 선택한 경우 

REC Still1 Still1 녹음 

REC Still2 Still2 녹음 

AUX XPT 1~12 크로스포인트 버튼(1 - 12)은 AUX 버스를 전환하는 데 사용됩니다. 

• 메뉴를 사용하여 제어할 AUX 버스(AUX1, AUX2)를 선택합니다. 

RTly DSBL 빨간색 탈리 신호가 출력되지 않습니다.  

기능은 접점 입력을 사용하여 

활성화됩니다(또는 열린 상태에서 

비활성화됨). 

GTly DSBL 녹색 탈리 신호가 출력되지 않습니다. 

AUXTly DSBL AUX 탈리 신호가 출력되지 않습니다. 

No Assign 할당된 기능이 없습니다.  
 

 

■ GPI 출력 포트의 출력 
 

항목 할당 할당된 기능에 대한 설명 출력 

CUT 컷 전환이 실행됨  

 

낮은 펄스가 출력됩니다(약 50 - 

60ms). 

KEY1 ON, KEY 2 ON 키 1, 2 전환 시작 

FTB ON FTB 전환 시작 

BKGD CUT 실행된 배경에 대한 잘라내기 전환 

KEY1 CUT 실행된 key1에 대한 컷 전환 

AUTO 자동 전환 실행 진행 중  

낮은 레벨이 출력됩니다. BKGD AUTO 백그라운드에 대한 자동 전환 실행 진행 중 

KEY1 AUTO key1에 대한 자동 전환 실행 진행 중 

RTly SDI IN1 - 4 SDI IN1 - IN4에 대한 적색 집계  

 

 

낮은 레벨은 탈리 출력 중에 출력됩니다. 

RTly HDMI IN1, 2 HDMI IN1, 2에 대한 적색 탈리 

RTly IP IN1 - 4 IP IN1 - IN4에 대한 적색 집계 

GTly SDI IN1 - 4 SDI IN1 - IN4에 대한 그린 탈리 

GTly HDMI IN1, 2 HDMI IN1, 2에 대한 그린 탈리 

GTly IP IN1 - 4 IP IN1 - IN4에 대한 녹색 집계 

AUXTly SDI IN1 - 4 AUX 버스에서 SDI IN1 - IN4를 선택한 경우*  

입력이 선택되는 동안 낮은 레벨이 

출력됩니다. 
AUXTly HDMI IN1, 2 AUX 버스에서 HDMI IN1, 2를 선택한 경우* 

AUXTly IP IN1 - 4 AUX 버스에 의해 IP IN1 - IN4가 선택된 경우* 

No Assign 할당된 기능이 없습니다.  
 

*: 메뉴를 사용하여 신호를 출력할 AUX 버스(AUX1, AUX2)를 선택합니다. 
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탈리/GPI 

 
 

핀 번호 신호 이름 

1  GPI Out1 
 9 GPI Out8 

2  GPI Out2 
 10 GPI-In1 

3  GPI Out3 
 11 GPI-In2 

4  GPI Out4 
 12 GPI-In3 

5  GPI Out5 
 13 GPI-In4 

6  알람 Out 
 14 GPI-In5 

7  GPI Out6 
 15 GPI-COM 

8  GPI Out7 

 

 LAN 

장치와 컴퓨터 또는 장치와 외부 장치*를 연결합니다. 

*: 장치에서 외부 장치를 제어할 수 있습니다. 

 

• 카테고리 5e 이상, 스트레이트 또는 크로스오버 STP(Shielded Twisted Pair) LAN 케이블, 최대 100m(328피트)를 사용하십시오. 
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 외부 패널로 제어 

이 장치를 사용하면 IP 네트워크를 통해 연결된 외부 패널(*)에서 다음 작업을 수행할 수 있습니다. 

• 각 버스에 대한 소스 선택 

• 비디오 전환 실행 

• 샷 메모리 재생 

• 각 버스에 대한 크로스포인트 선택 

*: 이 장치는 LAWO의 LBP 시리즈를 지원합니다. LBP 시리즈 설정 및 작동에 대해서는 LAWO에 문의하십시오. 

 

 준비  
 

LAN 케이블을 사용하여 외부 패널을 장치 뒷면의 LAN 커넥터에 

연결합니다. 

최대 20개의 외부 패널을 연결할 수 있습니다. 여러 외부 패널을 

연결할 때 허브를 통해 연결하십시오. 

 

외부  패널  설정  
 

본 기기에서 다음 설정을 확인한 다음 연결된 외부 패널에서 
설정하십시오. 

• 다음 항목에서 설정한 주소 값을 외부 패널에 의해 제어되는 
장치의 IP 주소로 설정하십시오. 

①   [16] Network >  

LAN > IP Address 
 

• 다음 항목에서 설정한 포트 번호를 외부 패널에 의해 제어되는 
장치의 포트 번호로 설정하십시오. 

①   [17] External Interfaces >  

External Panel Information > Port No 
 

또한 연결된 네트워크 환경에 따라 다음 메뉴에서 서브넷 마스크와 
기본 게이트웨이를 설정합니다. 

①   [16] Network >  

LAN > Subnet Maks 
 

②   [16] Network >  

LAN > Default Gateway 

외부  패널이  연결된  경우의  본  기기  설정  

 
①  다음 메뉴 조작으로 외부 패널 기능에 대한 활성화/비활성화를 

설정합니다. 

②   [17] External Interfaces >  

External Panel Information > Active 
 

 

②  다음 메뉴 조작으로 본 기기에서 사용하는 수신 포트 번호를 
설정하십시오. 

③   [17] External Interfaces >  

External Panel Information > Port No 
 

 

 

 

 

 

 

 

 

 

  

Possible setting range  
(가능한 설정 범위) 

62000 ~ 65535 

Default value (기본값) 62010 

수신 포트 번호 설정 

노트 

외부 패널 및 본 기기 ON/OFF 

장치를 켜거나 끄거나 다시 시작할 때 다음 사항에 유의하십시오. 

본 기기를 다시 시작한 후 3분 이상이 경과해도 외부 패널을 

연결할 수 없으면 외부 패널을 다시 시작하십시오. 
본 기기가 켜져 있는 동안 외부 패널을 끄려면 
실행 중인 경우 먼저 다음 항목을 "사용 안 함(Disable)"으로 

설정한 다음 외부 패널을 끕니다. 

[17] External Interface > 

External Panel Informatioin > Active 



110 

 

 
 

제작 : ㈜디브이네스트 1544-5596 

 

 
 

이 기기의 샷 메모리가 외부 패널의 조작으로 재생될 때의 재생 
대상을 설정합니다. 

 

다음 메뉴 조작으로 샷 메모리의 재생 대상을 설정합니다. 
 

①   [17] External Interfaces >  

External Panel Ip > Shot Memory Recall >  

BKGD 
 

②   [17] External Interfaces >  

External Panel Ip > Shot Memory Recall >  

Key1 
 

③   [17] External Interfaces >  

External Panel Ip > Shot Memory Recall >  

Key2 
 

④   [17] External Interfaces >  

External Panel Ip > Shot Memory Recall >  

AUX1 
 

⑤   [17] External Interfaces >  

External Panel Ip > Shot Memory Recall >  

AUX2 
 

⑥   [17] External Interfaces >  

External Panel Ip > Shot Memory Recall >  

CBGD 
 

⑦   [17] External Interfaces >  

External Panel Ip > Shot Memory Recall >  

XPT 
 

• BKGD, 키, AUX, 컬러 배경, 크로스포인트 영역을 개별적으로 
켜거나 끌 수 있습니다. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

샷 메모리 재생 대상 설정 
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외부 인터페이스  

 

 

 버스  ID  및  소스  ID  목록  

 
외부 패널에서 작업을 수행할 때 버스(대상)의 소스(소스)를 지정하는 크로스포인트 설정 명령이 발행됩니다. 

본 기기가 외부 패널로부터 크로스포인트 설정 명령을 수신하면 명령에 지정된 버스 및 소스 조합에 따라 소스가 선택되고 비디오 전환이 

실행됩니다. 

이 섹션에서는 각 버스와 각 소스를 식별하기 위해 이 장치에서 사용하는 ID(번호)에 대해 설명합니다. ID는 크게 

다음 2가지 유형으로 분류할 수 있습니다. 

1) 일반 버스 ID 및 소스 ID 

스위처 내부의 버스(PGM, AUX1 등) 및 스위처 자료(IN1, CBGD1, STILL1-V 등)를 지정하는 ID입니다. 1에서 512 사이의 숫자를 사용합니다. 

2) 확장 버스 ID 및 확장 소스 ID 
비디오 전환, 매크로 메모리 및 샷 메모리의 재생에 사용되는 ID입니다. 

본 장치가 버스와 소스에 대해 동일한 확장 ID가 지정된 크로스포인트 설정 명령을 수신하면 해당 기능이 실행됩니다. 

예를 들어, BKGD AUTO 버스(ID: 522)에 대한 BKGD AUTO 소스(ID: 522)를 지정하는 명령이 수신되면 AUTO 전환이 실행됩니다. 

513에서 1024 사이의 숫자를 사용합니다. 
 

실행 가능한 작업 지정된 버스 및 소스 

ME 키 전환 KEY1 AUTO, KEY2 AUTO 

ME 키 전환(CUT) KEY1 CUT, KEY2 CUT 

ME AUTO 전환 BKGD AUTO 

ME CUT 트랜지션 BKGD CUT 

샷 메모리 등록된 메모리 재생하기 SHOTPLAY1 ~ SHOTPLAY12 

각 버스에 대한 크로스포인트 선택 XPT1 ~ XPT12 

 

• LBP 시리즈의 각 버튼 작동에 ID를 할당하는 방법에 대한 자세한 내용은 LAWO에 문의하십시오. 

 

  

노트 

외부 인터페이스(ExtPanel)로 사용되는 외부 패널(LAWO의 LBP 시리즈)에 대한 설정 

여러(2개 이상)의 외부 패널을 연결할 때 다음 사항에 유의하십시오. 
여러 외부 패널에 대한 구성 데이터를 작성할 때 동일한 .snap 파일 내에 데이터를 작성하십시오. 
사용할 각 외부 패널에 대해 라우터 이름만 다른 동일한 매개변수 설정을 사용합니다. 

위의 조치를 취하지 않고 여러 외부 패널에서 제어 ID의 확장 버스 ID/확장 소스 ID 810 - 821(XPT1 - XPT12)에 대한 설정을 지정하면 외부 

패널이 올바르게 작동하지 않을 수 있습니다. 
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버스 ID 

 
–: 미사용 ID 

소스 ID 

 
–: 미사용 ID 

확장 버스 ID 

 
–: 사용 가능한 ID(-1) 전송됨 

확장 소스 ID 

 
–: 미사용 ID 

  



113 

외부 인터페이스  

 

 

 외부  제어  

 
<개요> 

시스템에서 모든 버스의 소스를 전환하고 시스템 컨트롤러 및 

탈리 인터페이스와 같은 네트워크에 연결된 외부 장치를 

사용하여 이 장치에서 모든 버스의 소스 이름 정보를 송수신할 수 

있습니다. 

외부 장치에서 키 신호 커플링 설정을 전환할 수도 있습니다. 

TSL UMD Protocol V5.0과 호환되는 전송 형식을 사용하여 

탈리 정보 및 Source ID 정보를 송수신할 수 있습니다. 

Panasonic의 AW-RP 시리즈 원격 카메라 컨트롤러를 IP를 통해 

연결하면 AW-RP 시리즈 카메라 셀렉터를 사용하여 소스 전환, 탈리 

정보 전송, 포커스 어시스트 수행 및 유닛 버스의 소스 이름을 획득할 

수 있습니다. 

• 제어 버스 설정 등에 대한 정보는 AW-RP 시리즈의 
사용 설명서를 참조하십시오. 

 

<준비> 

LAN 케이블을 사용하여 외부 장치를 본 기기 후면의 LAN 커넥터에 

연결합니다. 

이 장치는 20개의 IP 연결을 지원합니다. 여러 외부 장치에 

연결하는 경우 허브를 통해 연결하십시오. 중복되지 않도록 IP 

주소를 설정해야 합니다. 

다음 메뉴에서 본 기기에 대한 네트워크 설정을 확인하십시오. 
 

⑧   [16] Network >  

LAN > IP Address 
 

⑨   [16] Network >  

LAN > Subnet Mask 
 

초기 설정은 다음과 같습니다. IP 주소: "192.168.0.50", 서브넷 

마스크: "255.255.255.0". 

 

<설정> 

①  다음 메뉴 조작으로 외부 제어 기능에 대한 활성화/비활성화를 
설정합니다. 

⑩   [17] External Interfaces >  

External Control Switcher > Active 
 

②  다음 메뉴 조작으로 네트워크를 설정합니다. 

⑪   [17] External Interfaces >  

External Control Switcher > Port No 
 

③  다음 메뉴 조작으로 명령 전송 간격을 설정합니다. 

⑫   [17] External Interfaces >  

External Control Switcher > Interval Time 

 

④  다음 메뉴 조작으로 전송 소스에 대한 변경 알림 전송을 
설정합니다. 

⑬   [17] External Interfaces >  

External Control Switcher > Response 
 

On 전송 소스에 변경 알림을 보냅니다. 

Off 전송 소스에 변경 알림을 보내지 않습니다. 

 

⑤  다음 메뉴 조작으로 연결된 외부 장치의 IP 주소를 설정합니다. 

⑭   [17] External Interfaces >  

External Control AUX Panel > IP AddressXX 
 

⑥  다음 메뉴 조작으로 연결된 외부 장치의 수신 포트 번호를 
설정합니다. 

⑮   [17] External Interfaces >  

External Control AUX Panel > Port No 
 

• 리모트 카메라 컨트롤러 AW-RP 시리즈에 연결할 경우 
60031로 설정하십시오. 

⑦  TSL UMD 프로토콜 V5.0 명령의 DMSG-CONTROL 매개변수에 
대한 정보 

RH 탈리가 출력될 때 빨간색 탈리 설정이 출력됩니다. TXT 

탈리가 출력될 때 녹색 탈리 설정이 출력됩니다. 

⑧  소스 이름을 변경하려면 다음 항목을 "사용자"로 설정해야 
합니다. 

1    [10] Input >  

Inx > Name Type 

 

<명령 사양> 

AV-HSW10 외부 인터페이스 통신 프로토콜 사양을 참조하십시오. 
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 소프트웨어  패널  연결  설정  

 
이 유닛을 사용하면 LAN 연결을 사용하여 AV-SF10 소프트웨어 
패널이 설치된 PC를 연결하여 본 기기를 원격으로 조작하고 본 기기의 
설정을 제어할 수 있습니다. 

소프트웨어 패널을 인증하기 위해 이 장치에서 인증 정보를 
설정합니다. 

 

• 로컬 PC에 소프트웨어 패널을 설치하는 경우 AV-
SF10의 설치 절차를 참조하십시오. 

• 소프트웨어 패널의 작동에 대한 자세한 내용은 AV-
SF10의 사용 설명서를 참조하십시오. 

 

①  다음 메뉴를 실행하여 소프트웨어 패널에서 인증에 사용되는 
사용자 이름을 설정합니다. 

 

1    [13] System >  

User Auth > User Name 
 

• 사용자 이름은 1자에서 32자 사이로 설정할 수 있습니다. 

<사용자 이름에 사용할 수 있는 문자입니다> 
 

 

②  다음 메뉴를 실행하여 소프트웨어 패널로 인증에 사용되는 
암호를 설정합니다. 

• 인증 비밀번호는 2번 입력해야 합니다. 

 

1    [13] System >  

User Auth > Password 
 

• 암호는 1자에서 32자 사이로 설정할 수 있습니다. 

<암호에 사용할 수 있는 문자입니다> 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

A부터 Z까지, A부터 Z까지, 0부터 9까지, 공백, 

! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > / 

A부터 Z까지, A부터 Z까지, 0부터 9까지 
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자동 색상 톤 보정  

 

자동 색상 톤 보정 
 

<개요> 

본 기기에 여러 대의 카메라를 연결하여 사용할 수 있지만 카메라마다 색상 속성이 다르기 때문에 전환할 때 이상하게 보일 수 있습니다. 따라서 각 

카메라에서 개별 조정을 완료한 후 다른 카메라의 색상 속성이 마스터 카메라와 일치하도록 일치 프로세스를 수행해야 합니다. 이 기능은 색상 속성 

일치를 단순화하기 위해 이 장치에 대한 조정을 수행하는 방법으로 제공됩니다. 

 

 

<설정> 

①  카메라의 기능을 사용하여 각 개별 카메라를 조정합니다. 이것은 

이 장치의 기능이 아닙니다. 사용 중인 장치의 사용 설명서 등을 

참조하십시오. 

②  마스터 카메라를 결정하고 맥베스(Macbeth) 차트의 24개 점을 

마커와 일치시키거나 마커를 일치시킨 다음 녹화합니다. 

 

 

• 이 함수에는 맥베스(Macbeth) 차트가 사용될 것으로 

예상되지만 다른 색상 차트도 사용할 수 있습니다. 

③  마스터 카메라와 마찬가지로 다른 카메라를 맥베스 차트의 24개 

포인트와 연속적으로 일치시킨 다음 마스터 카메라 녹화를 

사용하여 보정합니다. 

• 매개변수는 추출된 24개 점을 서로 비교하여 결정되지만 보정 

프로세스의 특성으로 인해 절대 일치가 아님을 의미합니다. 

교정은 교정 후의 전체 변동이 최소로 줄어들도록 

이루어집니다. 

변경으로 인해 카메라 설정이 다시 조정된 경우 조건 등에 따라 이 

함수를 다시 실행해야 합니다. 따라서 카메라의 자동 조정 기능을 끄는 

것이 좋습니다. 
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 마스터  카메라  기록  
 

①  다음 메뉴 조작으로 대상 입력을 선택합니다. 

1    [19] Color Adjust >  

Target 
 

②  다음 메뉴 조작으로 대상 입력에 마커를 표시합니다. 

2    [19] Color Adjust >  

Maker 
 

③  다음 메뉴 조작으로 마커 위치를 설정합니다. 

2    [19] Color Adjust >  

Left 
 

2    [19] Color Adjust >  

Top 
 

2    [19] Color Adjust >  

Bottom 
 

2    [19] Color Adjust >  

Right 
 

2    [19] Color Adjust >  

Set capture points 
 

Left 점을 생성할 영역의 왼쪽 모서리를 지정합니다. 

Top 점이 생성될 영역의 위쪽 모서리를 지정합니다. 

Bottom 점이 생성될 영역의 아래쪽 모서리를 지정합니다. 

Right 점을 생성할 영역의 오른쪽 모서리를 지정합니다. 

Set capture 
points 

지정된 영역에 24개의 포인트가 세로 6 × 가로 4 
패턴으로 생성됩니다. 

 

 

④  다음 메뉴 조작으로 마커 위치를 조정합니다. 

2    [19] Color Adjust >  

Points > Point x 
 

⑤  다음 메뉴 조작으로 마커 위치의 색상을 기록할 위치를 
선택합니다. 

 

⑥  다음 메뉴에서 OSD/TIME 다이얼(Excute)을 눌러 선택한 
위치를 기록합니다. 

2    [19] Color Adjust >  

Capture for Master 

• 이미 기록이 있는 경우 덮어씁니다. 

 

⑦  다음 메뉴 조작으로 기록에서 이름을 설정합니다. 

2    [19] Color Adjust >  

Parameters > Parameter x > Name 
 

• 최대 16자의 문자열을 입력할 수 있습니다. 

 

 다른  카메라  보정  

 

①  다음 메뉴 조작으로 대상 입력을 선택합니다. 

2    [19] Color Adjust >  

Adjust Target 
 

②  마커를 일치시킵니다. 

 "마스터 카메라 기록"에서 ② 에서 ④를 참조하십시오. 

③  다음 메뉴 조작으로 캘리브레이션 참조로 사용할 마스터 
카메라의 기록을 선택합니다. 

3    [19] Color Adjust >  

Parameter No 
 

④  다음 메뉴에서 OSD/TIME 다이얼(Execute)을 눌러 색상을 
조정합니다. 

3    [19] Color Adjust >  

Adjust Target 
 

• [19] 컬러 보정기 > Enable Color Adjust는 이때 자동으로 
"Enable"로 변경됩니다. 보정을 비활성화하려면 "Disable"로 
변경합니다. 

 

 
 

 

 

 

 

 

 

 

 

 

 

①   [19] Color Adjust >  

Parameter No 

왼쪽, 위쪽 
 
 
 
 

아래쪽, 오른쪽 
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외형  

 

 

외형  
 

Unit: mm (inch) 
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제품 사양  
 

 
 

일반 

작동 주위 온도 0 °C - 40 °C (32 °F - 104 °F) 

작동 주위 습도 10 % - 90 % (결로 없음) 

보관 온도 0 °C - 40 °C (32 °F - 104 °F) 

보관 습도 10 % - 90 % (결로 없음) 

무게  약 1.8kg (3.96파운드) 

크기 (W× H×D) 254mm × 67mm × 175mm(10인치 × 2-5/8인치 × 6-7/8인치)(돌출부 제외) 

 

비디오 단자 

SDI 입력 (SDI1~SDI4) 4 라인 
• 커넥터 : BNC × 4 
• 프레임 싱크로나이저 장착 
• 커넥터<SDI IN 1> 및 <SDI IN 2>에는 간소화된 포맷 컨버터가 있으며, <SDI IN 3> 및 <SDI IN 4>에는 
고성능 포맷 컨버터가 있습니다. 

• 커넥터<SDI IN 1> - <SDI IN 4>에는 간소화된 컬러 코렉터가 장착되어 있습니다. 
* SDI IN 1은 HDMI IN 1과 둘 중 하나만 선택하여 사용 할 수 있습니다. 
3G-SDI 3G-SDI, SMPTE424M 표준 준수(Level-A/Level-B 호환) 

• 0.8V [p-p] ± 10 % (75 Ω) 
• 자동 이퀄라이저 100m (케이블 사용 시) 

HD-SDI  HD-SDI, SMPTE292M 표준 준수 
• 0.8V [p-p] ± 10 % (75 Ω) 
• 자동 이퀄라이저 100m (케이블 사용 시) 

HDMI 입력 (HDMI1, HDMI2)  2 라인, HDMI1.4b 호환  
비디오 형식 포맷 : 
720p/59.94Hz, 720p/50Hz, 1080i/59.94Hz, 1080i/50Hz, 1080p/59.94Hz, 1080p/50Hz, 
1080p/29.97Hz, 1080p/25Hz, 1080p/24Hz, 1080p/23.98Hz 
PC 형식 포맷 : 
WSXGA+(1680 × 1050, 60Hz), SXGA(1280 × 1024, 60Hz), WXGA(1280 × 768, 60Hz), 
XGA(1024 × 768, 60Hz) 
모드 : Full / Fit-V  Fit-H 
• 커넥터 : HDMI × 2 
• 프레임 싱크로나이저 및 단순화된 색상 보정기 장착 
• HDMI IN 커넥터에는 스케일러 기능이 있습니다. 
• 이 커넥터는 HDCP 기술을 지원하지 않습니다. 
* HDMI IN 1은 SDI IN 1과 둘 중 하나만 선택하여 사용 할 수 있습니다. 

SDI 출력 (SD 1, SDI2)  2 라인 
• 커넥터: BNC × 2 
• PGM, PVW, CLN, MV, AUX1/2 및 Key Out을 할당할 수 있습니다. 
3G-SDI (영문) 3G-SDI, SMPTE424M 표준 준수(Level-A와 호환) 

• 0.8V [p-p] ± 10 % (75 Ω) 
HD-SDI (영어) HD-SDI, SMPTE292M 표준 준수 

• 0.8V [p-p] ± 10 % (75 Ω) 
HDMI 출력 1라인, HDMI1.4b 호환 

• 커넥터 : HDMI × 1 
• 스케일러 기능을 갖추고 있습니다. 
모드 : Fit-V, Fit-H, 전체, 전체 -90 %, 전체 -80 % 
• PGM, PVW, CLN, MV, AUX1/2 및 Key Out을 할당할 수 있습니다. 
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LAN 1000Base-T 및 AUTO-MDIX와 호환(IP 신호 전송/제어용) 

• 연결 케이블: LAN 케이블(카테고리 5e 이상), 최대 100m(328ft), STP(Shielded Twisted Pair) 
케이블 권장 

• 커넥터: RJ-45 
 IP 입력 신호  
IN 6 - 9에 할당 
• IN 6, IN 7: Selectable from SRT/NDI|HX(버전 1/버전 2). 
• IN 8, IN 9: 고대역폭 NDI 입력 전용. 

NDI 알파 채널 입력을 지원합니다. 이 경우 IN 9와 쌍으로 사용됩니다. 
 IP 출력 신호 
OUT 4 및 OUT 5에 할당 
• OUT 4, OUT 5: SRT/고대역폭 NDI/RTMP 중에서 선택 가능. 
• PGM, PVW, CLN, MV, AUX1/2, Key Out을 할당할 수 있습니다. 
• 스케일러 기능 및 I/P 변환 기능을 갖추고 있습니다. * 
• 가능한 출력 포맷 : 

1920 × 1080/60fps, 50fps, 30fps, 25fps, 24fps 
1280 × 720/60fps, 50fps 

* 펌웨어 업데이트를 통한 계획된 지원 
USB UVC/UAC 출력용  

커넥터 OUT 6에 할당 
• 커넥터: USB3.2 Gen1 Type-C, USB 버스 전원 기능 없음 
• PGM, PVW, CLN, MV, AUX1/2 및 Key Out을 할당할 수 있습니다. 
• 스케일러 기능 및 I/P 변환 기능을 갖추고 있습니다.* 
• 가능한 출력 포맷 : 

1920 × 1080/60fps, 50fps, 30fps, 25fps, 24fps 
1280 × 720/60fps, 50fps, 30fps, 25fps, 24fps 

* 펌웨어 업데이트를 통한 계획된 지원 
시스템 포맷 1080/59.94p, 50p, 29.97p, 25p, 24p, 23.98p, 59.94i, 50i 

720/59.94p, 50p 
신호 처리 R:G:B 4:4:4 8비트 / 4:2:2 10비트(HDMI일 때) 

Y:Cb:Cr 4:2:2 8비트(고대역폭 NDI/UVC일 때) 

Y:Cb:Cr 4:2:0 8비트(NDI|HX/SRT/RTMP)에 대해 설명합니다. 

Y:Cb:Cr 4:2:2 10비트 

M / E  1 ME 

 

오디오 단자  

오디오 입력 • L/1 및 R/2 
• 커넥터: 핀 잭 
• 각 출력에 내장 기능을 갖추고 있습니다. 
• 딜레이/레벨 조정 기능을 갖추고 있습니다. 

오디오 출력 헤드폰 모니터용 커넥터 
• 커넥터: Φ3.5mm TRS 
• 출력 볼륨 조정 기능을 갖추고 있습니다. 

 

커넥터 동기화 

레퍼런스 입력 젠록(Genlock) 모드: BB(블랙 버스트), Tri-level Sync 및 내부(Internal) 동기화 중에서 선택 가능 
• 루프 스루 출력은 BB 모드와 트라이 레벨 싱크 모드에서 수행됩니다. 
• 루프 스루 출력을 사용하지 않을 경우 75 Ω 종료를 제공합니다. 
• 커넥터: BNC×2 
• 지원되는 시스템 형식의 주파수와 동일한 필드 주파수입니다. 
• 23.98 Hz 및 24 Hz의 경우 트라이 레벨 입력 또는 내부 동기화만 지원됩니다. 

비디오 지연 시간 1 Line(H) 프레임 싱크로나이저 설정이 [Off]이고 업 컨버터와 다운 컨버터가 모두 작동하지 않는 
경우 

1 Frame(F) 프레임 싱크로나이저 설정이 켜져 있고 업 컨버터와 다운 컨버터가 작동 중일 때 

• 신호가 PinP, 멀티 뷰, 다운 컨버터 또는 HDMI IN/OUT을 통과하면 각 경우에 최대 1 프레임의 지연이 
적용됩니다. 
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제어 커넥터 

LAN 1000Base-T 및 AUTO-MDIX(IP 제어용)와 호환 

• 연결 케이블: LAN 케이블(카테고리 5e), 최대 100m(328피트), STP(Shielded Twisted Pair) 케이블 권장 
• 커넥터: RJ-45 

TALLY GPI INPUT: 5개 입력, 범용, 포토커플러 감지  

OUTPUT: 8개 출력, R/G 탈리에서 선택, 범용 ALARM: 1개 출력, 오픈 컬렉터 출력(네거티브 로직) 
• 커넥터 : D-Sub 15pin 

USB • 커넥터: USB2.0, Type-A, USB 버스 전원 기능 포함 

USB 메모리를 사용하여 구성 파일과 스틸 데이터를 저장 및 로드하고 펌웨어 업데이트를 수행합니다. 

 

AC 어댑터 
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설정 메뉴표 
 
No. Sub menu Setting item Setting 

1 WIPE 1 BKGD Pattern  Setting range Select each pattern (page 34) 

Default value 5 

2 BKGD 

Transition 

Direction Setting range Normal, Reverse, N/R 

Default value Normal 

Border Setting range Border On, Off Width 0.1 to 100.0 

Default value Off 5.0 

Setting range Soft 0.0 to 100.0   

Default value 0.0  

Border Color  

Setting range 

 

 

Load 

White, Yellow, Cyan, 

Green, Magenta, Red, 

Blue, Black 

 

 

Hue 

0.0 to 359.9 

Default value White 0.0 

Setting range Sat 0.0 to 100.0 Lum 0.0 to 108.0 

Default value 0.0 100.0 

Position Setting range X-Position –100.00 to 100.00 Y-Position –100.00 to 100.00 

Default value 0.00 0.00 

3 Key1 Pattern  Setting range Select each pattern (page 39) 

Default value 5 

4 Key1 

Transition 

Type Setting range MIX, WIPE 

Default value MIX 

Keyout Pattern Setting range Normal, Reverse 

Default value Normal 

Position Setting range X- 

Position 

–100.00 to 100.00 Y- 

Position 

–100.00 to 100.00 

Default value 0.00 0.00 

2 CBGD 1 CBGD Select  Setting range CBGD1, CBGD2 

Default value CBGD1 

2 CBGD Main Load Setting range White, Yellow, Cyan, Green, Magenta, Red, Blue, Black 

Default value Blue, Red 

Hue Setting range 0.0 to 359.9 

Default value 120.0, 0.0 

Sat Setting range 0.0 to 100.0 

Default value 100.0 

Lum Setting range 0.0 to 108.0 

Default value 100.0 

3 CBGD Sub Load Setting range White, Yellow, Cyan, Green, Magenta, Red, Blue, Black 

Default value White 

Hue Setting range 0.0 to 359.9 

Default value 0.0 

Sat Setting range 0.0 to 100.0 

Default value 0.0 

Lum Setting range 0.0 to 108.0 

Default value 100.0 

4 CBGD Wash Wash Setting range On, Off 

Default value Off 

Color Setting range Dual, Rainbow 

Default value Dual 

Rainbow Sat Setting range 0.0 to 100.0 

Default value 100.0 

Rainbow Lum Setting range 0.0 to 108.0 

Default value 100.0 

 

No. Sub menu Setting item Setting 
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2 CBGD 5 CBGD Wave Pattern Setting range Sine, Saw 

Default value Sine 

Cycle Setting range 0.0 to 100.0 

Default value 0.0 

Phase Setting range –180.0 to 180.0 

Default value 0.0 

Angle Setting range 0.0 to 360.0 

Default value 0.0 

6 CBGD Move Move Setting range Off, Roll, Rotation 

Default value Off 

Speed Setting range –50.0 to 50.0 

Default value 1.0 

3 Key 1 Key Select  Setting range Key1, Key2 

Default value Key1 

2 Key Type  Setting range Lum (ChromaOff), Lum (ChromaOn), Linear, Chroma, Full 

Default value Linear 

3 Fill  Setting range Bus, Matte 

Default value Bus 

4 PVW  Setting range Off, On 

Default value Off 

5 Key Adjust Clip Setting range 0.0 to 108.0 

Default value 0.0 

Gain Setting range 0.0 to 200.0 

Default value 100.0 

Density Setting range 0.0 to 100.0 

Default value 100.0 

Invert Setting range On, Off 

Default value Off 

6 Fill Matte Load Setting range White, Yellow, Cyan, Green, Magenta, Red, Blue, Black 

Default value White 

Hue Setting range 0.0 to 359.9 

Default value 0.0 

Sat Setting range 0.0 to 100.0 

Default value 0.0 

Lum Setting range 0.0 to 108.0 

Default value 100.0 

7 Edge Type Setting range Off, Border, Drop, Shadow, Outline 

Default value Off 

Width Setting range 0 to 4 

Default value 2 

Direction Setting range 0, 45, 90, 135, 180, 225, 270, 315 

Default value 0 

Density Setting range 25%, 50%, 75%, 100% 

Default value 100% 

Fill Setting range Color, CBGD1, CBGD2, Still1, Still2 

Default value Color 
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No. Sub menu Setting item Setting 

3 Key 7 Edge Color  

Setting range 

 

 

Load 

White, Yellow, Cyan, 
Green, Magenta, Red, 
Blue, Black 

 

 

Hue 

0.0 to 359.9 

Default value Black 0.0 

Setting range 
Sat 

0.0 to 100.0 
Lum 

0.0 to 108.0 

Default value 0.0 0.0 

8 Mask Size Setting range Off, Manual, 4:3 

Default value Off 

Invert Setting range On, Off 

Default value Off 

Position Setting range 
Left 

–50.00 to 50.00 
Top 

–50.00 to 50.00 

Default value –25.00 25.00 

Setting range 
Bottom 

–50.00 to 50.00 
Right 

–50.00 to 50.00 

Default value –25.00 25.00 

9 PinP PinP Setting range On, Off 

Default value Off 

Shape Setting range Square, Circle, Heart, Flower, Star 

Default value Square 

Density Setting range 0.0 to 100.0 

Default value 100.0 

Full Key Setting range On, Off 

Default value On 

Border Setting range 
Border 

Off, On 
Width 

0.1 to 100.0 

Default value Off 5.0 

Setting range 
Soft 

0.0 to 100.0 
Mode 

Fix, Variable 

Default value 0.0 Fix 

Setting range 
 

 

 

 

 

 

Color 

 

Load 

White, Yellow, Cyan, Green, Magenta, Red, 
Blue, Black 

Default value Black 

Setting range 
Hue 

0.0 to 359.9 

Default value 0.0 

Setting range 
Sat 

0.0 to 100.0 

Default value 0.0 

Setting range 
Lum 

0.0 to 108.0 

Default value 0.0 

Position Setting range X- 

Position 

–100.00 to 100.00 Y- 

Position 

–100.00 to 100.00 

Default value 0.00 0.00 

Setting range 
Size 

0.00 to 100.00 

Default value 25.00 
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No. Sub menu Setting item Setting 

3 Key 9 PinP Trim Setting range 
Trim 

Off, On 
Pair 

Off, On 

Default value Off Off 

Setting range 
Preset 

16:9, 12:9, 9:9, 7:9, 6:9, Manual 

Default value 16:9 

Setting range  

 

 

 

 

Adjust 

Left 
–50.00 to 50.00 

Default value –50.00 

Setting range 
Top 

–50.00 to 50.00 

Default value 50.00 

Setting range 
Bottom 

–50.00 to 50.00 

Default value –50.00 

Setting range 
Right 

–50.00 to 50.00 

Default value 50.00 

Sync 
Setting range  

Symmetry 

Off, X, Y, Center, 

Same 
Copy to 

KEY 

Execute 

Default value Off  

10 Key Signal 

Coupling 

 Setting range Coupling, Independent 

Default value Coupling 

11 Key Priority Key Setting range 1st, 2nd 

Default value 2nd 

4 ChromaKey 1 Marker  Setting range On, Off 

Default value Off 

2 Sample  Setting range Execute 

Default value Execute 

3 Marker 

Position 

X-Position Setting range –50.00 to 50.00 

Default value 0.00 

Y-Position Setting range –50.00 to 50.00 

Default value 0.00 

Size Setting range 1.00 to 80.00 

Default value 10.00 

4 Marker Aspect  Setting range –50.00 to 50.00 

Default value 0.00 

5 Ref Adjust Hue Setting range 0.0 to 359.9 

Default value 354.0 

Sat Setting range 0.0 to 100.0 

Default value 100.0 

Lum Setting range 0.0 to 108.0 

Default value 7.00 

6 Y-Influence  Setting range 0.0 to 100.0 

Default value 0.0 

7 Radius Hue Setting range 0.0 to 100.0 

Default value 100.0 

Sat Setting range 0.0 to 100.0 

Default value 50.0 

8 Soft  Setting range 0.0 to 100.0 

Default value 0.0 

9 Cancel  Setting range 0.0 to 100.0 

Default value 0.0 
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No. Sub menu Setting item Setting 

5 Time 1 BKGD  Setting range 0 to 999 (Frame) 

Default value 1s00f 

2 Key1  Setting range 0 to 999 (Frame) 

Default value 1s00f 

3 Key2  Setting range 0 to 999 (Frame) 

Default value 1s00f 

4 FTB Trans Time Setting range 0 to 999 (Frame) 

Default value 1s00f 

Source Setting range Still1, Still2, CBGD1, CBGD2, White, Black 

Default value Black 

Mute Setting range Off, On 

Default value Off 

5 Effect Dissolve  Setting range 0 to 999 (Frame) 

Default value 1s00f 

6 AUX1 Bus 

Trans 

Transition Setting range Off, On 

Default value Off 

Trans Time Setting range 0 to 999 (Frame) 

Default value 1s00f 

7 AUX2 Bus 

Trans 

Transition Setting range Off, On 

Default value Off 

Trans Time Setting range 0 to 999 (Frame) 

Default value 1s00f 

6 Still 1 Still Select  Setting range Still1, Still2 

Default value Still1 

2 Key Status  Setting range On, Off 

Default value – 

3 Capture  Setting range Execute 

Default value  

4 Capture 

Setting 

Video Setting range AUX1, AUX2 

Default value AUX1 

Key Enable Setting range On, Off 

Default value On 

Key Setting range AUX1, AUX2 

Default value AUX1 

Review Setting range On, Off 

Default value On 

5 Test Pattern Load Setting range Execute 

Default value  
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No. Sub menu Setting item Setting 

7 Shot Memory 1 Target Select BKGD Setting range 
Target 

On, Off 
XPT 

On, Off 

Default value On On 

Key1 Setting range 
Target 

On, Off 
XPT 

On, Off 

Default value On On 

Key2 Setting range 
Target 

On, Off 
XPT 

On, Off 

Default value On On 

AUX1 Setting range On, Off 

Default value On 

AUX2 Setting range On, Off 

Default value On 

CBGD Setting range On, Off 

Default value On 

2 Effect  Setting range Cut, Dissolve 

Default value Dissolve 

3 Hue Path  Setting range Short, Long, CW, CCW 

Default value Short 

4 XPT Disable  Setting range Off, On 

Default value Off 
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No. Sub menu Setting item Setting 

8 XPT Assign 1 XPT1  
Setting range 

IN1 to 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, Still1K, 
Still2V, Still2K, CLN, Key Out, None 

Default value IN1 

2 XPT2  
Setting range 

IN1 to 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, Still1K, 
Still2V, Still2K, CLN, Key Out, None 

Default value IN2 

3 XPT3  
Setting range 

IN1 to 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, Still1K, 
Still2V, Still2K, CLN, Key Out, None 

Default value IN3 

4 XPT4  
Setting range 

IN1 to 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, Still1K, 
Still2V, Still2K, CLN, Key Out, None 

Default value IN4 

5 XPT5  
Setting range 

IN1 to 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, Still1K, 
Still2V, Still2K, CLN, Key Out, None 

Default value IN5 

6 XPT6  
Setting range 

IN1 to 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, Still1K, 
Still2V, Still2K, CLN, Key Out, None 

Default value IN6 

7 XPT7  
Setting range 

IN1 to 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, Still1K, 
Still2V, Still2K, CLN, Key Out, None 

Default value IN7 

8 XPT8  
Setting range 

IN1 to 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, Still1K, 
Still2V, Still2K, CLN, Key Out, None 

Default value IN8 

9 XPT9  
Setting range 

IN1 to 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, Still1K, 
Still2V, Still2K, CLN, Key Out, None 

Default value IN9 

10 XPT10  
Setting range 

IN1 to 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, Still1K, 
Still2V, Still2K, CLN, Key Out, None 

Default value CBAR 

11 XPT11  
Setting range 

IN1 to 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, Still1K, 
Still2V, Still2K, CLN, Key Out, None 

Default value CBGD1 

12 XPT12  
Setting range 

IN1 to 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, Still1K, 
Still2V, Still2K, CLN, Key Out, None 

Default value CBGD2 

13 Switch Timing  Setting range Any, Field1, Field2 

Default value Any 
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No. Sub menu Setting item Setting 

9 MultiView 

 

**********: 

Name of the 

currently set 

material 

1 Split  Setting range 4Split, 5-aSplit, 5-bSplit, 6-aSplit, 6-bSplit, 9Split, 10-aSplit, 

10-bSplit, 12Split, 16Split 

Default value 10-aSplit 

2 Size  Setting range Fit, SQ 

Default value SQ 

3 Source Select Pos1 Source  

 

Setting range 

IN1 to 9 (**********), 

CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, PVW, 

CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog IN, IP OUT1, 

IP OUT2 

Default value PGM 

Pos2 Source  

 

Setting range 

IN1 to 9 (**********), 

CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, PVW, 

CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog IN, IP OUT1, 

IP OUT2 

Default value PVW 

Pos3 Source  

 

Setting range 

IN1 to 9 (**********), 

CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, PVW, 

CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog IN, IP OUT1, 

IP OUT2 

Default value IN1 

Pos4 Source  

 

Setting range 

IN1 to 9 (**********), 

CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, PVW, 

CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog IN, IP-OUT1, 

IP-OUT2 

Default value IN2 

Pos5 Source  

 

Setting range 

IN1 to 9 (**********), 

CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, PVW, 

CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog IN, IP OUT1, 

IP OUT2 

Default value IN3 

Pos6 Source  

 

Setting range 

IN1 to 9 (**********), 

CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, PVW, 

CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog IN, IP OUT1, 

IP OUT2 

Default value IN4 

Pos7 Source  

 

Setting range 

IN1 to 9 (**********), 

CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, PVW, 

CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog IN, IP OUT1, 

IP OUT2 

Default value IN5 

Pos8 Source  

 

Setting range 

IN1 to 9 (**********), 

CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, PVW, 

CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog IN, IP OUT1, 

IP OUT2 

Default value IN6 

Pos9 Source  

 

Setting range 

IN1 to 9 (**********), 

CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, PVW, 

CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog IN, IP OUT1, 

IP OUT2 

Default value IN7 

Pos10 Source  

 

Setting range 

IN1 to 9 (**********), 

CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, PVW, 

CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog IN, IP OUT1, 

IP OUT2 

Default value IN8 
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No. Sub menu Setting item Setting 

9 MultiView 

 

**********: 

Name of the 

currently set 

material 

3 Source Select Pos11 Source  

 

Setting range 

IN1 to 9 (**********), 

CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, PVW, 

CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog IN, IP OUT1, 

IP OUT2 

Default value IN9 

Pos12 Source  

 

Setting range 

IN1 to 9 (**********), 

CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, PVW, 

CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog IN, IP OUT1, 

IP OUT2 

Default value Still1V 

Pos13 Source  

 

Setting range 

IN1 to 9 (**********), 

CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, PVW, 

CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog IN, IP OUT1, 

IP OUT2 

Default value Still2V 

Pos14 Source  

 

Setting range 

IN1 to 9 (**********), 

CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, PVW, 

CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog IN, IP OUT1, 

IP OUT2 

Default value CBAR 

Pos15 Source  

 

Setting range 

IN1 to 9 (**********), 

CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, PVW, 

CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog IN, IP OUT1, 

IP OUT2 

Default value CBGD1 

Pos16 Source  

 

Setting range 

IN1 to 9 (**********), 

CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, PVW, 

CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog IN, IP OUT1, 

IP OUT2 

Default value CBGD2 

4 MV Frame  Setting range LUM0%, LUM25%, LUM50%, LUM75%, LUM100%, Off 

Default value LUM75% 

5 MV Character  Setting range LUM0%, LUM25%, LUM50%, LUM75%, LUM100%, Off 

Default value LUM75% 

6 MV Label  Setting range On, Off 

Default value On 

7 Red Tally Box Setting range On, Off 

Default value Off 

Label Left Setting range On, Off 

Default value Off 

Label Right Setting range On, Off 

Default value Off 

8 Green Tally Box Setting range On, Off 

Default value Off 

Label Left Setting range On, Off 

Default value Off 

Label Right Setting range On, Off 

Default value Off 
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No. Sub menu Setting item Setting 

9 MultiView 9 Display Level Meter Setting range OFF, IN ON, OUT ON, IN/OUT ON 

Default value OFF 

Input Status Setting range On, Off 

Default value On 

Marker Setting range 4:3, 16:9, Off 

Default value Off 

Marker Size Setting range 80 to 100% 

Default value 95% 

 

Upper layer 

No. Sub menu Setting item Setting 

10 Input 1 IN1(SDI1/ HDMI1)  

 

 

 

 

 

 

Display only 

 

 

 

 

 

 

Menu for the 

next layer 

Moves to lower layer A 

2 IN2(SDI IN2)  

3 IN3(SDI IN3)  

4 IN4(SDI IN4)  

5 IN5(HDMI IN2)  

6 IN6(IP IN1) Moves to lower layer B 

7 IN7(IP IN2)  

8 IN8(IP IN3)  

9 IN9(IP IN4)  

 

Lower layer A 

No. Sub menu Setting item Setting 
 SDI1/HDMI1 1 SDI/HDMI  Setting range SDI, HDMI 

Default value SDI 

SDI IN XX 2 Status 

Information 

Format 
 

Display only 

 

Audio 

Status 

3 FS Mode  Setting range Off, Normal, Auto 

Default value Auto 

4 FS Delay  
Setting range 

0F to 6F 

• SDI IN1 is 0F to 2F. 

Default value 0F 

5 Freeze  Setting range Disable, Enable 

Default value Disable 

6 Freeze Select  Setting range Frame, Field 

Default value Frame 

7 Name Type  Setting range Default, User 

Default value Default 

8 Name  Setting range 32 characters can be set. 

Default value  

9 Up/Down 

Converter 

Move Detect Setting range 1 to 5 

Default value 5 

Sharp Setting range 1 to 5 

Default value 3 
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No. Sub menu Setting item Setting 

 SDI IN XX 10 Color Correct C/C Setting range On, Off 

Default value Off 

C/C Process Setting range Y-Gain 0.0 to 200.0 Pedestal –20.0 to 20.0 

Default value 100.0 0.0 

Setting range C-Gain 0.0 to 200.0 Hue 0.0 to 359.9 

Default value 100.0 0.0 

11 Camera 

Setting 

IP Address Setting range IP Address selection 

Default value  

Port Setting range 1 to 65535 

Default value 80 

Edit IP Address Setting range Execute 

Default value  

Scan IP Address Setting range Execute 

Default value  

Edit User Name Setting range  

Default value  

Edit Password Setting range ******** 

Default value  

Name Setting range Name registered on the camera 

Default value  

Network Status Setting range No IP Address, Now Checking…, Connected, Unauthorized, Not 

Connected 

Default value No IP Address 

Red Tally Setting range Disable, Enable 

Default value Enable 

Green Tally Setting range Disable, Enable 

Default value Enable 

 HDMI IN XX 2 Status 

Information 

Size  

 

 

Display only 

 

Dot Clock  

H-Frequency  

V-Frequency  

Status  

3 Freeze  Setting range Disable, Enable 

Default value Disable 

4 Freeze Select  Setting range Frame, Field 

Default value Frame 

5 Limited  Setting range On, Off 

Default value Off 

6 Name Type  Setting range Default, User 

Default value Default 

7 Name  Setting range 32 characters can be set. 

Default value  

8 Scale  Setting range Fit-V, Fit-H, Full 

Default value Full 

9 Color Correct C/C Setting range On, Off 

Default value Off 

C/C Process Setting range Y-Gain 0.0 to 200.0 Pedestal –20.0 to 20.0 

Default value 100.0 0.0 

Setting range C-Gain 0.0 to 200.0 Hue 0.0 to 359.9 

Default value 100.0 0.0 
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No. Sub menu Setting item Setting 
 HDMI IN XX 10 Camera 

Setting 

IP Address Setting range IP Address selection 

Default value  

Port Setting range 1 to 65535 

Default value 80 

Edit IP Address Setting range Execute 

Default value  

Scan IP Address Setting range Execute 

Default value  

Edit User Name Setting range  

Default value  

Edit Password Setting range ******** 

Default value  

Name Setting range Name registered on the camera 

Default value  

Network Status 
Setting range 

No IP Address, Now Checking…, Connected, Unauthorized, Not 
Connected 

Default value No IP Address 

Red Tally Setting range Disable, Enable 

Default value Enable 

Green Tally Setting range Disable, Enable 

Default value Enable 
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Lower layer B 

No. Sub menu Setting item Setting 
 IP IN1,2 1 Streaming 

Mode 

 Setting range NDI|HX, SRT (selected source shown below) 

Default value NDI|HX 

IP IN3,4 1 Streaming 

Mode 

 Setting range NDI 

Default value NDI 

NDI IN XX 2 Status 

Information 

Format  

 

 

 

Display only 

 

Sampling Rate 

Audio Channel 

Frame Data 

Compress 

Streaming Mode 

Status 

3 Alpha Settings Use Alpha Setting range Disable, Enable 

Default value Disable 

Type 
Display only 

 

Alpha Signal  

Key Source 

BKGD 

Setting range White, Black 

Default value White 

4 Machine Name  
Display only 

 

5 Source Name   

6 Scan Mode  Setting range HB/HX v2, HX v1 

Default value HB/HX v2 

7 Scan  Setting range Move to another menu (List of scan results) 

Default value  

8 Protocol  Setting range TCP, UDP 

Default value TCP 
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No. Sub menu Setting item Setting 
 NDI IN XX 9 Group Group Setting range Disable, Enable 

Default value Disable 

Group Name Setting range 64 characters can be set. 

Default value  

10 Use Discovery 

server 

Use Discovery 

server 

Setting range Disable, Enable 

Default value Disable 

Discovery server 

IP 

Setting range IP Address input 

Default value  

11 RTSP Port Setting range 1 to 65535 

Default value 554 

Request URL Setting range 255 characters can be set. 

Default value MediaInput/h264/stream_1 

Connect Setting range Execute 

Default value  

12 Name Type  Setting range Default, User 

Default value Default 

13 Name  Setting range 32 characters can be set. 

Default value  

14 Camera 

Setting 

Control Setting range Panasonic, NDI 

Default value Panasonic 

IP Address Setting range IP Address selection 

Default value  

Port Setting range 1 to 65535 

Default value 80 

Edit IP Address Setting range Execute 

Default value  

Scan IP Address Setting range Execute 

Default value  

Edit User Name Setting range  

Default value  

Edit Password Setting range ******** 

Default value  

Name Setting range Name registered on the camera 

Default value  

Network Status 
Setting range 

No IP Address, Now Checking…, Connected, Unauthorized, Not 
Connected 

Default value No IP Address 

Red Tally Setting range Disable, Enable 

Default value Enable 

Green Tally Setting range Disable, Enable 

Default value Enable 
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No. Sub menu Setting item Setting 
 SRT IN XX 2 Status 

Information 

Format  

 

 

Display only 

Video format (1080/59.94p, etc.) 

Sampling Rate  

Audio Channel  

Compress H.264/H.265 

Status  

3 Name Type  Setting range Default, User 

Default value Default 

4 Name  Setting range 32 characters can be set. 

Default value  

5 Mode  Setting range Caller, Listener 

Default value Caller 

6 Server URL  Setting range Enter URL. 1 to 254 characters 

Default value  

7 Server Port  Setting range 0 to 65535 

Default value 30000 

8 Stream ID  Setting range 512 characters can be set. 

Default value  

9 Port  Setting range 1024 to 65535 

Default value 2020 

10 Encryption  Setting range Disable, Enable 

Default value Disable 

11 Passphrase  Setting range 10 to 79 characters can be set. 

Default value  

12 Camera 

Setting 

IP Address Setting range IP Address selection 

Default value  

Port Setting range 1 to 65535 

Default value 80 

Edit IP Address Setting range Execute 

Default value  

Scan IP Address Setting range Execute 

Default value  

Edit User Name Setting range  

Default value  

Edit Password Setting range ******** 

Default value  

Name Setting range Name registered on the camera 

Default value  

Network Status 
Setting range 

No IP Address, Now Checking…, Connected, Unauthorized, Not 
Connected 

Default value No IP Address 

Red Tally Setting range Disable, Enable 

Default value Enable 

Green Tally Setting range Disable, Enable 

Default value Enable 
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Upper layer 

No. Sub menu Setting item Setting 

11 Output 1 OUT1(SDI 
OUT1) 

 

 

 

 

 

 

 

Display only 

 

 

 

 

 

 

 

Menu for the 

next layer 

Moves to lower layer A 

2 OUT2(SDI 
OUT2) 

Moves to lower layer A 

3 OUT3(HDMI 
OUT) 

Moves to lower layer B 

4 OUT4(IP 
OUT1) 

Moves to lower layer C 

5 OUT5(IP 
OUT2) 

Moves to lower layer C 

6 OUT6(UVC 
OUT) 

Moves to lower layer D 

 

Lower layer A 

No. Sub menu Setting item Setting 
 SDI OUT XX 1 Assign  Setting range PGM, PVW, CLN, AUX1, AUX2, MV, Key Out 

Default value PGM 
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Lower layer B 

No. Sub menu Setting item Setting 
 HDMI OUT 1 Assign  Setting range PGM, PVW, CLN, AUX1, AUX2, MV, Key Out 

Default value MV 

2 Size  Setting range Auto, XGA, WXGA, SXGA, WSXGA+, Native 

Default value Auto 

3 Color  Setting range Auto, RGB, YUV444, YUV422 

Default value Auto 

4 Scale  Setting range Fit-V, Fit-H, Full, Full90%, Full80% 

Default value Full 

5 Move Detect  Setting range 1 to 5 

Default value 5 

 

Lower layer C 

No. Sub menu Setting item Setting 
 IP OUT XX 1 Streaming 

Mode 

 Setting range NDI, SRT, RTMP (selected source shown below) 

Default value NDI 

2 Streaming Link  Setting range On, Off 

Default value Off 

NDI OUT XX 3 Assign  Setting range PGM, PVW, CLN, AUX1, AUX2, MV, Key Out 

Default value PGM 

4 Machine Name  Setting range Up to 20 characters 

Default value AV-HSW10 

5 Source Name Display only Setting range Up to 32 characters 

Default value NDI Device xx 

6 Protocol  Setting range TCP, UDP 

Default value TCP 

7 Multicast Multicast Setting range Disable, Enable 

Default value Disable 

IP Address Setting range IP Address input 

Default value 239.192.0.30 

Subnet Mask Setting range IP Address input 

Default value 255.0.0.0 

TTL/HOP Limit Setting range 1 to 254 

Default value 16 

8 Group Group Setting range Disable, Enable 

Default value Disable 

Group Name Setting range 64 characters can be set. 

Default value  

9 Use Discovery 

server 

Use Discovery 

server 

Setting range Disable, Enable 

Default value Disable 

Discovery server 

IP 

Setting range IP Address input 

Default value  
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No. Sub menu Setting item Setting 
 SRT OUT XX 3 Assign  Setting range PGM, PVW, CLN, AUX1, AUX2, MV, Key Out 

Default value PGM 

4 Assign STDBY  Setting range PGM, PVW, CLN, AUX1, AUX2, MV, Key Out 

Default value PGM 

5 Mode  Setting range Caller, Listener 

Default value Caller 

6 Destination 

URL 

 Setting range Enter URL. 1 to 254 characters 

Default value  

7 Destination 

Port 

 Setting range 0 to 65535 

Default value 30000 

8 Stream ID  Setting range 512 characters can be set. 

Default value  

9 Port  Setting range 1024 to 65535 

Default value 2020 

10 TTL/HOP limit  Setting range 1 to 254 

Default value 64 

11 Latency(ms)  Setting range 0 to 9999 

Default value 20 

12 Encryption  Setting range Disable, AES128, AES256 

Default value Disable 

13 Passphrase  Setting range 10 to 79 characters can be set. 

Default value  

14 Codec  Setting range H.264, H.265 

Default value H.264 

15 Rate Control 

Mode 

 Setting range CBR, VBR 

Default value CBR 

16 Target bit rate  Setting range 4Mbps, 8Mbps, 10Mbps, 14Mbps, 20Mbps, 24Mbps 

Default value 14Mbps 

17 Max bit rate  Setting range 4Mbps, 8Mbps, 10Mbps, 14Mbps, 20Mbps, 24Mbps 

Default value 14Mbps 

 
  



139 

설정 메뉴표  

 

No. Sub menu Setting item Setting 
 RTMP OUT XX 3 Assign  Setting range PGM, PVW, CLN, AUX1, AUX2, MV, Key Out 

Default value PGM 

4 Assign STDBY  Setting range PGM, PVW, CLN, AUX1, AUX2, MV, Key Out 

Default value PGM 

5 Server  Setting range 1 to 3 

Default value 1 

6 Server URL  Setting range Enter URL. 1 to 254 characters 

Default value  

7 Stream Key  Setting range 512 characters can be set. 

Default value  

8 Timeout (sec)  Setting range 1 to 30 

Default value 10 

9 Codec  Setting range H.264 

Default value H.264 

10 Rate Control 

Mode 

 Setting range CBR, VBR 

Default value CBR 

11 Target bit rate  Setting range 4Mbps, 8Mbps, 10Mbps, 14Mbps, 20Mbps, 24Mbps 

Default value 14Mbps 

12 Max bit rate  Setting range 4Mbps, 8Mbps, 10Mbps, 14Mbps, 20Mbps, 24Mbps 

Default value 14Mbps 

 

Lower layer D 

No. Sub menu Setting item Setting 
 UVC OUT 1 Assign  Setting range PGM, PVW, CLN, AUX1, AUX2, MV, Key Out 

Default value PGM 

2 Menu Out  Setting range Off, On 

Default value Off 

3 Mode  Setting range Normal, 720p 

Default value Normal 
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No. Sub menu Setting item Setting 

12 Config 1 Operate Menu Out Setting range SDI OUT2, HDMI OUT, SDI2+HDMI 

Default value SDI2+HDMI 

Menu Size Setting range FULL, Upper-Left, Upper-Right, Lower-Right, Lower-Left 

Default value FULL 

Menu Back Setting range 70%, 80%, 90%, 100% 

Default value 100% 

Bus Mode Setting range A/B, PGM-A/PST-B, PGM-B/PST-A 

Default value PGM-A/PST-B 

Time Unit Setting range Sec, Frame 

Default value Sec 

Delegation Setting range On, Off 

Default value On 

Fader Setting range BKGD, KEY1, BKGD+KEY1, No Assign 

Default value BKGD 

2 Key1/2 Link  Setting range Off, On 

Default value Off 

3 CBAR Type Setting range Type1, Type2, Type3 

Default value Type1 

Move Setting range Normal, Low, Off 

Default value Off 

Test Tone Setting range Normal, Low, Off 

Default value Off 

4 Button 

Illumination 

Button 

Illumination 

Setting range Dimmer Off, On 

Default value Off 

Setting range Lighting 80%, 90%, 100%, 110%, 120%, 130%, 140%, 150% 

Default value 150% 

 

Setting range 

 

XPT 

Color 

Input, Color Group1, Color Group2, Color Group3, 

Color Group4, Color Group5, Color Group6, Color 

Group7, Color Group8 

Default value Input 

Color Group IN Setting range  

IN1(***) 

Color Group1, Color Group2, Color Group3, Color Group4, Color 

Group5, Color Group6, Color Group7, Color Group8 

Default value Color Group1 

Setting range  

IN2(***) 

Color Group1, Color Group2, Color Group3, Color Group4, Color 

Group5, Color Group6, Color Group7, Color Group8 

Default value Color Group1 

 

Setting range 

 

 

IN3(***) 

Color Group1, Color Group2, Color Group3, Color Group4, 

Color Group5, Color Group6, Color Group7, Color Group8 

Default value Color Group1 

 

Setting range 

 

 

IN4(***) 

Color Group1, Color Group2, Color Group3, Color Group4, 

Color Group5, Color Group6, Color Group7, Color Group8 

Default value Color Group1 

 

Setting range 

 

 

IN5(***) 

Color Group1, Color Group2, Color Group3, Color Group4, 

Color Group5, Color Group6, Color Group7, Color Group8 

Default value Color Group1 

 

Setting range 

 

 

IN6(***) 

Color Group1, Color Group2, Color Group3, Color Group4, 

Color Group5, Color Group6, Color Group7, Color Group8 

Default value Color Group1 
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No. Sub menu Setting item Setting 

12 Config 4 Button 

Illumination 

Color Group IN  

Setting range 

 

 

IN7(***) 

Color Group1, Color Group2, Color Group3, Color Group4, 
Color Group5, Color Group6, Color Group7, Color Group8 

Default value Color Group1 

 

Setting range 

 

 

IN8(***) 

Color Group1, Color Group2, Color Group3, Color Group4, 
Color Group5, Color Group6, Color Group7, Color Group8 

Default value Color Group1 

 

Setting range 

 

 

IN9(***) 

Color Group1, Color Group2, Color Group3, Color Group4, 
Color Group5, Color Group6, Color Group7, Color Group8 

Default value Color Group1 

Color Group 

Internal 

 

Setting range 

 

 

Black 

Color Group1, Color Group2, Color Group3, Color Group4, 
Color Group5, Color Group6, Color Group7, Color Group8 

Default value Color Group1 

 

Setting range 

 

 

CBGD1 

Color Group1, Color Group2, Color Group3, Color Group4, 
Color Group5, Color Group6, Color Group7, Color Group8 

Default value Color Group1 

 

Setting range 

 

 

CBGD2 

Color Group1, Color Group2, Color Group3, Color Group4, 
Color Group5, Color Group6, Color Group7, Color Group8 

Default value Color Group1 

 

Setting range 

 

 

CBAR 

Color Group1, Color Group2, Color Group3, Color Group4, 
Color Group5, Color Group6, Color Group7, Color Group8 

Default value Color Group1 

Color Group Still  

Setting range 

 

 

Still 1V 

Color Group1, Color Group2, Color Group3, Color Group4, 
Color Group5, Color Group6, Color Group7, Color Group8 

Default value Color Group1 

 

Setting range 

 

 

Still 1K 

Color Group1, Color Group2, Color Group3, Color Group4, 
Color Group5, Color Group6, Color Group7, Color Group8 

Default value Color Group1 

 

Setting range 

 

 

Still 2V 

Color Group1, Color Group2, Color Group3, Color Group4, 
Color Group5, Color Group6, Color Group7, Color Group8 

Default value Color Group1 

 

Setting range 

 

 

Still 2K 

Color Group1, Color Group2, Color Group3, Color Group4, 
Color Group5, Color Group6, Color Group7, Color Group8 

Default value Color Group1 
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No. Sub menu Setting item Setting 

12 Config 4 Button 

Illumination 

Color Group Other  

Setting range 

 

 

CLN 

Color Group1, Color Group2, Color Group3, Color Group4, 

Color Group5, Color Group6, Color Group7, Color Group8 

Default value Color Group1 

 

Setting range 

 

 

Key Out 

Color Group1, Color Group2, Color Group3, Color Group4, 

Color Group5, Color Group6, Color Group7, Color Group8 

Default value Color Group1 

 

Setting range 

 

 

STREAM 

Color Group1, Color Group2, Color Group3, Color Group4, 

Color Group5, Color Group6, Color Group7, Color Group8 

Default value Color Group1 

 

Setting range 

AUX 

BUS 

DELEG 

Color Group1, Color Group2, Color Group3, Color Group4, 

Color Group5, Color Group6, Color Group7, Color Group8 

Default value Color Group1 

 

Setting range 

 

AUX 

SOURCE 

Color Group1, Color Group2, Color Group3, Color Group4, 

Color Group5, Color Group6, Color Group7, Color Group8 

Default value Color Group1 

Button Color 

Group1 

Setting range  

R 

0.0 to 1.5  

G 

0.0 to 1.5 

Default value 0.1 0.1 

Setting range B 0.0 to 1.5 

Default value 0.1 

Button Color 

Group2 

Setting range  

R 

0.0 to 1.5  

G 

0.0 to 1.5 

Default value 0.1 0.1 

Setting range  

B 

0.0 to 1.5 

Default value 0.0 

Button Color 

Group3 

Setting range  

R 

0.0 to 1.5  

G 

0.0 to 1.5 

Default value 0.0 0.1 

Setting range  

B 

0.0 to 1.5 

Default value 0.1 

Button Color 

Group4 

Setting range  

R 

0.0 to 1.5  

G 

0.0 to 1.5 

Default value 0.0 0.1 

Setting range  

B 

0.0 to 1.5 

Default value 0.0 

Button Color 

Group5 

Setting range  

R 

0.0 to 1.5  

G 

0.0 to 1.5 

Default value 0.1 0.0 

Setting range  

B 

0.0 to 1.5 

Default value 0.1 

Button Color 

Group6 

Setting range  

R 

0.0 to 1.5  

G 

0.0 to 1.5 

Default value 0.1 0.0 

Setting range  

B 

0.0 to 1.5 

Default value 0.0 

Button Color 

Group7 

Setting range  

R 

0.0 to 1.5  

G 

0.0 to 1.5 

Default value 0.0 0.0 

Setting range  

B 

0.0 to 1.5 

Default value 0.1 

 
  



143 

설정 메뉴표  

 

No. Sub menu Setting item Setting 

12 Config 4 Button 

Illumination 

Button Color 

Group8 

Setting range  

R 

0.0 to 1.5  

G 

0.0 to 1.5 

Default value 0.0 0.0 

Setting range  

B 

0.0 to 1.5 

Default value 0.0 

5 User Button User 1  

Setting range 

Key1 PVW, Key2 PVW, GPII-EN, GPIO-EN, AUX Trans, AUX1 

Trans, AUX2 Trans, Effect Dissolve, Capture Still1, Capture 

Still2, None, None, Shot Memory1 to 12, XPT Disable 

Default value Key1 PVW 

User 2  

Setting range 

Key1 PVW, Key2 PVW, GPII-EN, GPIO-EN, AUX Trans, AUX1 

Trans, AUX2 Trans, Effect Dissolve, Capture Still1, Capture 

Still2, None, Shot Memory1 to 12, XPT Disable 

Default value Key2 PVW 

User 3  

Setting range 

Key1 PVW, Key2 PVW, GPII-EN, GPIO-EN, AUX Trans, AUX1 

Trans, AUX2 Trans, Effect Dissolve, Capture Still1, Capture 

Still2, None, Shot Memory1 to 12, XPT Disable 

Default value Shot Memory1 

User 4  

Setting range 

Key1 PVW, Key2 PVW, GPII-EN, GPIO-EN, AUX Trans, AUX1 

Trans, AUX2 Trans, Effect Dissolve, Capture Still1, Capture 

Still2, None, Shot Memory1 to 12, XPT Disable 

Default value Shot Memory2 

User 5 Setting range Key1 PVW, Key2 PVW, GPII-EN, GPIO-EN, AUX Trans, AUX1 

Trans, AUX2 Trans, Effect Dissolve, Capture Still1, Capture 

Still2, None, Shot Memory1 to 12 

Default value Shot Memory3 

User 6  

Setting range 

Key1 PVW, Key2 PVW, GPII-EN, GPIO-EN, AUX Trans, AUX1 

Trans, AUX2 Trans, Effect Dissolve, Capture Still1, Capture 

Still2, None, Shot Memory1 to 12 

Default value Shot Memory4 

6 AUX Name AUX1 Type Setting range Default, User 

Default value Default 

AUX1 Name Setting range 32 characters can be set. 

Default value  

AUX2 Type Setting range Default, User 

Default value Default 

AUX2 Name Setting range 32 characters can be set. 

Default value  

7 GPI GPI-In Setting Setting range GPI-In 

Enable 

On, Off  

AUX Sel 

AUX1, AUX2 

Default value On AUX1 

GPI-In Port  

 

Setting range 

 

 

Port1 

Assign 

No Assign, KEY1 ON, KEY2 ON, FTB ON, BKGD AUTO, 

BKGD CUT, KEY1 AUTO, KEY1 CUT, REC 

Still1, REC Still2, AUX XPT1 to 12, RTly DSBL, GTly 

DSBL, AUX Tly DSBL 

Default value GTly DSBL 

 

 

Setting range 

 

 

Port2 

Assign 

No Assign, KEY1 ON, KEY2 ON, FTB ON, BKGD AUTO, 

BKGD CUT, KEY1 AUTO, KEY1 CUT, REC 

Still1, REC Still2, AUX XPT1 to 12, RTly DSBL, GTly 

DSBL, AUX Tly DSBL 

Default value BKGD AUTO 

 

 

Setting range 

 

 

Port3 

Assign 

No Assign, KEY1 ON, KEY2 ON, FTB ON, BKGD AUTO, 

BKGD CUT, KEY1 AUTO, KEY1 CUT, REC 

Still1, REC Still2, AUX XPT1 to 12, RTly DSBL, GTly 

DSBL, AUX Tly DSBL 

Default value BKGD CUT 
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No. Sub menu Setting item Setting 

12 Config 7 GPI GPI-In Port  

 

Setting range 

 

 

Port4 

Assign 

No Assign, KEY1 ON, KEY2 ON, FTB ON, BKGD AUTO, 

BKGD CUT, KEY1 AUTO, KEY1 CUT, REC 

Still1, REC Still2, AUX XPT1 to 12, RTly DSBL, GTly 

DSBL, AUX Tly DSBL 

Default value KEY1 ON 

 

 

Setting range 

 

 

Port5 

Assign 

No Assign, KEY1 ON, KEY2 ON, FTB ON, BKGD AUTO, 

BKGD CUT, KEY1 AUTO, KEY1 CUT, REC 

Still1, REC Still2, AUX XPT1 to 12, RTly DSBL, GTly 

DSBL, AUX Tly DSBL 

Default value KEY2 ON 

GPI-Out Setting Setting range GPI-Out 

Enable 

On, Off AUX Tly 

Sel 

AUX1, AUX2 

Default value On AUX1 

GPI-Out Port  

 

 

Setting range 

 

 

 

Port 1 

Assign 

No Assign, AUTO, CUT, KEY1 ON, KEY2 ON, FTB ON, 

BKGD AUTO, BKGD CUT, KEY1 AUTO, KEY1 CUT, RTly 

SDI IN1 to 4, RTly HDMI IN1, 2, RTly IP IN1 to 4, GTly SDI 

IN1 to 4, GTly HDMI IN1, 2, GTly IP IN1 to 4, AUXTly SDI 

IN1 to 4, AUXTly HDMI IN1, 2, AUXTly IP IN1 to 4 

Default value RTly SDI IN1 

 

 

 

Setting range 

 

 

 

Port 2 

Assign 

No Assign, AUTO, CUT, KEY1 ON, KEY2 ON, FTB ON, 
BKGD AUTO, BKGD CUT, KEY1 AUTO, KEY1 CUT, RTly 
SDI IN1 to 4, RTly HDMI IN1, 2, RTly IP IN1 to 4, GTly SDI 
IN1 to 4, GTly HDMI IN1, 2, GTly IP IN1 to 4, AUXTly SDI 
IN1 to 4, AUXTly HDMI IN1, 2, AUXTly IP IN1 to 4 

Default value RTly SDI IN2 

 

 

 

Setting range 

 

 

 

Port 3 

Assign 

No Assign, AUTO, CUT, KEY1 ON, KEY2 ON, FTB ON, 
BKGD AUTO, BKGD CUT, KEY1 AUTO, KEY1 CUT, RTly 
SDI IN1 to 4, RTly HDMI IN1, 2, RTly IP IN1 to 4, GTly SDI 
IN1 to 4, GTly HDMI IN1, 2, GTly IP IN1 to 4, AUXTly SDI 
IN1 to 4, AUXTly HDMI IN1, 2, AUXTly IP IN1 to 4 

Default value RTly SDI IN3 

 

 

 

Setting range 

 

 

 

Port 4 

Assign 

No Assign, AUTO, CUT, KEY1 ON, KEY2 ON, FTB ON, 
BKGD AUTO, BKGD CUT, KEY1 AUTO, KEY1 CUT, RTly 
SDI IN1 to 4, RTly HDMI IN1, 2, RTly IP IN1 to 4, GTly SDI 
IN1 to 4, GTly HDMI IN1, 2, GTly IP IN1 to 4, AUXTly SDI 
IN1 to 4, AUXTly HDMI IN1, 2, AUXTly IP IN1 to 4 

Default value RTly SDI IN4 

 

 

 

Setting range 

 

 

 

Port 5 

Assign 

No Assign, AUTO, CUT, KEY1 ON, KEY2 ON, FTB ON, 
BKGD AUTO, BKGD CUT, KEY1 AUTO, KEY1 CUT, RTly 
SDI IN1 to 4, RTly HDMI IN1, 2, RTly IP IN1 to 4, GTly SDI 
IN1 to 4, GTly HDMI IN1, 2, GTly IP IN1 to 4, AUXTly SDI 
IN1 to 4, AUXTly HDMI IN1, 2, AUXTly IP IN1 to 4 

Default value RTly HDMI IN2 

 

 

 

Setting range 

 

 

 

Port 6 

Assign 

No Assign, AUTO, CUT, KEY1 ON, KEY2 ON, FTB ON, 
BKGD AUTO, BKGD CUT, KEY1 AUTO, KEY1 CUT, RTly 
SDI IN1 to 4, RTly HDMI IN1, 2, RTly IP IN1 to 4, GTly SDI 
IN1 to 4, GTly HDMI IN1, 2, GTly IP IN1 to 4, AUXTly SDI 
IN1 to 4, AUXTly HDMI IN1, 2, AUXTly IP IN1 to 4 

Default value KEY1 ON 
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No. Sub menu Setting item Setting 

12 Config 7 GPI GPI-Out Port  

 

 

Setting range 

 

 

 

Port 7 

Assign 

No Assign, AUTO, CUT, KEY1 ON, KEY2 ON, FTB ON, 
BKGD AUTO, BKGD CUT, KEY1 AUTO, KEY1 CUT, RTly 
SDI IN1 to 4, RTly HDMI IN1, 2, RTly IP IN1 to 4, GTly SDI 
IN1 to 4, GTly HDMI IN1, 2, GTly IP IN1 to 4, AUXTly SDI 
IN1 to 4, AUXTly HDMI IN1, 2, AUXTly IP IN1 to 4 

Default value No Assign 

 

 

 

Setting range 

 

 

 

Port 8 

Assign 

No Assign, AUTO, CUT, KEY1 ON, KEY2 ON, FTB ON, 
BKGD AUTO, BKGD CUT, KEY1 AUTO, KEY1 CUT, RTly 
SDI IN1 to 4, RTly HDMI IN1, 2, RTly IP IN1 to 4, GTly SDI 
IN1 to 4, GTly HDMI IN1, 2, GTly IP IN1 to 4, AUXTly SDI 
IN1 to 4, AUXTly HDMI IN1, 2, AUXTly IP IN1 to 4 

Default value No Assign 

8 Key Source 

Signal 

Coupling 

Fill/Source Setting range Fill To Source, Source To Fill 

Default value Fill To Source 

IN1(***) 
Setting range 

IN1(***) to IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, Still 1K, 
Still 2V, Still 2K 

Default value IN1 

IN2(***) 
Setting range 

IN1(***) to IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, Still 1K, 
Still 2V, Still 2K 

Default value IN2 

IN3(***) 
Setting range 

IN1(***) to IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, Still 1K, 
Still 2V, Still 2K 

Default value IN3 

IN4(***) 
Setting range 

IN1(***) to IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, Still 1K, 
Still 2V, Still 2K 

Default value IN4 

IN5(***) 
Setting range 

IN1(***) to IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, Still 1K, 
Still 2V, Still 2K 

Default value IN5 

IN6(***) 
Setting range 

IN1(***) to IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, Still 1K, 
Still 2V, Still 2K 

Default value IN6 

IN7(***) 
Setting range 

IN1(***) to IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, Still 1K, 
Still 2V, Still 2K 

Default value IN7 

IN8(***) 
Setting range 

IN1(***) to IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, Still 1K, 
Still 2V, Still 2K 

Default value IN8 

IN9(***) 
Setting range 

IN1(***) to IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, Still 1K, 
Still 2V, Still 2K 

Default value IN9 

Black 
Setting range 

IN1(***) to IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, Still 1K, 
Still 2V, Still 2K 

Default value Black 
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No. Sub menu Setting item Setting 

12 Config 8 Key Source 

Signal 

Coupling 

CBGD 1 
Setting range 

IN1(***) to IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, Still 1K, 
Still 2V, Still 2K 

Default value CBGD 1 

CBGD 2 
Setting range 

IN1(***) to IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, Still 1K, 
Still 2V, Still 2K 

Default value CBGD 2 

CBAR 
Setting range 

IN1(***) to IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, Still 1K, 
Still 2V, Still 2K 

Default value CBAR 

Still 1V 
Setting range 

IN1(***) to IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, Still 1K, 
Still 2V, Still 2K 

Default value Still 1V 

Still 1K 
Setting range 

IN1(***) to IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, Still 1K, 
Still 2V, Still 2K 

Default value Still 1K 

Still 2V 
Setting range 

IN1(***) to IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, Still 1K, 
Still 2V, Still 2K 

Default value Still 2V 

Still 2K 
Setting range 

IN1(***) to IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, Still 1K, 
Still 2V, Still 2K 

Default value Still 2K 

9 System Menu 

Lock 

 Setting range On, Off 

Default value Off 
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No. Sub menu Setting item Setting 

13 System 1 System Format  
Setting range 

1080/59.94p, 50p, 59.94i, 50i, 29.97p, 25p, 24p, 23.98p, 

720/59.94p, 50p 

Default value 1080/59.94p 

2 Reference Reference Select Setting range BB, Tri-level Sync, Internal 

Default value BB 

Status Setting range  

Default value  

3 Output Phase System Setting range 0H, 1H 

Default value 0H 

H-Phase Setting range – 0.50 to 0.49 

Default value 0.00 

V-Phase Setting range –100 to 100 

Default value 0 

4 User Auth User Name Setting range Can be set between 1 and 32 characters. 

Default value  

Password Setting range ******** (Can be set between 1 and 32 characters.) 

Default value  

5 Alarm Power Setting range Alarm, No Alarm 

Default value  

Fan Setting range Alarm, No Alarm 

Default value  

Temperature Setting range Alarm, No Alarm 

Default value  

6 Tally Settings Tally Mode Setting range Off, On 

Default value On 

Tally Target  

 

Setting range 

 

 

Red 

Tally 

Off, PGM, CLN, Key 

Out, AUX1, AUX2, IP 

OUT1, IP OUT2 

 

 

Green 

Tally 

Off, PGM, PVW, CLN, 
Key Out, AUX1, AUX2, 
IP OUT1, IP OUT2 

Default value PGM PVW 

7 Date/Time Date Setting Setting range yyyy / mm / dd 

Default value  

Time Setting Setting range hh : mm : ss 

Default value  

8 Initial Initial Settings Setting range Execute 

Default value  

Initial Fader Setting range Execute 

Default value  

9 System 

Information 

System Version Setting range Display only 

Default value  

System Core1 

Version 

Setting range Display only 

Default value  

System Core2 

Version 

Setting range Display only 

Default value  

System Core 

Update 

Setting range Execute 

Default value  
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No. Sub menu Setting item Setting 

14 Project 1 Project File Project 1 Setting range 
Protect 

Off, On 
Load 

Execute 

Default value Off  

Setting range 
Save 

Execute 
Delete 

Execute 

Default value   

Setting range 
Name 

32 characters 
Date 

Display only 

Default value   

Project 2 Setting range 
Protect 

Off, On 
Load 

Execute 

Default value Off  

Setting range 
Save 

Execute 
Delete 

Execute 

Default value   

Setting range  

Name 
32 characters  

Date 
Display only 

Default value   

Project 3 Setting range 
Protect 

Off, On 
Load 

Execute 

Default value Off  

Setting range 
Save 

Execute 
Delete 

Execute 

Default value   

Setting range 
Name 

32 characters 
Date 

Display only 

Default value   

2 Last Load File 

Name 

 Setting range I: *****, U: *****, L: ***** 

Default value  

3 Last Load Date  Setting range yyyy/mm/dd hh:mm 

Default value  
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No. Sub menu Setting item Setting 

15 Ancillary/Audio 1 Ancillary AUX Setting range Off, On 

Default value On 

PGM Setting range Off, On 

Default value On 

PVW Setting range Off, On 

Default value On 

CLN Setting range Off, On 

Default value On 

MV Setting range PGM, PVW, Off 

Default value Off 

2 Audio Assign AUX1 Setting range IN1(***) to IN9(***), Analog, Follow Video, OFF 

Default value Follow Video 

AUX2 Setting range IN1(***) to IN9(***), Analog, Follow Video, OFF 

Default value Follow Video 

PGM Setting range IN1(***) to IN9(***), Analog, Follow Video, OFF 

Default value Follow Video 

PVW Setting range IN1(***) to IN9(***), Analog, Follow Video, OFF 

Default value Follow Video 

CLN Setting range IN1(***) to IN9(***), Analog, Follow Video, OFF 

Default value Follow Video 

3 Analog IN Audio Setting range Off, On 

Default value Off 

Input Type Setting range LINE, MIC 

Default value LINE 

Gain 
Setting range 

–36dB, –33dB, –30dB, –27dB, –24dB, –21dB, –18dB, –15dB, 

–12dB, –9dB, –6dB, –3dB, 0dB, 3dB, 6dB, 9dB, 12dB 

Default value 0dB 

Delay(ms) Setting range 0 to 512 

Default value 0 

4 Analog OUT Assign Setting range PGM, PVW, AUX1, AUX2, CLN 

Default value PGM 

Mute Setting range Off, On 

Default value Off 

Volume Setting range Displays the value for the monitor volume dial on the front panel 
area of this unit. The range is between 0 and 100. 

Default value  

16 Network 1 LAN IP Address Setting range 0 to 255.255.255.255 

Default value 192.168.0.8 

Subnet Mask Setting range 0 to 255.255.255.255 

Default value 255.255.255.0 

Default Gateway Setting range 0 to 255.255.255.255 

Default value 192.168.0.1 

MAC Address Setting range – 

Default value – 

2 Primary DNS IP Address Setting range 0 to 255.255.255.255 

Default value – 

3 Secondary DNS IP Address Setting range 0 to 255.255.255.255 

Default value – 



150 

 

 
 

제작 : ㈜디브이네스트 1544-5596 

No. Sub menu Setting item Setting 

17 External 

Interfaces 

1 External Panel 

Information 

Active  Setting range Disable, Enable 

Default value Disable 

Port No  Setting range 62000 to 65535 

Default value 62010 

2 External Panel 

IP 

Shot Memory 

Recall 

BKGD Setting range 
Target 

Off, On 
XPT 

Off, On 

Default value Off Off 

Key1 Setting range 
Target 

Off, On 
XPT 

Off, On 

Default value Off Off 

Key2 Setting range 
Target 

Off, On 
XPT 

Off, On 

Default value Off Off 

AUX1 Setting range Off, On 

Default value Off 

AUX2 Setting range Off, On 

Default value Off 

CBGD Setting range Off, On 

Default value Off 

XPT Setting range Off, On 

Default value Off 

3 External 

Control 

Switcher 

Active  Setting range Disable, Enable 

Default value Disable 

Port No  Setting range 62000 to 65535 

Default value 62000 

Interval Time  Setting range 0ms, 16ms, 32ms, 48ms, 64ms, 80ms 

Default value 16ms 

Response  Setting range On, Off 

Default value On 

4 External 

Control AUX 

Panel 

Port No  Setting range 60000 to 65535 

Default value 65000 

IP Address1  Setting range 0 to 255.255.255.255 

Default value 0.0.0.0 

IP Address2  Setting range 0 to 255.255.255.255 

Default value 0.0.0.0 

IP Address3  Setting range 0 to 255.255.255.255 

Default value 0.0.0.0 

IP Address4  Setting range 0 to 255.255.255.255 

Default value 0.0.0.0 

IP Address5  Setting range 0 to 255.255.255.255 

Default value 0.0.0.0 

IP Address6  Setting range 0 to 255.255.255.255 

Default value 0.0.0.0 

IP Address7  Setting range 0 to 255.255.255.255 

Default value 0.0.0.0 

IP Address8  Setting range 0 to 255.255.255.255 

Default value 0.0.0.0 

IP Address9  Setting range 0 to 255.255.255.255 

Default value 0.0.0.0 

IP Address10  Setting range 0 to 255.255.255.255 

Default value 0.0.0.0 
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No. Sub menu Setting item Setting 

17 External 

Interfaces 

4 External 

Control AUX 

Panel 

IP Address11  Setting range 0 to 255.255.255.255 

Default value 0.0.0.0 

IP Address12  Setting range 0 to 255.255.255.255 

Default value 0.0.0.0 

IP Address13  Setting range 0 to 255.255.255.255 

Default value 0.0.0.0 

IP Address14  Setting range 0 to 255.255.255.255 

Default value 0.0.0.0 

IP Address15  Setting range 0 to 255.255.255.255 

Default value 0.0.0.0 

IP Address16  Setting range 0 to 255.255.255.255 

Default value 0.0.0.0 

IP Address17  Setting range 0 to 255.255.255.255 

Default value 0.0.0.0 

IP Address18  Setting range 0 to 255.255.255.255 

Default value 0.0.0.0 

IP Address19  Setting range 0 to 255.255.255.255 

Default value 0.0.0.0 

IP Address20  Setting range 0 to 255.255.255.255 

Default value 0.0.0.0 

18 USB Memory 1 Load Load Type  Setting range Still1, Still2, Project, Update 

Default value Still1 

Load  Setting range Execute 

Default value  

2 Save Save Type  Setting range Still1, Still2, Project, Log 

Default value Project 

Setup  Setting range On, Off 

Default value On 

Shot  Setting range On, Off 

Default value On 

Still  Setting range On, Off 

Default value Off 

File Format  Setting range bmp, tga, png, jpg, tif, gif 

Default value png 

Save  Setting range Execute 

Default value  

3 Free   Setting range Free space [KB/MB/GB] 

Default value  

4 Total   Setting range Total space [KB/MB/GB] 

Default value  

5 Unmount   Setting range Execute 

Default value  

6 Format   Setting range Execute 

Default value  
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No. Sub menu Setting item Setting 

19 Color Adjust 1 Target  Setting range IN1(***) to IN5(***) 

Default value IN1(***) 

2 Parameter No  Setting range 1 to 10 

Default value 1 

3 Marker  Setting range Off, On 

Default value Off 

4 Capture for 

Master 

 Setting range Execute 

Default value  

5 Adjust Target  Setting range Execute 

Default value  

6 Enable Color 

Adjust 

 Setting range Disable, Enable 

Default value Disable 

7 Left  Setting range –50.00 to 50.00 (Left<Right) 

Default value –50.00 

8 Top  Setting range –50.00 to 50.00 (Top>Bottom) 

Default value 50.00 

9 Bottom  Setting range –50.00 to 50.00 (Top>Bottom) 

Default value –50.00 

10 Right  Setting range –50.00 to 50.00 (Left<Right) 

Default value 50.00 

11 Set Capture 

Points 

 Setting range Execute 

Default value  

12 Points Point 1 to 24 Setting range  

X-Position 

–50.00 to 50.00 

Default value 
Value generated by Left = –50.00, Top = 50.00, 
Bottom = –50.00, Right = 50.00 (full-screen use) 

Setting range  

Y-Position 

–50.00 to 50.00 

Default value 
Value generated by Left = –50.00, Top = 50.00, 
Bottom = –50.00, Right = 50.00 (full-screen use) 

13 Parameters Parameter 1 to 

10 

Setting range 
Master 

IN1 to 5 

Default value  

Setting range 
Name 

Can set up to 16 characters. 

Default value  
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부록 (용어집) 
 

다음은 이 설명서에서 사용된 용어입니다. 
 

Word Explanation 

AB Bus system 버스 제어 모드 전환을 실행하여 A 버스와 B 버스 신호가 교대로 프로그램 영상에 출력됩니다. 

Ancillary Data 비디오 시리얼 인터페이스의 데이터 스트림 내부에서 전송되는 비디오 신호를 제외한 보조 데이터. 

수직 블랭킹 구간에 중첩되는 데이터를 VANC(Vacondary Data)라 합니다. 

Aspect ratio 이미지 또는 화면의 수평 및 수직 크기 사이의 비율입니다. HD 형식의 경우 16:9, SD 형식의 

경우 4:3입니다. 

AUX 

[Auxiliary Bus] 

메인 라인 출력 신호 이외의 신호로 전환할 수 있는 예비 버스. 

BB 

[Black burst] 

Black Burst signals의 줄임말. gen-lock의 기준 신호로 사용되는 전체 화면 블랙 레벨 합성 신호. 

Border 와이프 또는 키의 가장자리에 추가되는 영역 또는 여백입니다. 

테두리 너비와 색상은 조절될 수 있습니다. 테두리 주변의 영역의 초점을 푸는 것은 부드러운 효과라고 

불립니다. 

Chroma key 비디오 신호의 색상 정보를 기반으로 키 신호를 생성하고 키를 결합하는 기능을 말합니다. 

Clip 키 신호가 키 소스에서 생성될 때 휘도의 임계값 레벨입니다. 

Color Background 내부 색상 발생기에서 출력되어 배경 이미지로 사용되는 신호입니다. 

Cut 디스플레이가 즉시 다음 이미지로 전환되는 효과를 말합니다. 

Density 키 신호의 밀도를 조정하는 데 사용되는 매개 변수입니다. 

Down Converter 4K 형식의 소스를 2K/HD 형식으로 변환하는 기능입니다. 

Embedded Audio 이는 비디오 직렬 인터페이스의 데이터 스트림 내부에서 전송되는 오디오 데이터 패킷을 말합니다. 

Flip Flop system 

(PGM/PST system) 

버스 제어 모드. 프로그램 버스에 의해 선택된 신호는 항상 프로그램 영상으로 출력됩니다. 전환을 

실행함으로써, 프로그램 버스와 미리 설정된 버스 신호가 전환됩니다. 

Frame Synchronizer 비동기 비디오 입력 신호의 동기화에 일치하는 기능입니다. 

Freeze 비디오 신호를 일시 중지하는 기능입니다. 

FTB [Fade to Black] 배경 이미지가 검은색 화면으로 희미해지는 효과입니다. 

Genlock 외부 동기 신호를 기준으로 비디오 신호를 동기화하는 기능. 

GPI [General Purpose Interface] 외부 소스로부터의 자동 전환을 제어하는 인터페이스 신호입니다. 

Hue 비디오 신호의 색조. 

Key Edge 키 가장자리에 추가된 테두리 또는 그림자입니다. 

Key Fill 키 조합 처리를 사용하여 키 신호가 빈 영역을 채우는 신호입니다. 

Key Gain 키 신호의 진폭을 조정하는 데 사용되는 매개 변수입니다. 

Key Invert 키 신호를 반전시키는 기능입니다. 

Key Mask 박스 패턴 등을 이용하여 키 결합을 위한 영역을 지정하는 기능입니다. 키 신호의 영역 중 일부만을 

사용하는 경우 불필요한 영역을 마스킹한 상태에서 키 결합을 실행합니다. 

Key Source 키 신호를 만들기 위한 비디오 신호. 
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Word Explanation 

Line Synchronizer 입력 영상 신호 위상을 수평 동기 기준 신호 위상으로 자동 조정하는 기능입니다. 

Linear Key 단색 키 신호를 사용하여 키를 결합하는 기능과 윤곽의 눈금을 기준으로 합니다. 

Lum [Luminance] 비디오 신호의 밝기 부분. 

Luminance Key 비디오 신호의 휘도(휘도) 정보를 기반으로 키 신호를 생성하여 키를 결합하는 기능. 

ME [Mix Effect] 여러 비디오 신호를 조합하여 믹스, 와이퍼, 키 및 기타 비디오 신호를 생성하는 비디오 효과 장치. 

Mix 한 이미지와 다음 이미지가 겹쳐서 생기는 그림 바꾸기 효과를 '디졸브(Dissolve)'라고도 

합니다. 

Multi View Display 이 기능은 여러 소스를 조합하여 한 화면에 표시하는 것입니다. PGM, PVW와 입력된 재료를 한 

화면에서 동시에 미리 볼 수 있습니다. 

PinP [Picture in Picture] 이 기능은 배경 이미지에 보조 화면 이미지를 작은 크기로 나타나게 합니다. 

PVW[Preview] 다음 전환 후 출력될 영상을 미리 확인하기 위한 기능. 영상은 PVW 시스템에서 출력됩니다. 

PGM[Program Bus] 항상 프로그램 출력 신호를 전달하는 버스. 

PST [Preset Bus] 프로그램을 전송하는 버스는 다음 백그라운드 전환 후에 신호를 출력합니다. 

Sat [Saturation] 이는 영상 신호의 색차 수준의 강도를 의미합니다. 

SDI [Serial Digital Interface] 다양한 SD 및 HD 형식의 비디오 신호가 단일 동축 케이블을 따라 전송되는 표준. 

Self Key 키를 조합하기 위한 키 채우기 신호에서 키 신호를 생성하는 기능입니다. 

Setup Data 제어판 상태를 저장하고 호출할 수 있는 메모리입니다. 

버튼 선택 상태는 물론 테두리, 색상 및 기타 설정 정보를 이 메모리에 저장할 수 있습니다. 

Tally 입력된 신호의 프로그램 출력 상태를 외부 장치로 출력하는 신호를 탈리(Tally)라고 합니다. 

Transition 한 이미지에서 다른 이미지로 전환되는 기능입니다. 

스위칭 중 이미지에 대해 와이프, 믹스 및 기타 효과를 사용할 수 있습니다. 

Tri-level Sync HD 포맷에 사용되는 동기화 신호입니다. 

Trimming 이는 PinP 기능을 사용하여 결합된 영상의 상단, 하단, 좌측 및/또는 우측에 있는 불필요한 부분을 

제거하는 기능입니다. 

Up Converter 2K/HD 형식의 재료를 4K 형식으로 변환하여 높은 해상도를 제공하는 기능입니다. 

Video Memory 키 신호가 있는 영상(정지 영상)을 저장할 수 있는 메모리입니다. 

Wipe 미리 선택된 패턴을 이용하여 둘 사이의 경계를 이동시킴에 따라 하나의 이미지가 점차 다른 이미지로 

대체되는 비디오 효과. 



155 

색인 

 

색인 
 

A 
ALARM indicator ............................................................ 18 
Ancillary/Audio ............................................................. 149 

Analog IN .......................................................................... 149 

Analog OUT ........................................................................ 149 

Ancillary ................................................................................ 149 

Audio Assign ..................................................................... 149 

Audio input connector................................................... 21 
AUTO button .................................................................. 20 
AUX bus crosspoint buttons ........................................ 20 
AUX bus selector buttons ............................................ 20 

B 
Bus tally indicators ........................................................ 20 

C 
CBGD ....................................................................... 121, 122 

CBGD Main .................... ............... ..................................... 121 

CBGD Move ....................... .............. ................................. 122 

CBGD Select ...... ............... ................................................. 121 

CBGD Sub ................................. ............... .......................... 121 

CBGD Wash .................................................... ............... .... 121 

CBGD Wave .......... .............. .............................................. 122 

ChromaKey .............. ........... .............................................. 124 

Cancel ................... ............... .............................................. 124 

Marker ..................... .............. ............................................ 124 

Marker Aspect ....... ............ .............................................. 124 

Marker Position ......... ............ .......................................... 124 

Radius ......................... ............... ........................................ 124 

Ref Adjust ................. ............. ........................................... 124 

Sample ....................... ............... ......................................... 124 

Soft ............................. ............... ......................................... 124 

Y-Influence ................ ............ ........................................... 124 

Color Adjust ................. ........... .......................................... 152 

Adjust Target .............. ............. ......................................... 152 

Bottom ......................... .............. ........................................ 152 

Capture for Master ..... ............ ......................................... 152 

Enable Color Adjust ........ ........... ..................................... 152 

Left ............................ ................ .......................................... 152 

Marker ....................... ............... .......................................... 152 

Parameter No .......... ............. ............................................ 152 

Parameters ................... .............. ....................................... 152 

Points ......................... ................ ......................................... 152 

Right ................................ ................ .................................... 152 

Set Capture Points ........ ............ ...................................... 152 

Target ............................... ............... ................................... 152 

Top ................................. ............... ...................................... 152 
 

Config ............................... 140, 141, 142, 143, 144, 145, 146 

AUX Name ........................................................................ 143 

Button Illumination ................................ 140, 141, 142, 143 

CBAR .................................................................................. 140 

GPI ..................................................................... 143, 144, 145 

Key1/2 Link ....................................................................... 140 

Key Source Signal Coupling................................ 145, 146 

Operate ............................................................................. 140 

System Menu Lock.......................................................... 146 

User Button ...................................................................... 143 

Cooling fan ...................................................................... 22 
CUT button ..................................................................... 19 

D 
Dedicated crosspoint buttons for the AUX bus .........20 

E 
EXIT button .................................................................... 19 
External Interfaces ............................................... 150, 151 

External Control AUX Panel ........................................ 150, 

151 

External Control Switcher ............................................. 150 

External Panel Information ........................................... 150 

External Panel IP ............................................................. 150 

F 
Fader lever ......................................................................20 
FTB ON button ............................................................... 19 

G 
Ground connector .......................................................... 22 

H 
HDMI IN connectors .......................................................21 
HDMI OUT connector ..................................................... 21 
Headphone connector ................................................... 23 
Hole for fitting the cable clamp ................................... 23 



156 

 

 
 

제작 : ㈜디브이네스트 1544-5596 

I 
Input .............................................................................. 130 

IN1(SDI1/HDMI1) ................................................................ 130 

IN2(SDI IN2) ....................................................................... 130 

IN3(SDI IN3) ....................................................................... 130 

IN4(SDI IN4) ....................................................................... 130 

IN5(HDMI IN2) ................................................................... 130 

IN6(IP IN1) ........................................................................... 130 

IN7(IP IN2) .......................................................................... 130 

IN8(IP IN3) .......................................................................... 130 

IN9(IP IN4) .......................................................................... 130 

K 
Key ................................................................. 122, 123, 124 

Edge ............................................................................. 122, 123 

Fill ........................................................................................... 122 

Fill Matte .............................................................................. 122 

Key Adjust ............................................................................ 122 

Key Priority .......................................................................... 124 

Key Select ............................................................................ 122 

Key Signal Coupling ........................................................... 124 

Key Type .............................................................................. 122 

Mask ...................................................................................... 123 

PinP............................................................................... 123, 124 

PVW ....................................................................................... 122 

KEY 1 ON button .................................................................. 19 

KEY 2 ON button ............................................................ 19 
 

L 
LAN cable ............................................................................ 103 

LAN connector .................................................................... 22 

 

M 
 

 

MENU button .................................................................. 19 
MIX/WIPE switching button ........................................ 20 
Monitor volume dial .......................................................23 
MultiView ...................................................... 128, 129, 130 

Display ................................................................................. 130 

Green Tally........................................................................... 129 

MV Character ...................................................................... 129 

MV Frame ............................................................................ 129 

MV Label .............................................................................. 129 

Red Tally............................................................................... 129 

Size ........................................................................................ 128 

Source Select ............................................................. 128, 129 

Split........................................................................................ 128 

N 
 

 

Network ........................................................................ 149 
LAN ....................................................................................... 149 

Primary DNS ....................................................................... 149 

Secondary DNS .................................................................. 149 

O 
 

 

OSD menu ....................................................................... 26 
 
OSD/TIME dial ................................................................ 19 
 
Output ........................................................................... 136 

OUT1(SDI OUT1) ................................................................. 136 

OUT2(SDI OUT2) ............................................................... 136 

OUT3(HDMI OUT) .............................................................. 136 

OUT4(IP OUT1) ................................................................... 136 

OUT5(IP OUT2) ................................................................... 136 

OUT6(UVC OUT) ................................................................ 136 

P 
PGM bus crosspoint buttons ........................................20 
POWER indicator ........................................................... 18 
Power switch ................................................................... 21 
Project ........................................................................... 148 

Last Load Date ................................................................. 148 

Last Load File Name ....................................................... 148 

Project File ........................................................................ 148 

PST bus crosspoint buttons .........................................20 

R  
Reference input connector ............................................ 21 

S 
SDI IN connectors ...........................................................21 
SDI OUT connectors ....................................................... 21 
Security slot .................................................................... 22 
SERVICE switch .............................................................. 22 
SHIFT button .................................................................. 19 
Shot Memory ................................................................ 126 

Effect ..........................................................................126 

Hue Path ........................................................................... 126 



157 

색인 

 

Target Select .................................................................... 126 

XPT Disable ...................................................................... 126 

Shot Memory button ..................................................... 19 
Still ................................................................................. 125 

Capture .............................................................................. 125 

Capture Setting ................................................................ 125 

Key Status ......................................................................... 125 

Still Select ......................................................................... 125 

Test Pattern ...................................................................... 125 

STREAM button .............................................................. 18 

System .......................................................................... 147 
Alarm ..................................................................................147 

Date/Time ..........................................................................147 

Initial ...................................................................................147 

Output Phase ....................................................................147 

Reference ...........................................................................147 

System Format .................................................................147 

System Information .........................................................147 

Tally Settings .....................................................................147 

User Auth ...............................................................................147 

T 
TALLY/GPI connector ....................................................... 22 

 

Time ...................................................................................... 125 

AUX1 Bus Trans ................................................................... 125 

AUX2 Bus Trans .................................................................. 125 

BKGD .................................................................................... 125 

Effect Dissolve .............................................................. 125 

FTB ........................................................................................ 125 

Key1 ....................................................................................... 125 

Key2 ...................................................................................... 125 

U 
USB connector .............................................................. 21, 22 
USB Memory ...................................................................... 151 

Format .................................................................................... 151 

Free ......................................................................................... 151 

Load ........................................................................................ 151 

Save ......................................................................................... 151 

Total ........................................................................................ 151 

Unmount ................................................................................ 151 

USER buttons ..................................................................... 18 

W 
WIPE ................................................................................... 121 

BKGD Pattern ........................................................................ 121 

BKGD Transition ................................................................... 121 

Key1 Pattern .......................................................................... 121 

Key1 Transition ...................................................................... 121 

X 
XPT Assign ........................................................................ 127 

Switch Timing ...................................................................... 127 

XPT1 ...................................................................................... 127 

XPT2 ...................................................................................... 127 

XPT3 ...................................................................................... 127 

XPT4...................................................................................... 127 

XPT5 ...................................................................................... 127 

XPT6...................................................................................... 127 

XPT7 ...................................................................................... 127 

XPT8 ..................................................................................... 127 

XPT9...................................................................................... 127 

XPT10.................................................................................... 127 

XPT11 ..................................................................................... 127 

XPT12 .................................................................................... 127 

  

 

 

 

 

 

 

 

 

 

  



158 

 

 
 

제작 : ㈜디브이네스트 1544-5596 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Web Site: https://pro-av.panasonic.net/en/ 

© Panasonic Entertainment & Communication Co., Ltd. 2023-2024 

 


	사전 숙지 내용
	미국 및 캐나다의 경우
	For AV-HSW10P
	AV-HSW10E의 경우
	안전을 위해 다음 텍스트를 주의 깊게 읽으십시오. 이 제품에는 3가지 유형의 AC 주전원 케이블이 장착되어 있습니다.
	영국만 해당


	장치 구매자/사용자에 대한 EMC 고지 사항
	1. 위의 표준을 준수하기 위한 전제 조건
	<2> 연결 케이블은 기기의 용도에 맞는 차폐 케이블을 사용하십시오.
	2. 성능 수준
	배터리 기호(하단 기호)에 대한 참고 사항:

	ІНФОРМАЦІЯ ПРО ПІДТВЕРДЖЕННЯ ВІДПОВІДНОСТІ ПРОДУКТУ
	Information for Users in India
	Information on hazardous constituents as specified in the E-Waste (Management) Rules in electrical and electronic equipment. Declaration of Conformity with the requirements of the E-Waste (Management) Rules limits with respect to Lead, Mercury, Cadmiu...
	The content of hazardous substance with the exemption of the applications listed in the E-Waste (Management) Rules:

	사용하기 전에
	개요
	등급 표시에 관하여
	보증 면책 조항
	네트워크 보안

	사용시 주의사항
	 조심스럽게 다루십시오.
	 0  C - 40  C (32  F - 104  F) 사이의 온도에서 제품을 사용하십시오.
	 케이블을 연결하거나 분리하기 전에 전원을 끄십시오.
	 습기와 먼지를 피하십시오.
	 정비
	  제품을 폐기해야 하는 경우
	 소모품에 관하여
	냉각팬:
	AC 어댑터:

	 프로덕션 제작시 준수해야 할 주의 사항

	설치시 주의 사항
	  "사전 숙지 내용"에 제시된 요점에 주의를 기울이는 것 외에도 다음 예방 조치를 준수해야 합니다.
	전원 공급 장치 연결
	조심스럽게 다루세요!
	제품 내부에 이물질이 들어가지 않도록 하세요!
	최적의 설치 위치 선택


	기능
	컴팩트한 디자인, 풍부한 입력 및 출력
	여러 형식 지원

	액세서리
	케이블 클램프 부착
	케이블 클램프 분리
	1 1  을 잡고 2 방향으로 당깁니다.

	AC 어댑터 고정

	구성과 그 기능
	제어판
	[키 1], [키 2]:
	[AUX 1], [AUX 2]:
	[MV]:
	[PGM/PVW]:

	후면 패널 영역
	오른쪽 패널 영역
	왼쪽 패널 영역
	전면 패널 영역
	㊵ 모니터 볼륨 다이얼 [LEVEL]


	운영 전 준비
	장치의 전원 켜기 및 끄기
	1 [POWER] 스위치를 ON 위치로 설정합니다.
	1 [POWER] 스위치를 OFF 위치로 설정합니다.

	비디오 출력 확인
	SDI 모니터에 OSD 메뉴 표시하기
	1. 장치의 전원을 끕니다.
	3. [MENU] 버튼을 길게 누릅니다.


	OSD(On-Screen Display) 메뉴 조작
	메뉴 구성 및 메뉴 간 이동
	메인 메뉴:
	하위 메뉴:
	하위 메뉴 항목에 대해 선택한 설정 입력:
	하위 메뉴에서 상위 계층의 하위 메뉴로 또는 주 메뉴로 이동

	하위 메뉴를 사용한 작업
	1. 설정 항목이 있는 라인을 선택합니다.
	2. 설정을 변경합니다.
	[설정을 기본값으로 되돌리기]


	문자열 입력
	이 사용 설명서에 사용된 표시
	메뉴 위임 기능
	버스 상태 표시


	기본 운영
	배경 전환
	버스 선택
	SHIFT 기능을 사용하여 버스 선택
	버스 모드 선택
	전환 모드 선택
	수동 전환
	자동 전환
	컷 전환

	와이프 (Wipe)
	와이프 패턴 선택
	와이프 방향 선택
	[Normal]을 선택한 경우:
	[Reverse]를 선택한 경우:
	[N/R]을 선택한 경우:

	와이프 세부 항목(테두리, 소프트 효과)
	■ 미리 설정된 색상을 호출하려면

	와이프 시작 위치 설정

	키 (Key)
	<키 구성 작동 방식>
	키 유형 선택
	키 구성 요소 선택
	<키 소스 신호 선택>
	<키 신호 커플링>
	<소스로 채우기(Fill to Source)>
	<채우기 할 소스(Source to Fill)>
	■ 미리 설정된 색상을 호출하려면

	키 전환
	<와이프 패턴 표>
	<패턴 예>

	키 미리보기
	PVW의 배경 (Background of the PVW)

	휘도 키와 선형 키 조정
	크로마 키 조정
	■ 마커 (Maker)
	■ 마커 위치 (Maker Position)
	■ 샘플 (Sample)
	■ 참조 조정 (Ref Adjust)
	■ Y-인플루언스
	■ 반지름 (Radius)
	■ 부드러움 (Soft)
	■ 취소 (Cancel)

	키 세부 설정
	■ 미리 설정된 색상을 호출하려면

	키 신호 마스킹
	우선 순위 설정

	PinP (픽처 인 픽처)
	PinP 채널 및 소스 선택
	모양 선택
	PinP 조정
	Key1 PinP 및 Key2 PinP 연결
	PinP 세부 설정
	■ 미리 설정된 색상을 호출하려면

	트리밍 설정

	키 링크 (Key Link)
	FTB (페이드 투 블랙)
	내부 색상 신호 (Internal color signal)
	색상 배경 설정
	■ 미리 설정된 색상을 호출하려면

	Wash 효과 설정

	내부 컬러바 신호 (Internal color bar signal)
	컬러 바 신호 선택
	색상 막대 신호 이동 설정
	테스트 톤 설정

	내장 테스트 패턴 신호
	<시스템 모드가 1080일 때의 테스트 패턴>

	AUX 출력 전환
	AUX 출력 소스 선택
	AUX1/2 트랜지션
	AUX1/2 전환에 대한 활성화/비활성화 설정

	샷 메모리 (Shot memories)
	등록하고 불러올 수 있는 메모리 항목
	메모리에 설정 저장하기(Store)
	메모리에 저장된 작업 불러오기(Recall)
	메모리에 저장된 작업 삭제하기(Delete)
	등록할 대상과 재생할 대상 선택
	설정 효과 디졸브(샷 메모리)

	비디오 메모리
	■ 비디오 메모리 입력/출력
	정지 이미지 촬영하기(스틸)

	USB 메모리
	비디오 메모리 (정지 이미지 데이터: Still1, Still2):
	<지원되는 파일 형식>
	<적용 가능한 크기>

	프로젝트 파일 데이터(Project):
	업데이트용 소프트웨어(Update):
	로그 파일(Log):
	<데이터 폴더 구성>

	USB 메모리 포맷
	USB 메모리에 데이터 저장하기
	USB 메모리에서 데이터 로드
	USB 메모리 정보 표시

	내부 저장소
	프로젝트 파일 관리 화면
	프로젝트 파일을 내부 저장소에 저장
	내부 저장소에서 프로젝트 파일 로드
	내부 저장소에서 프로젝트 파일 삭제
	내부 저장소에 저장된 프로젝트 파일의 파일 이름 변경
	<파일 이름에 사용할 수 있는 문자>



	입력 / 출력 신호 설정
	입력 신호 설정
	<입력 신호별 설정 목록>
	익스크루시브 입력 커넥터에 대한 설정
	입력 신호 상태 확인
	프레임 동기화(FS) 장치 설정
	지연 시간 설정
	입력 신호 프리즈 (Freez)
	제한(Limited) 설정
	소스 이름 설정
	<파일 이름에 사용할 수 있는 문자>

	업 컨버터 설정
	색상 보정 (Color Corrector)
	HDMI 입력 신호 설정
	<HDMI 입력 신호 호환성 차트>

	HDMI 입력 신호 정보 표시하기
	<HDMI 형식 지원>

	SRT 입력 신호 설정
	SRT 입력 신호 정보 표시
	소스 이름 설정(SRT 입력 신호)
	<파일 이름에 사용할 수 있는 문자>


	NDI/NDI|HX
	NDIHX
	NDI 입력 신호 설정
	수신 프로토콜 설정
	NDI 입력 신호 정보 표시
	소스 이름 설정(NDI 입력 신호)
	알파 채널이 있는 소스에 대한 입력 설정
	그룹 설정
	<파일 이름에 사용할 수 있는 문자>

	디스커버리 서버 (Discovery Server) 설정
	RTSP 포트 설정
	<파일 이름에 사용할 수 있는 문자>

	아날로그 오디오 입력 신호 설정

	출력 신호 설정
	<출력 (공통)>
	<출력 신호별 설정 목록>
	출력 신호 할당하기
	HDMI 출력 신호 설정
	SRT 출력 신호 설정
	<대상 URL에 사용할 수 있는 문자입니다>
	<스트림 ID에 사용할 수 있는 문자입니다>

	NDI 출력 신호 설정
	NDI | HX
	NDI 출력 신호 할당
	일반 NDI 출력 신호 설정
	NDI 전송 프로토콜 설정
	NDI 멀티캐스트 설정
	NDI 그룹 설정
	디스커버리 서버 (Discovery Server) 설정
	RTMP 출력 신호 설정
	<파일 이름에 사용할 수 있는 문자>

	UVC 출력 신호 설정
	아날로그 오디오 출력 설정
	SRT/RTMP 신호에 대한 전송 작업

	동기 신호 설정
	출력 신호 위상 조정
	AUX 버스, PGM 및 PVW에 대한 보조 설정
	AUX 버스, PGM 및 PVW에 대한 오디오 설정

	멀티뷰 디스플레이 설정
	화면 레이아웃 설정
	<디스플레이 모드>

	분할 프레임과 문자 설정
	탈리(Tally) 표시 설정
	소스 이름 변경(입력 신호)
	<파일 이름에 사용할 수 있는 문자>

	소스 이름 변경(출력 신호)
	<파일 이름에 사용할 수 있는 문자>
	<파일

	레벨 미터 설정
	입력 신호 표시 설정
	"F" 표시:
	" ! " 마크:

	마커 설정

	시스템 설정
	시스템 형식 설정
	크로스포인트 설정
	크로스포인트에 신호 할당
	크로스포인트 전환 설정

	버튼 할당
	사용자 버튼 설정
	■ 기본 설정


	날짜 및 시간 설정
	네트워크 설정
	버튼 조명 설정
	상태 표시
	초기화
	설정 데이터 초기화
	<초기화되지 않은 항목 및 데이터>

	페이더 초기화


	원격 카메라 연결 (Remote camera link) 기능
	■ 연결의 예
	리모트 카메라 연결 설정
	리모트 카메라 연결을 위한 단자 선택
	IP 주소 설정
	원격 카메라 포트 설정
	원격 카메라 인증 설정
	<파일 이름에 사용할 수 있는 문자>

	리모트 카메라 연결 상태 확인하기
	원격 카메라 탈리 제어 설정


	외부 인터페이스
	GPI I/O 설정
	■ GPI 입력 포트를 사용하여 제어

	LAN
	외부 패널로 제어
	준비
	외부 패널 설정
	외부 패널이 연결된 경우의 본 기기 설정
	버스 ID 및 소스 ID 목록
	1) 일반 버스 ID 및 소스 ID
	2) 확장 버스 ID 및 확장 소스 ID

	외부 제어
	<개요>
	<준비>
	<설정>
	<명령 사양>

	소프트웨어 패널 연결 설정
	<사용자 이름에 사용할 수 있는 문자입니다>
	<암호에 사용할 수 있는 문자입니다>



	자동 색상 톤 보정
	<설정>
	마스터 카메라 기록
	다른 카메라 보정

	외형
	제품 사양
	설정 메뉴표
	부록 (용어집)
	색인
	ALARM indicator 18
	Ancillary/Audio 149
	Audio input connector 21
	AUTO button 20
	AUX bus crosspoint buttons 20
	AUX bus selector buttons 20
	Bus tally indicators 20
	CBGD 121, 122
	Cooling fan 22
	CUT button 19
	Dedicated crosspoint buttons for the AUX bus 20
	EXIT button 19
	External Interfaces 150, 151
	Fader lever 20
	FTB ON button 19
	Ground connector 22
	HDMI IN connectors 21
	HDMI OUT connector 21
	Headphone connector 23
	Hole for fitting the cable clamp 23
	Input 130
	Key 122, 123, 124
	KEY 2 ON button 19
	MENU button 19
	MIX/WIPE switching button 20
	Monitor volume dial 23
	MultiView 128, 129, 130
	Network 149
	OSD menu 26
	OSD/TIME dial 19
	Output 136
	PGM bus crosspoint buttons 20
	POWER indicator 18
	Power switch 21
	Project 148
	PST bus crosspoint buttons 20
	Reference input connector 21
	SDI IN connectors 21
	SDI OUT connectors 21
	Security slot 22
	SERVICE switch 22
	SHIFT button 19
	Shot Memory 126
	Shot Memory button 19
	Still 125
	STREAM button 18
	System 147
	TALLY/GPI connector 22
	USB connector 21, 22
	USB Memory 151
	USER buttons 18
	WIPE 121
	XPT Assign 127


